APPENDIX 1

Software documentation

GIANT manual

PITSA manual
Short introduction to the software package

GIANT 1.1

Graphical Interactive Aftershock Network Toolbox

by Andreas Rietbrock

Institut für Geowissenschaften
Universität Potsdam
Postfach 601553
14415 Potsdam

internet: http://lbutler.geo.uni-potsdam.de/service.htm
email: rietbroc@geo.uni-potsdam.de
Special thanks to M. Ohrnberger, who wrote part of this manual and who also debugged part of this program very critical. I also have to thank J. Wassermann for the translation of some chapters in this manual.
1 Introduction ..................................................................................................................... 5
  1.1 Basic design considerations .......................................................................................... 5
  1.2 Organisation of the waveform database ...................................................................... 8
  1.3 Determination of the Source and waveform parameters ........................................... 11
  1.4 Prerequisites for the use of GIANT .......................................................................... 15
2 GIANT ...................................................................................................................... 17
  2.1 Starting of GIANT ..................................................................................................... 17
  2.2 Selection of database for the analysis ........................................................................ 18
  2.3 Searching the database. The Query-Menu .................................................................. 19
    2.3.1 Selection of waveforms in time ........................................................................... 20
    2.3.2 Selection of waveforms of a single station ....................................................... 23
    2.3.3 Selection of waveforms of a single event by event number ............................. 26
    2.3.4 Selection of waveforms by spatial region ......................................................... 27
    2.3.5 Writing input files to use with tomography program Simul ............................. 27
    2.3.6 Selection of waveforms of several events at several stations ........................... 29
    2.3.7 Selection of single components and the instrument simulation ....................... 30
  2.4 Starting of in GIANT implemented programs. The Tools Menu. ............................. 32
    2.4.1 Tools for using Hypo71 when working on earthquake localisation tasks ........ 32
    2.4.2 Calculation of Magnitudes (ML) and mean network Magnitude ..................... 35
    2.4.3 Calculation of instrument simulations and synthetic seismograms ................. 36
  2.5 Attaching waveforms to an event. The Event Menu ................................................. 38
3 Station Geometry .......................................................................................................... 41
  3.1 Selection of information to be plotted ........................................................................ 42
  3.2 Selection of coordinate system .................................................................................. 42
  3.3 Selection of localisation dependent parameters to be plotted in colour code ............ 44
  3.4 Looking at detailed regions and special information by the use of mouse buttons ... 45
4 Velocity model ............................................................................................................... 50
  4.1 Changing the velocity model by using the mouse ..................................................... 51
  4.2 Changing the number of layers in the velocity model ............................................. 51
  4.3 Changing the plot range of velocity model ............................................................. 52
5 Fault plane solutions

5.1 Computation of fault plane solution using Fpfit

5.1.1 Adjusting the search region

5.1.2 Miscellaneous

5.1.3 Various options

5.1.4 Reverse polarities and excluding some stations

5.1.5 Interactive estimation of fault plane solutions

5.2 Computing the fault plane solution using FocMec

5.2.1 False polarities threshold

5.2.2 Adjusting the search region

5.2.3 Adjusting the amplitude ratios

6 Analyzing a local earthquake

6.1 Automatic phase picker of the P-wave onset times

6.2 Interactive onset determination

6.3 Interactive S-wave onset time determination

6.4 Locating the quake using Hypo71

6.5 Interactive improvement of onset times with big residuals

6.6 Improve the polarities interactively

6.7 Pulling in another earthquake

7 Setting up the database and the import of waveform data

7.1 Setting up a new database

7.2 Import of seismic traces (waveform data) to the database

7.2.1 The giant_setup utility

7.2.2 The experiment file - normal and long format

7.2.3 The calibration information and calibration file format

8 References

9 Appendix

9.1 Data structure

9.2 Set structure
1 Introduction

The idea for the software package GIANT was born during the analysis of the aftershock sequence of the well known Loma Prieta, California, earthquake which took place on October, 17th, 1989 in California. For this task a new processing system for large volumes of digital data sets was developed. The system was designed primarily for the analysis of large scale experiments in mobile seismology such as aftershock monitoring campaigns, but can also be used for the analysis of permanent networks. Trying to analyse the very heterogeneous Loma Prieta aftershock data set which was collected by various agencies new approaches has to be developed for looking at seismic waveforms. The main goal for the design of the system was trying to find a reasonable way to deal quickly with large volumes of heterogeneous mobile network data in-depth, without too many sacrifices in terms of modelling assumptions.

In the following a short overview of the basis concepts of GIANT will be given followed by the description of the functionality of the program. For the theoretical background and algorithms of the programs which are used in GIANT further reading in the referenced bibliography is suggested. The software for calculating the focal mechanisms (FPFIT, FOCMEC) had to be rewritten by the author of GIANT for technical reasons to ensure a useful and practical implementation in GIANT. Therefore the names are only kept to indicate the computational methods used in the original programs.

1.1 Basic design considerations

For better understanding of the concept of GIANT imagine yourself the following situation: You did an aftershock experiment with several stations located in the region of the main shock. You collected data over several weeks or months and therefore you have to look at hundreds of Megabytes or even Gigabytes of digital waveform data. Normally it is not possible for a single person to analyse the data on his own. So the analysis is done by a group or even several groups of seismologists focusing on those parts of analysis that concern their special interest (Fig. 1.1). On the left side from Fig. 1.1 the kind of parameters that are typically extracted from aftershock or local earthquake data sets such as hypocenters, focal mechanisms, traveltime residuals, spectral parameters, or Coda Q are shown for example. On the right side the kind of models that are usually derived from them such as the fault structure, the stress tensor, a velocity model, and attenuation models are shown. These analysis are commonly completely decoupled and by analysing large volumes of data these analysis are even done by different
groups. Group A may be doing the location and potentially the focal mechanisms with one crustal model, group C may be performing spectral analysis with a different model and group D may be doing the coda analysis with assumption of their own. Meanwhile group D has developed a 3D velocity model and got different location for the earthquakes as group A, which would mean that all the focal mechanisms of group A have to be computed in the new model.

Fig. 1.1: Overview of the different analysis tasks of different groups during the analysis of an aftershock experiment.

With this kind of decoupled approach, it is very hard to obtain consistent results of different properties of the earth crust in the region of interest. Usually it is very hard to tell if the differences in the results from different approaches (for example for the resulting stress or attenuation models) are insights in the physics of the earth crust or are only pure artefacts of our analysis procedure. While this problem may be insignificant for certain questions, it is definitely not for all, especially not if we are interested in high resolution analysis of small scale features.

Being able to obtain consistent models for a wide variety of questions was the driving force and the primary goal of the design of our new analysis system. To illustrate some of the mutual interdependencies look at the simple task of locating earthquakes and determining fault plane solutions. For the location a velocity model will be assumed or the results of former experi-
ments in the literature will be taken. During the analysis the velocity model has to be refined according to the observed traveltime residuals. Afterwards the focal mechanisms will be computed, but very often wrong polarities will be found, which are caused by poor location results or even by an insufficient velocity model. For the determination of better fault plane solutions it would be necessary to refine again the velocity model, but this would mean to locate the events once again, which would lead to different hypocenter coordinates and therefore to different fault plane solutions. Such backward and forward dependencies which were shown at this simple example can be found very often during the analysis of large volumes of earthquake data.

During a complete waveform analysis, no matter what individual steps are involved, a heap of parameters will evolve which provides constraints for the subsequent analysis steps. With data volumes in the order of GigaBytes, this requires a clever way of interaction between the data, the parameter heap and the analyst. It would be desirable to do this completely automatic. Although automated processing has come a long way already, the quality of the results is not quite sufficient yet to rely on a complete automated approach. On the other hand, completely interactive processing with these kinds of data volumes is out of question either. Out of these reasons we used a semi-automated approach based on the assumption that only a very small number of interactively determined parameters are sufficient to start the rest of an in-depth analysis with comparatively very little interaction. The main goal was to minimize the steps of interactive analysis to the minimum needed. In order to be able to efficiently deal with huge amounts of data, we choose a database approach for organizing the recorded waveforms based on the dbVista Data Base Manager (Raima Corporation, 1991). Quick extraction of the digital seismograms and all the complex organisational tasks are performed through a graphical user interface, which acts as the root window of the GIANT processing system. Under control of GIANT the following analysis tools are incorporated and communicate through GIANT with the waveform database and the parameter heap (Fig. 1.2):

**PITSA** by F. Scherbaum and J. Johnson (1993). This program is used to display the waveform data and to apply interactive analysis on the digital seismograms. Pitsa was heavily reconstructed for the use inside of GIANT (Rietbrock, 1996).

**HYPO71** by W. Lee and J. Lahr (1972; 1975). The most widely used localization program for 1D-velocity models in observational practice.

**FPFIT** by A. Reasenberg and D. Oppenheimer (1985). Calculation of focal mecha-
nisms by the use of P-wave polarities.

**FOCMEC** by A. Snoke et al. (1984). Calculation of focal mechanisms by the use of the polarity information of P, SV and SH waves. Additionally it is possible to include amplitude ratio information for further constraints of focal mechanism.


**PREPROC** by M. Zmeskal and A. Plesinger (1995). Used for the preprocessing of seismological data. This includes resampling tasks as well as the restitution and simulation of different seismic recording systems. This turns out to be very useful in the case that someone wants to join data of one or several heterogeneous networks.

---

**Fig. 1.2:** Overview of the different analysis tools incorporated into GIANT
1.2 Organisation of the waveform database

For organising the waveform dataset the dbVista Data Base Manager (Raima Corporation, 1991) is used inside GIANT. This Data Base Manager is based on the network model. Inside the network model the data is stored in records which are the basic units of data storage. For an example the station record in GIANT is defined as follows:

**STATION RECORD**

- char stat_code[6] station code
- int chan_code channel id (1->Z, 2->N, 3->E)
- int stat_type type of recording system
- float stat_lon station longitude (Deg)
- float stat_lat station latitude (Deg)
- float stat_elav station elevation (km)
- float fcommon[3] for further use

The relationship between the different records is explicitly defined and directly maintained through sets. A set defines a one-to-many relationship between two record types. For example one seismic station is recording many seismograms and this dependency is described by the station -> seismogram set. Sets are implemented with linked lists of pointers to the record locations of the set members (seismograms) and owners (station). The result is a network of interconnected records. The great advantage of network based databases is a faster data access in comparison to relational database. Furthermore it is possible to transform every network oriented database into a relational database, which has the great advantage to use SQL (System Query Language) to retrieve data from the database. This approach is implemented into GIANT using the db_giant program (in development). Fig. 1.3 shows the structure of the GIANT database which is currently implemented. Since the storage of the seismic waveform is always very space (disk) consuming the waveforms are not stored inside the database. They are stored in a separate directory (directory structure) which can be chosen appropriate for the system. This gives the possibility to work with the database even if the actual waveforms are not currently loaded into the computer system.
Fig. 1.3: Organisation of the waveform database inside GIANT. Records are indicated by the boxes. The arrows indicate the set connection between the records. The arrow always points to the member of the corresponding set. The data fields of the individual records are described in the Appendix.
1.3 Determination of the Source and waveform parameters

As mentioned in the previous sections it is necessary to minimize the amount of interactive analysis if we are dealing with large data sets. For that reason all necessary parameters should be determined during the first 1D-Location of the events. These parameters should be used afterwards as starting values for further analysis processes. In this context the recorded seismogram is described as a set of wavelets which can be described by a few parameters. An overview of these parameters is given in Fig. 1.4.

![Wavelet parameters](image)

**Fig. 1.4**: Wavelet parameters used in GIANT. Start time of the wavelet and the corresponding uncertainties ($t_{01}$, $t_{01-}$, and $t_{01+}$), maximum and minimum of the wavelet with the corresponding times ($a_{\text{max}}$, $t_{\text{max}}$ and $a_{\text{min}}$, $t_{\text{min}}$), the rise time of the wavelet ($t_r$), and the end time of the wavelet ($t_{\text{end}}$).

The waveform parameters which can be determined interactively are the start time of the wavelet and the corresponding uncertainties ($t_{01}$, $t_{01-}$, and $t_{01+}$), maximum and minimum of the wavelet with the corresponding times ($a_{\text{max}}$, $t_{\text{max}}$ and $a_{\text{min}}$, $t_{\text{min}}$), the rise time of the wavelet ($t_r$), and the end time of the wavelet ($t_{\text{end}}$). These parameters are used as the starting values for further analysis. Out of this reason it is very important that these parameters are determined very consistently. This is achieved that the parametrisation of the waveforms is performed during the 1D localisation of the event and the computation of the corresponding fault plane solution. So it is possible to check the location and the determined wavelet parameters against
the synthetic travel times and against the synthetic parameters. It is also possible to determine
the onset of the S-wave on the horizontal components rotated into a ray based coordinate
system. In practice this approach is realized that beside the waveforms the determined waveform parameters, the synthetic travel times, the station geometry together with the location of the epicenter, the velocity model with the source depth, and the fault plane solution are displayed on the screen. Fig. 1.5 shows a typical screen for the determination of the waveform parameters. In the left upper panel the GIANT main window after the localisation and determination of the fault plane solution is shown. In this window all available seismic waveforms are shown sorted by time (X-axis) and station name (Y-axis). Each symbol represents a recorded waveform and the length of the waveform is indicated by the length of the individual black lines. The vertical lines indicate the selected time range. A selection of the waveforms can be performed by simple mouse clicks in this window. In the middle upper panel the fault plane solution computed with Fpfit and in the upper right panel the station geometry is shown for the corresponding event. The lower left panel shows two seismograms of the selected event. In the upper part of this window the whole seismograms, while in the lower part only the time window around the first P-wave arrival is shown (zoom window). Superimposed are the determined onset times for the P-wave (indicated by a column) and the theoretical onset times (without a column). The selection of the number of traces which will be shown together is arbitrary, as well as the length of the zoom window. In the right lower panel the used velocity model together with the focal depth is displayed. After the determination of the waveform parameters (onset times, polarities, amplitudes,...) the earthquake will be located using Hypo71. All synthetic traveltimes will be computed and are superimposed in the recorded seismograms. Furthermore the new location of the determined epicenter will be plotted in the station geometry window and the new focal depth will be shown in the velocity model. Additionally a new fault plane solution will be computed automatically. To quickly correct for large residuals at some stations (maybe caused by wrong determined onset times) or false determined polarities, these waveforms can be visualized very rapidly inside Pitsa. After this “consistent 1D localisation” all the determined waveform parameters should be determined consistently according to the velocity model, the fault plane solution and the hypocenter location. Fig. 1.6 gives a schematic overview for this “consistent 1D localisation” procedure.
Fig. 1.5: Graphical user interface for the 1D location and the determination of the waveform parameters. Further explanations to the different windows are given in the text.
Fig. 1.6: Determination of the waveform parameters according to the "consistent 1D localization". An iterative improvement of the waveform parameters is possible.

1D-Lokalisation using P- and S-Wave onsets

Quality control of the waveform parameters

- Control of the arrival times:
  - Comparison with synthetic phases:
  - Sorting according to the greatest residuals

- Control of the polarities:
  - Comparison with the fault plane solution:
  - Sorting according to the polarities

- Control of the velocity model:
  - Displaying the focal depth together with the used velocity model

- Visualization of the recording geometry
- Visualization of the station distribution

Yes

Lokalisation influenced?

Yes

Corrections performed?

Yes

No

No

?
1.4 Prerequisites for the use of GIANT

- SUN - world-shaking or other compatible workstation
- SUNOS 4.1.x or SOLARIS 2.4 together with the Openwindows environment. You can use GIANT in other X11-environments (like Motif), but please be aware that GIANT was developed under the Openwindows environment.
- The kernel must include the System V interprocess communication. You can check this for SUNOS 4.1.x with the command `ipcs`. If the kernel uses the System V interprocess communication you will get the following printout to your screen:

```
flaucher% ipcs
IPC status from flaucher as of Sun Nov 12 16:58:04 1995
T   ID    KEY      MODE      OWNER     GROUP
Message Queues:
Shared Memory:
Semaphores:
```

The SUN standard kernel (GENERIC) under SUNOS 4.1.x is properly compiled for the use of this feature.
- At least 20 MB of disk space for the installation of GIANT.

The Readme in the tar file covering GIANT includes further information for setting up GIANT. Please refer also to chapter 7 on page 71 for setting up GIANT correctly.
2 GIANT

2.1 Starting of GIANT

To start GIANT simply type: giant

After some 10 s the main window of GIANT will appear on your screen (Fig. 2.1). All grey-shaded buttons indicate that they are inactive in the moment and therefore can’t be selected. Buttons with a small triangle include a pull-down menu.

At the beginning the user has only two possibilities to choose: You can open a database for analysis in the File-Menu (Button Select) or look into the online help by clicking the Help-Button. The use of the online help requires a proper installed Netscape 2.0 (or higher) html-browsr somewhere in your system. Actually the online help document is identical to this manual. It is only a html-version so that you can use the Netscape browser to look into it and get pretty fast links to the topics you want to be informed about. In the lower left corner of the window frame GIANT will tell you always the actual processing status. In the lower right cor-
ner you can find information about the time window in which waveform data is available in the database. In Fig. 2.1 you see the message *Nothing Selected* indicating that the database hasn’t been opened yet.

### 2.2 Selection of database for the analysis

The selection of a database is chosen by pressing the Select-Button in the **File-Menu** (Fig. 2.2).

![Fig. 2.2: Selection of a database by pressing the Select-Button.](image)

By doing this you will get a popup panel for the database settings in the upper left corner of your screen (Fig. 2.3).

![Fig. 2.3: Selection of database setting in Select database window](image)

- **Name**: Name of GIANT database
- **Database Path**: directory in which the information of the selected database is stored
- **Data Path**: directory of waveform data.

The **Database Path** variable points to the location of the database parameter files which are supposed to have suffixes like *dat*, *key* and *dbd*. Parameters are stored in the *dat*
files. The files ending with `.key` include information to make a quick and effective search of parameters and waveforms possible. The file `.dbd` (`<database-name>.dbd`) describes the internal structure and dependencies of parameters in your database. The database name gives you the possibility to distinguish between different databases. **In one database path directory you can store only the information of one single database. It is not possible to store different databases in the same directory. This is due to the fact that the names of the `.dat` and `.key` files are unique and therefore identical for all databases.**

The `Data Path` variable gives the directory path where GIANT searches for waveform data. In Fig. 2.3 obviously we want to open the database named `nloma`, which is located in the directory `/a/loma/revise/new2`, while the waveform data is placed in `/a/loma/prieta/data`. If the selection of database name and path is correct you confirm your selection with the **Ok**-Button or you cancel the action with the **Cancel**-Button. If the database is opened without any error message you will get the time information of your waveform data printed to the lower right corner of the window frame (Fig. 2.4).

![Fig. 2.4: Time window in which waveform data is available](image)

**2.3 Searching the database. The Query-Menu.**

This menu shows you the overview of data search and selection possibilities which can be handled in GIANT. Be aware of the following: **If PITSA is already activated in the GIANT-session, this means it was started in GIANT, all selected waveforms will be automatically transferred to PITSA**

In Fig. 2.5 you see all implemented criteria, which will be explained in detail in the following subsections of the manual.
2.3.1 Selection of waveforms in time

Selection of waveform in time is done in the main window of GIANT. For this reason the window contains all stations plotted on the Y-axis and the time information is given on the X-axis. After the very first steps the time window is not yet initialised. This will be achieved by the function `Query > Time` (the chosen notation follows the rule: `Query` specifies the menu and `Time` the selected button in the active menu). You get a popup window like shown in Fig. 2.6. `MID-TIME` gives you the mid-point of the time window, that should be printed to the main window. You can change the mid-point by clicking on the `TIME RANGE` bar and move it freely whereever you want in the given time range. Therefore the whole time span which includes data is divided into 1000 equal distant steps. The length of the time window with mid-point `MID-TIME` can be changed using the `Range` sub-menu between 10 minutes and 1 year. In Fig. 2.6 you can see a selection of a 10-minute time window around the mid-point at 24th of October, 1989, at 03:05:53.050 a.m.
In Fig. 2.7 you can see the selected time window plotted in the main window of GIANT. Existing waveform data in this time window will be represented by a symbol (in this case a square). The time-length of the traces will be plotted as a horizontal line. A selection of the time window can be achieved also by the following functions:

- you can select the next window in time with the **Next-Button**. To jump to the previous time window click the **Previous-Button**.
- pressing both the **CONTROL**-key and one of the two buttons (Next or Previous) you can shift the time window half of the window size forwards and backwards in time.
- pressing both the **SHIFT**-key and one of the two buttons you will jump automatically to the next/previous waveform data located in the database centering the time window around the start point of the waveform.

All these selection methods leave the actual window size untouched.
If you want to reduce the length of the time window you can do this either in the **Query > Time** menu point as described before or with the menu-point **Query > Zoom**. After pressing this button you will get a zoom-cursor in the main window which enables you to select the desired time region. To achieve this you have to press the left mouse button at the begin of the time window you want to choose. Keeping the mouse button pressed you can move to the left or right and you will observe that the crossed time region changes its color from white to black. Releasing the mouse button at the end of your selection will automatically zoom in the desired time region and GIANT switches the main window to your zoom-selection. **Before each single zoom-action you have to click the Query > Zoom first.** An enlargement of the time window is only possible with the **Query > Time** function.

The functions mentioned until now are only used for the selection of the time window which shall be plotted to the main window of GIANT to give a quick and detailed overview of available waveform data. A selection of waveforms was still not possible. If you have already chosen...
the time window in which you are interested you can select the waveform data using the mouse buttons in the main window.

Each successful selection of waveform data will automatically activate the Station Geometry window showing the actual recording geometry. It doesn’t matter if this window was opened before or not. If PITSA is running during selection all chosen waveforms are automatically transferred to PITSA and will be plotted onto the PITSA screen.

The selection of waveforms can be achieved by using the mouse buttons. The start time in your window of interest is marked by clicking the left mouse button. In the main window of GIANT will appear a vertical line. Pressing the right mouse button you cancel this selection. The end of the time window will be marked by clicking the middle mouse button. The whole selected time region will be marked black now. Automatically the recording geometry will be plotted to the Station Geometry window and the digital waveforms are transferred to PITSA. In case that PITSA was started within GIANT, the digital waveforms are directly transferred to PITSA.

The time selection can be completed by selecting single stations (or a set of stations) which are of special interest for you in this moment. Just click the left mouse button when pointing with the cursor to a station name (plotted on the left Y-axis). If the station name is framed black the waveforms of this station will not be selected. To reactivate this station press the left mouse button again on the station name. Using the two functions Query >Select All or Query >Deselect All you can activate or deactivate all stations plotted in the main window of GIANT at one time.

2.3.2 Selection of waveforms of a single station

This function is used for sorting and selection of waveforms of a single station. Only waveforms are taken into account which are already member of a localised event. You can do this using the Select Station popup window (Fig. 2.8), that you get by pressing the menu button Query >Station.

The selection of one single station is achieved by clicking the left mouse button on a station name in the list of stations shown in the upper part of the window. The selected station will be marked by grey-shading. You can select only one single station.
Using the *Mode* menu you can choose special search criteria as given below. *All* selects all available waveforms in the database that belong to the station of interest, if there has been a localisation done before. Fig. 2.9 shows for example all aftershock recordings of the previously localised events in the Loma Prieta aftershock series at station olsp.

Pressing the *Region* button you can select the waveforms at one single station interactively by drawing a rectangular box with the middle mouse button in the *Station Geometry* window. This feature is of main interest when doing analysis of earthquake clusters. This kind of selection is only useful when there was done a preselection with *Mode All* or *Mode Azimuth*. Only then the located earthquakes available at the selected station will be plotted to the *Station Geometry* window.

![Select Station](image)

**Fig. 2.8:** Selection of waveforms at a single station. In the station list you can select only one single station. Due to the possibilities given in the *Mode* menu you can choose a search criteria:

- **All**: All available waveforms at this stations are selected
- **Region**: waveforms in a region which is interactively drawn in the *Station Geometry* window will be selected
- **Azimuth**: only waveforms of earthquakes which have been located in the backazimuth given by *Azimuth Range* are selected

The selected search criteria will be activated by pressing the *Search* Button. The *Delete* Button is used to delete all waveforms of a single station in the database.
If you have selected the Region Mode and have already pressed the Search button the next step is to select a region in the Station Geometry window interactively as mentioned before (Fig. 2.9). You will note a change of the symbol used for the cursor in the Station Geometry window. Analog to the interactive zooming option in this window you can use the middle mouse button to select a region of your interest by pressing at the startpoint and releasing at the endpoint. Doing so you won’t get a zooming in, but the waveforms of the earthquakes in the specified region will be transferred automatically to the interactive analysis tool PITSA. If PITSA wasn’t running at this time, the transfer of waveform data will be suppressed.

Using the Azimuth Mode only waveforms of events in backazimuth region specified by the Azimuth Range variable will be selected.

After selecting the search criteria (All, Region, Azimuth) you always activate your selection with the Search button. The Delete button is used to delete all waveforms of one single stations from the database, so be careful with this option. For security reason you will be asked for a confirmation in another popup-window. To delete single waveforms in the database you can use another option in the interactive analysis tool PITSA.
2.3.3 Selection of waveforms of a single event by event number

Inside GIANT every successfully localised event will get a unique number by which it can be specified. With the option Query > Event > Number you can search for the waveforms of a specific earthquake by number. The selection is done by the Enter Event Number popup window like shown in Fig. 2.10. To get the unique number of an event of your interest you can use the mouse inside the Station Geometry window. Just move the mouse to the event you are interested in, then press the SHIFT-key and the left mouse button simultaneously and all event information (including the event number) will appear in an extra popup window (see also chapter 3.4.).
Using function Query > Event > Region you can select all waveforms of events that were recorded by stations in a specific (rectangular) region. The input is done in the Select Region popup window (Fig. 2.11). The selection is done by specifying the geographical coordinates of the northwestern and the southeastern edge of a rectangular region. Latitude is counted positive to the north and Longitude to the east.

The selection is done by specifying the geographical coordinates of the northwestern and the southeastern edge of a rectangular region. Latitude is counted positive to the north and Longitude to the east.

2.3.5 Writing input files to use with tomography program Simul

We implemented in GIANT an interface to the program Simul that is used for the simultaneous estimation of hypocentral parameters and a 3-dimensional velocity structure. Furthermore we did some work on Simul to enable also the estimation of a 3-dimensional absorption structure. The input files for Simul which include station, traveltime and absorption value information
can be written by the use of the Select Region for Tomography (Fig. 2.12) popup window. You can call this window by pressing the Query > Event > Simul button.

![Figure 2.12](image)

**Fig. 2.12**: Writing of input files for the use in program Simul including station, travel time or absorption value information, respectively. The single variables have the following meaning:

- **Origin Point**: Latitude and Longitude of origin point used in Simul.
- **Rotation Angle**: Rotation of cartesian coordinate system in Simul against north measured over east direction.
- **Dimension in X-Dir.**: Dimensions in X-Direction, in which recording stations were placed and the events occurred.
- **Dimension in Y-Dir.**: Dimensions in Y-Direction, in which recording stations were placed and the events occurred.
- **Mode**: Selection of information to be written out: P-VEL > travel-times of P-wave, S-VEL > travel-times of S-wave, P&S-VEL and R-TIME > $t^*$-operators estimated from the highfrequency slope of the fourier spectra.
- **Cut off value for ..**: Only residuals with a smaller value will be taken into account.

A more detailed description of input parameters for Simul is given in figure caption of Fig. 2.12.

The output of the desired information will be written to several files in the same directory where you started GIANT (be aware that a check for already existing files in this directory won’t be done). The station information will be written to the file station.dat. For the travel-time information (options P-VEL, S-VEL and P&S-VEL) you get files: p_times.dat, s_times.dat, und ps_times.dat, respectively. The estimated values for the $t^*$-operator are written to p_pulse.dat.
2.3.6 Selection of waveforms of several events at several stations

This selection criteria was proven to be very useful in relative localisation techniques using a master event. The input for selection is done in the Select Events popup window which is called by Query > Event > Join (Fig. 2.13). In the lower left corner all already localised events are listed due to their unique event number. For a better overview the origin times are plotted, too. Single earthquakes can be selected with the left mouse button within this list. In the upper left window will appear your selection. In the upper right window you will then get a station list with all stations which have registered at least one of the selected earthquakes. With the left mouse button you can now select the stations you are interested in. This selection will be marked with a grey-shading. This enables you for example to select the waveforms of different events at a single station. The order of the event list in the upper left window tells PITSA the order of waveforms to be plotted. Pressing the Ok-button will start the search and transfer the selected waveforms to PITSA. With the Delete ?X-Phases Button you can delete formerly defined “relative phases” in PITSA.
2.3.7 Selection of single components and the instrument simulation

GIANT gives you the chance to select waveforms of single components. For example if you have actually three component data but only want to look on the Z-components for P-wave phase picking - this possibility makes things quite comfortable and much faster. You can do this by opening the Transfer popup window (Fig. 2.14) when pressing the Query >Set Up menu point. GIANT enables you to keep simulated seismograms out of your original data as it includes the possibility to simulate four standard seismographs and do the restitution of your instrument. If you want you can calculate synthetic traces for the IASP91 earth model, too. In the Transfer window you can select the components you are interested in by clicking on the adequate buttons with the left mouse button. In the default setting, all buttons are active. So please keep in mind that a lot of data will be transferred to PITSA when you did all the simula-
tions before. The settings in the transfer window are always checked before waveforms will be transferred. The meaning of the symbols is given in the figure caption of Fig. 2.14.

![Transfer Window Diagram]

**Fig. 2.14:** Selection of single components of waveform data in the Transfer popup window. The settings are always checked before transferring waveforms to PITSA. The abbreviations used are:

- **BB**  original Seismograms
- **KR**  Kirnos broadband seismometer
- **LP**  WWSSN Long Period Seismometer
- **SP**  WWSSN Short Period Seismometer
- **W**   Wood Anderson seismometer
- **SY**  synthetic seismograms
- **R**   restituted seismograms

The restitution of seismograms isn’t possible until now. Therefore a selection has no effect.
2.4 Starting of in GIANT implemented programs. The Tools Menu.

In this menu you will find a list of all programs that were implemented and can be used out of GIANT (Fig. 2.15). Clicking with the left mouse button will activate the single menu points. In later subsections we will explain in detail the working of subprograms Geometry, Vel. Model and the programs for the estimation of focal mechanism Fpfit and FocMec.

![Selection of programs that were implemented in GIANT in the Tools Menu](image)

**Fig. 2.15:** Selection of programs that were implemented in GIANT in the Tools Menu

2.4.1 Tools for using Hypo71 when working on earthquake localisation tasks

The input of control parameters that are used by the localisation program Hypo71 can be done in the Control Cards popup window (Fig. 2.16). All relevant parameters can not only be checked for but also be edited as you like. Doing a localisation these values will be used for the Hypo71 run. This includes the editing of the Control Cards and the Reset Test values respectively.

Take care: a checking for the validity and usefulness of the single parameters is not performed. Also the exact positions of the parameters in the control cards have to be correct, because Hypo71 (as a typical FORTRAN program) needs this formatted input.

To make things a bit more comfortable, we included a line to get the character position within one line and furthermore blanks are shown as dashes in the popup window (Fig. 2.16).
Fig. 2.16: Input for the control parameters of Hypo71 for a localisation run. The positioning of parameters in the control card has to be correct for a successful run in Hypo71, because Hypo71 expects a formatted input. You can edit the following lines and values:

- **Position** dummy line to ensure the exact positioning of parameters in the Control Card
- **Control** Input for Hypo71 Control Card
- **Instruction** Input for Hypo71 Instruction Card
- **Fix Location** Calculation of synthetic travel times
- **Fixed** Input of Control Card for the calculation of theoretical travel times
- **RESET ( )** Input of different Reset values of Hypo71

To make things a bit more comfortable blanks are shown as dashes for the correct positioning of parameters
The output file of Hypo71 will be shown in the *Hypo71 Output* popup window which is called by clicking on function **Tools >Hypo71 Output**. After each localisation run the actual output-file will be read. Therefore an instant control of your localisation quality is enabled (Fig. 2.17).

**Fig. 2.17:** Plotting of Hypo71 output file. This window is thought for an instant quality control of your localisation run
2.4.2 Calculation of Magnitudes ($M_L$) and mean network Magnitude

Pushing the button **Magnitude** in the **Tools Menu** opens the **Compute Magnitude** window (Fig. 2.18). Selecting one or several events within the main window of GIANT by the use of the mouse buttons as described in previous sections you will get a list of the selected events plotted to the left subspace of the **Compute Magnitude** window (Fig. 2.18). Selecting one event out of the list by a single left mouse button click will show you a list of local Magnitudes ($M_L$, using the Bakun-Joyner relation) that have been estimated for this event in the right subspace of the window. The estimation has to be done before on the single waveforms during the interactive analysis in PITSA. If you want to check the amplitude picks again or add some new estimations load the waveforms of this event to PITSA. Then estimate Magnitudes as described in the PITSA-Manual - these will be automatically stored in the database. To get this new information to the **Compute Magnitude** window (Fig. 2.18), you have to push the **Get Magnitude** Button. The list of available Magnitude estimations for this event is sorted from highest to lowest Magnitude value. The **Compute** button is used for calculating some kind of network magnitude by averaging the first (highest) Magnitude estimations according to the list and using the specified number of values as given by **Numbers**. In the example (Fig. 2.18) the calculated network Magnitude $M_L$(network) averaged over the first 5 values of the list is around 1.4. Finally you can either accept the computed value with the **Accept Magnitude** button and write it to the database or delete the value with the **Delete Magnitude** button and therefore drop this information in the database.
2.4.3 Calculation of instrument simulations and synthetic seismograms

The simulation of standard recording seismograph systems is enabled in GIANT by calling \textit{preproc}, a program for preprocessing of seismological data. Furthermore it is possible to compute synthetic seismograms for teleseismic events using the program \textit{zesmo}. Input and control of these programs will be interfaced in GIANT by the \textit{Simulation} popup window which is called with activating the menu point \textbf{Tools >Simulation} Fig. 2.19
You can choose the desired standard seismograph simulation with the left mouse button. For the calculation for the instrument responses of the actual recording instrument that registered the waveform data a calibration file is needed (see also chapter 7.2.3 on page 81). This calibration file is connected to a single station, so that it is possible to have a heterogeneous network, database without affecting the correctness of simulation.

After you finished the selection of the instrument that shall be simulated, press the Ok Button. The main window of GIANT will change in the simulation mode, this means that all waveforms that you select in the time window by the use of the mouse buttons will not be transferred to PITSA but the simulation for this data will be started. Of course you can select within the main window single stations (click on station names plotted on the left side of main window) or only some components you are interested in (in the Transfer popup window). For the selection of single components only the settings of BB instrument (your original data) in the Transfer window will affect your choice.

![Simulation](image)

**Fig. 2.19:** Simulation of standard instruments and calculation of synthetic seismograms for teleseismic events. You can simulate the following standard seismograph systems:

- **Lp** WWSSN Long Period seismometer
- **Sp** WWSSN Short Period seismometer
- **Kirnos** Kirnos broadband seismometer
- **Wa** Wood Anderson seismometer

Furthermore you can calculate synthetic seismograms. Using Strike, Dip and Rake you can account for the focal mechanism of the event (-999.0 is a dummy value for explosion source characteristic). Period gives the source signal duration in seconds and Signal enables you to choose a special signal type.

You can choose the desired standard seismograph simulation with the left mouse button. For the calculation for the instrument responses of the actual recording instrument that registered the waveform data a calibration file is needed (see also chapter 7.2.3 on page 81). This calibration file is connected to a single station, so that it is possible to have a heterogeneous network, database without affecting the correctness of simulation.

After you finished the selection of the instrument that shall be simulated, press the Ok Button. The main window of GIANT will change in the simulation mode, this means that all waveforms that you select in the time window by the use of the mouse buttons will not be transferred to PITSA but the simulation for this data will be started. Of course you can select within the main window single stations (click on station names plotted on the left side of main window) or only some components you are interested in (in the Transfer popup window). For the selection of single components only the settings of BB instrument (your original data) in the Transfer window will affect your choice.
2.5 Attaching waveforms to an event. The Event Menu.

Before you can localise an earthquake or seismic event in GIANT, a unique connection between waveforms and an event has to be done first (Fig. 2.20). This so-called grouping can be achieved in two ways. Using the function **Event > Group** the selected waveforms in a given time window will be connected to a single event only. Function **Event > Group&Insert** enables you to write known event parameters to the database. Grouping will be done by using the mouse in the main window of GIANT. Activating one of the two functions causes GIANT to change in the grouping-mode. Selected traces won’t be transferred to PITSA but grouped together to a single event with an unique event number. The selection of the time window will be done by clicking the left mouse button on the start point. Pressing the right mouse button deletes the selection of start point while the middle mouse button is used for determining the end point of the selection. To prevent other actions before leaving the grouping mode (pressing Done in the Event menu) all other menu points are deactivated.

As already mentioned before function **Event > Group&Insert** enables you to store known hypocentral parameters in the database. After each grouping action the **Event Parameters** popup window (Fig. 2.21) will appear. You can insert the origin time, hypocentral coordinates and a unique event number in this window. Pressing the Ok button the information will be written to the database and a new grouping action can be started.
**Fig. 2.21:** Inserting hypocentral parameters when attaching seismic traces to an event.

- **Origin Time**
  - Origin time: year month day hour minute seconds

- **Lon, Lat, Depth (negative)**
  - Location of event: Longitude in degrees (positive east), Latitude in degrees (positive north), depth in kilometer (negative downwards)

- **Event Number (int)**
  - Unique event number for identification
3 Station Geometry

Within this window the spatial distribution of recording stations and localised events will be shown. Furthermore you can have a look at the station coordinates and useful event information like hypocentral coordinates, origin time, unique event number, number of P and S phases used for localisation. Another useful feature for the user is that it is possible to change station coordinates easily in the database (for example if you get better station coordinates after building the database). The Station Geometry window shows the recording geometry according to your actual selection of waveforms (Fig. 3.1). The window always appears automatically when you are selecting waveforms within the main window of GIANT.

![Station Geometry Window](image)

**Fig. 3.1:** The Station Geometry window. This window shows automatically the recording geometry according to the selected waveforms in GIANT.

Stations will be shown as triangles whereas events are plotted as red full dots. In the lower left corner of the window the absolute number of stations and events of your actual selection will be shown. Furthermore the position of the cursor within the window both given in geographical and local coordinates (kilometer from the center of local projection) will be plotted in the
lower right corner of the Station Geometry window frame (Pos.).

3.1 Selection of information to be plotted

Using the Show Network button enables you to select which kind of basic information shall be plotted. Pressing the Show Network button there will appear the Plot Area popup window (Fig. 3.2). Selection is marked by a hook. The stations (triangles) will be plotted always, there is no way to suppress this. The meaning of the single parameters is given in figure caption of Fig. 3.2.

![Plot Area Popup Window](image)

**Fig. 3.2:** Selection of information shown in Station Geometry window:
- **Events**: Show location of epicenters
- **Ev. Coordinates**: Plot coordinates (Lon, Lat) of epicenters
- **Station Codes**: Plot station codes

Additionally it is possible to suppress automatic rescaling of the region by activating the Keep Region option.

GIANT tries in standard mode to plot station and event distribution in the best-available resolution according to the region which shall be plotted and the given window size (the window is scalable). Choosing the option Keep Region suppresses the automatic rescaling of the region of interest.

3.2 Selection of coordinate system

GIANT offers you two possibilities for choosing a coordinate system. The choice can be made within the menu Coordinates (Fig. 3.3).
Station Geometry

Coordinates > Coordinate Type enables you to select between a representation of recording geometry in Mercator projection (in degrees and absolut geographical coordinates) and a cartesian coordinate system (Fig. 3.4). The origin of the cartesian coordinate system will be always laid in the center of the selected region. The internal representation of coordinates in GIANT and therefore the calculations are done in geographical coordinates only.

Coordinates > Plot Area is used to select a special region by user input. The input is done in the Plot Area popup window (Fig. 3.5).
Longitude and latitude are counted positive to east and north, respectively. Choosing the button Automatic, GIANT will scale the region automatically to plot all stations and events lying within the selected region.

### 3.3 Selection of localisation dependent parameters to be plotted in colour code

Looking into the **Parameter** menu you will get a list of additional information that is connected to your localisation output (Fig. 3.6). This means that you can plot the P/S-residuals you produced, the user-picked P/S-weights and by Hypo71 really used P/S-weights during your localisation run according to the actual selected event in a color code. The values of the color code are plotted in the upper frame part to indicate the meaning of colors. This enables you to check for strange patterns as can occur when using a totally unreasonable velocity model or control parameters for the localisation procedure.
You select the parameter of your choice with a single click of the left mouse button. The stations will change their color according to the desired parameter and size of value. Residuals (P and S) are only divided in two colors - red and blue - which indicate positive or negative residual values (too late or too early arrival of the body wave in comparison to the theoretically computed traveltime of the according phase). Showing the weights of the phases that were used during the localisation run five different colors are possible.

### 3.4 Looking at detailed regions and special information by the use of mouse buttons

Additionally to the functions described in the previous sections the use of the mouse buttons within the Station Geometry window enables you to look on detailed regions or get more information about stations or events respectively. By pressing the left mouse button while pointing to a station or event symbol a popup window will be caused to appear on the screen giving you some special information.

Selecting a station (triangle) activates the Station: `<Stationname>` popup window (Fig. 3.7). The stationname gives you the name of the actual selected station. You can use this window for checking the station coordinates only or to change the coordinates respectively. By pressing the Cancel Button you can leave this popup window without any changes while clicking the Ok Button leads to the activation of another popup window in which you will be asked to confirm...
whether the actual station coordinates should be changed or not. Please keep in mind that the coordinates will be changed in the whole database! You can’t achieve a temporal coordinate change of your station (as it is common practice in field experiments like aftershock recordings for example). Pressing No in the confirmation window will cancel your action and leaves things unchanged. Type gives you the used type of recording system. So far we implemented the possibilities MARS, REFTEK, PDAS, PCM5000, PCM5800, OBH-GEOMAR, K2 and ORION to include at least the most widely used recording systems. If a non-valid type is given GIANT changes the station type to UNSPECIFIED.

<table>
<thead>
<tr>
<th>Station : JALV</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type:</strong> PDAS</td>
</tr>
<tr>
<td><strong>Longitude:</strong> -121.847000</td>
</tr>
<tr>
<td><strong>Latitude:</strong> 37.158290</td>
</tr>
<tr>
<td><strong>Elevation:</strong> 0.244000</td>
</tr>
</tbody>
</table>

Pressing simultaneously the Shift - key and the left mouse button while pointing to an event symbol (red full dot) you will get the Event: <Event Number> popup window showing you a set of useful event information (Fig. 3.8). It is not possible to edit the lines within this window. To leave the popup window, please press the Ok button.
For a detailed look on the recording geometry you can draw a rectangular box with the middle mouse button. Press the middle mouse button selecting one edge of the region you want to zoom in. Keep the mouse button pressed while drawing the rectangular box until you find your selection useful. Release the mouse button and a zoomed plot of the selected box will be shown now. This action is demonstrated in Fig. 3.9.

**Fig. 3.8:** Popup window to show event information:
- **Origin Time:** Year, month, day, hour, minute, seconds.
- **Latitude:** Latitude in degrees, pos. to North.
- **Longitude:** Longitude in degrees, pos. to East.
- **Depth:** counted negative downwards.

<table>
<thead>
<tr>
<th>EVENT: 4</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Origin Time:</strong> 1989-10-24 02:27:45.000</td>
</tr>
<tr>
<td><strong>Latitude:</strong> 37.011501</td>
</tr>
<tr>
<td><strong>Longitude:</strong> -121.862503</td>
</tr>
<tr>
<td><strong>Depth:</strong> -17.730000</td>
</tr>
<tr>
<td><strong>RMS:</strong> 0.070000</td>
</tr>
<tr>
<td><strong>GAP:</strong> 0.000000</td>
</tr>
<tr>
<td><strong>Lat-Err.:</strong> 0.000000</td>
</tr>
<tr>
<td><strong>Lon-Err.:</strong> 0.000000</td>
</tr>
<tr>
<td><strong>Depth-Err.:</strong> 0.000000</td>
</tr>
<tr>
<td><strong>Num.of P and S:</strong> 941 - 000</td>
</tr>
</tbody>
</table>

**Ok**
Fig. 3.9: The Station Geometry window during the interactive zoom action with the middle mouse button. The region within the selected rectangular box will be plotted in detail.
4 Velocity model

For the interactive control of a 1-dimensional velocity model that is used by Hypo71 for the computation of hypocentral coordinates GIANT offers you the function **Tools > Velocity**. After pressing this menu point you will get the **Velocity Function** window like the one shown in (Fig. 4.1).

![Velocity Function Window](image)

**Fig. 4.1:** Interactive input of velocity-depth-function, which is used by Hypo71 for the localization of seismic events.

Basically GIANT enables the user to use different velocity models for each single event. This can be useful if you locate events from regions with geologically very different settings or known azimuthal variations in velocity structure. The velocity models will be organized in a separate directory. The pathname of this directory is given by the environment variable IATSN_VEL in the GIANT settings (see chapter 7 on page 71). If no special velocity model was used for the location procedure of an event, GIANT takes the default model stored in the file `velmod.hdr`. If this file doesn’t exist in your directory, a homogeneous model with a P-wave velocity of 6.0 km/s in all depths is used.
The following functions can be used within the *Velocity Function* window to manipulate the one-dimensional velocity model:

- **Get Default**  Load the actual standard velocity model (name).
- **Save Default**  Save the actual shown velocity model as standard velocity model.
- **Save Current**  Save the actual used velocity model and attach it to the actual selected event that has been or shall be localised with this velocity model.

### 4.1 Changing the velocity model by using the mouse

You can change the 1-dimensional velocity model which is shown in the *Velocity Function* window by the interactive use of the mouse. The X-axis shows the P-wave velocity as a function of depth plotted on the Y-axis. You can move the values of single layers by pressing the left mouse button while pointing on the line representing the layer of your choice. Keeping the mouse button pressed you can drag the line to the values you want to choose for your model. The actual values are printed to the fields *Velocity* and *Depth*. Furthermore the number of the actual layer which is edited will be shown by *Number*. Additionally you can set the values for each layer using the keyboard. Select the layer you want to edit by activating with a left button mouse click. Now you can insert the depth and velocity of your choice and confirm by pressing the *Set* button. Keep in mind that *Hypo71* can’t handle low-velocity layers, so inserting anything like this is actually not forbidden or checked, but it doesn’t make much sense neither.

### 4.2 Changing the number of layers in the velocity model

Using the function **Insert** you can insert more layers in your velocity model. To do this press the **Insert** button first and then click with the left mouse button onto the position for your new layer in the *Velocity Function* window. To delete a layer from the model you can either drag the vertical lines (representing the velocity) or the horizontal lines (representing the depth) of two layers together on the same value. GIANT will remove automatically the layer from the velocity model.
4.3 Changing the plot range of velocity model

using the function **Range** you can change the plot-range of the velocity-depth-function. Selecting the **Range** button you will get the **Range Selection** popup window. You can edit the upper limits of velocity [km/s] and depth [km] by typing the desired values with the keyboard (Fig. 4.2).

![Range Selection Window](image)

Fig. 4.2: Control panel for the range selection for plotting the 1-D velocity depth function.

- **Max. Velocity** upper limit of velocity to be plotted in km/s
- **Max. Depth** upper limit of depth to be plotted in km.
5 Fault plane solutions

GIANT offers two different ways to compute fault plane solutions. The programs are named Fpfit and FocMec. The calling sequence of the two programs are Tools > Focal Mechanism > Fpfit and Tools > Focal Mechanism > FocMec, respectively. While there is full access to the program Fpfit only parts of FocMec are supported yet. For this reason the computation of fault plane solutions using Fpfit will presented first.

5.1 Computation of fault plane solution using Fpfit

The program Fpfit is based on the estimated direction of the first motions of the P-waves at different seismological stations. Only if these parameters are determined, the calling routine Tools > Focal Mechanism > Fpfit will result in popping up the FAULT PLANE (Fpfit) window (Fig. 5.1).

![FAULT PLANE (Fpfit)](image.png)

**Fig. 5.1:** Estimation of the fault plane solution using Fpfit. The program uses the directions of the first motions of the P-waves at different stations. Only one possible fault plane was found.

All stations are plotted in a stereographic projection. If the first motion is in up direction on the vertical component (compression) the associated station is drawn as a solid circles. Downward
motion (dilatation) is symbolized by open circles. Finally, stations with errors in the polarity of the first motions are represented by a red open circle. Additionally, if there is only one possible fault plane solution found, the 90% confidence level for the P- and T-axis is plotted (Fig. 5.1). Otherwise if many different solutions exist only these fault plane solutions are plotted (Fig. 5.2). Finally, if only one possible best fitting fault plane solution exists, the solution is stored in the data base.

![FAULT PLANE (Fpfit)](image)

**Fig. 5.2:** Estimation of the fault plane solution using Fpfit. The computation was done using the polarities of the first motion of the P-waves. A few different fault plane solutions were found.

### 5.1.1 Adjusting the search region

The computation of the fault plane solutions is done using a grid search algorithm. The size of the searching region for the *Strike, Dip* and *Rake* and the step width of the grid search are controlled by the parameters in the *Control* popup panel. This windows appears by pushing the *Control* button (Fig. 5.3).
The grid search algorithm in Fpfit works from coarse to fine steps. In the first step only a coarse search of the parameters is performed (\textit{Incr. Coarse}). Secondly a search in the region of minimal polarity errors is started using the specified \textit{Incr. Fine} step width. Please keep in mind that only 6156 points are allowed in Fpfit.

\subsection*{5.1.2 Miscellaneous}

Pushing the \textbf{Miscellaneous} button the \textit{Miscellaneous} panel appears (Fig. 5.4). Changing the parameters causes a different amount of stations to be used for the computation of the fault plane solution. The controlling parameters are the angle of incidence, the maximum distance to the hypocenter and a threshold for the absolute residual of the P-wave travel time, respectively. Only if the amount of used stations exceeds the \textit{Minimum of P first} threshold the computation of the fault plane solutions is started. The stations excluded from this computation are plotted in green color without polarity symbol.

\begin{center}
\begin{tabular}{|l|c|c|c|c|c|}
\hline
\textbf{Parameter} & \textbf{Min} & \textbf{Max} & \textbf{Incr. Coarse} & \textbf{Incr. Fine} \\
\hline
\textbf{Strike} & 50 & 270 & 10 & 5 \\
\hline
\textbf{Dip} & 10 & 30 & 10 & 5 \\
\hline
\textbf{Rake} & -180 & 180 & 20 & 10 \\
\hline
\end{tabular}
\end{center}

\textbf{Fig. 5.3:} Adjusting the search dimensions of the grid. You can specify the maximum and minimum values of \textit{Strike}, \textit{Dip} and \textit{Rake}. First the grid search is performed with the \textit{Incr. Coarse} step size. Secondly the region of the minimum of false polarities is sampled with the \textit{Incr. Fine} step width.
### Various options

When pushing the **Option** button you are able to adjust two parameters in order to get an optimal fault plane solution within the **Option** popup (Fig. 5.5). **Fpfit** enables you to plot all different kinds of possible fault plane solutions. This option is suppressed if the switch **Search for multiple solution** is set to **No**. This causes to plot only the best solution found.

Switching the **Restrict fine search to coarse search** will cause a fine search of the coarse grid region.

<table>
<thead>
<tr>
<th><strong>Miscellaneous</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Range of incident angle:</strong> Min: 0°, Max: 180°</td>
</tr>
<tr>
<td><strong>Minimum of P first motion:</strong></td>
</tr>
<tr>
<td><strong>Minimum of magnitude:</strong></td>
</tr>
<tr>
<td><strong>Maximum permissible distance:</strong> 200,000 m</td>
</tr>
<tr>
<td><strong>Maximum permissible P-residual:</strong> 10,000 s</td>
</tr>
</tbody>
</table>

---

**Fig. 5.4:** Possible parameters for the used polarities of the first motions of the P-waves.

- **Range of incident angle**
  - range of possible incident angles of the upgoing P-waves
- **Minimum of P first motion**
  - lower threshold of polarities for starting the computation of the fault plane solutions
- **Min. of magnitude**
  - not implemented
- **Max. permissible distance**
  - only polarities are used when the hypocentral distance is smaller than this specified value
- **Max. permissible P-residual**
  - the residual of the P-wave travel time must be smaller than this upper threshold.
5.1.4 Reverse polarities and excluding some stations

Calling the functions **Stations >Ignore** and **Stations >Reverse** enables you to exclude some stations and to invert the polarities of stations, respectively (Fig. 5.6)

Selecting one of the two possible actions will cause the popup of a panel. Selecting the different stations is controlled by pushing the left mouse button (Fig. 5.7 and Fig. 5.8). Ignored stations are plotted in green color and changed polarities are represented by blue color.
5.1.5 Interactive estimation of fault plane solutions

GIANT also offers the possibility to estimate the fault plane solution manually. Calling the \textbf{Adjust} function causes the popup of the \textit{Adjust} panel (Fig. 5.9). The Strike, Dip and Rake can either be adjusted by keyboard action or by mouse. If you change one of the parameters a new fault plane solution is drawn in the FAULT PLANE window, automatically. Stations with false polarities are plotted in red color.
5.2 Computing the fault plane solution using FocMec

Calling the function **Tools > Focal Mechanism > FocMec** will cause the popup of the window FAULT PLANE (FocMec). Now it is possible to compute the fault plane solutions using the P- and S-wave polarities and the ratios of the amplitudes of these waves.

The program is yet not fully implemented and we restrict ourselves to the descriptions of the supported possibilities. Fault plane solutions computed by this program will not be stored into the database.

In contrast to the program Fpfit all computed fault plane solutions found by FocMec will be drawn in the graphical window. Stations with false polarities will also be represented in red color (Fig. 5.10).
5.2.1 False polarities threshold

When you push the **Polarities** button the panel *Polarities* will appear on the screen. Within this frame you are able to specify the allowed amount of false polarities for the computation of the solutions. Additionally, pushing the *Use Relative Weighting* switch will enable you to introduce a relative weight of the polarities with respect to the amplitudes of the computed radiation pattern (Fig. 5.11). Here, the weighting factor is always greater than the specified *Lower Threshold* value.

Fig. 5.10: Computation of the fault plane solutions using FocMec.
5.2.2 Adjusting the search region

Again pushing the Control button will enable you to specify the grid dimensions and the step width of the Strike, Dip and Rake grid search within the Control panel (Fig. 5.12).

**Fig. 5.11:** Selecting the threshold for allowed false polarities and the weight of the observed polarities, respectively

- **Use Relative Weighting**
  
  the polarities are weighted with respect to the computed radiation pattern of the source. The minimum weight is controlled by value of Lower Threshold.

- **Total Polarity Option**

  pushing the button Yes enables you to specify the maximum numbers of allowed false polarities. If No is selected, you are able to distinguish between false polarities of P-, SV- and SH-waves.

**Fig. 5.12:** Adjusting the grid dimensions and the step width of Strike, Dip and Rake.
5.2.3 Adjusting the amplitude ratios

In order to specify the allowed amplitude ratios you are forced to select the **Ratios** popup by pushing the **Ratios** button (Fig. 5.13). Within this panel you are also able to specify the amount of allowed number of false amplitude ratios.

![Selecting the used amplitude ratios](image)

Fig. 5.13: Selecting the used amplitude ratios:

- **Max. allowed log10 of ratios**: threshold of tolerated deviations between computed and synthetic amplitude ratios.
- **Number of allowed ratio errors**: maximum number of false amplitude ratios. (cf. Max allowed log10 of ratios).
- **Lower bound for P radiation pattern**: lower threshold for the P-wave amplitudes used for the computation of the synthetic amplitude ratios. The radiation pattern of a P-wave is assumed.
- **Lower bound for S radiation pattern**: lower threshold for the S-wave amplitudes used for the computation of the synthetic amplitude ratios. The radiation of a S-wave is assumed.
- **vp/vs ratio**: ratio of the P- to S-wave velocity.
6 Analysing a local earthquake

Now we will demonstrate the routine analysis of a local earthquake using the GIANT system. First we have to decide whether different seismograms belong to the same event. Calling the function Event >Group will enable you to group the associated seismograms of the different stations. This action will change the colour of the seismogram symbols from black to red.

Next you are able to analyse the seismograms of the selected event in PITSA. The selection of the different events is done in the GIANT main frame. PITSA accepts new pulled in traces only in three different modes: Main Menu, Phase Picking menu and Spectral Fitting menu. PITSA only plots the traces automatically, if it is in the Main Menu mode. If the data transfer is started any mouse action is suppressed.

The determination of the onset times in PITSA as well as the localisation of the earthquake is controlled in the Phase Picking menu. This mode can be activated by choosing the Routine Tools >Phase Picking function (Fig. 6.1).

6.1 Automatic phase picker of the P-wave onset times

In order to pick the onset times of the P-waves automatically, you should transfer only the seismograms of the vertical components to PITSA. The selection of the different components are controlled by GIANT in the Transfer panel. This popup window appears, if you select the Query>Set Up function. In order to select only the seismograms of the vertical components switch off all other possibilities than BB Z-component. When selecting an earthquake in the GIANT main window, only the seismograms of the vertical components are transferred to PITSA.
64 Analysing a local earthquake

Fig. 6.2 shows the uploaded seismograms, when activating the Plot All button in the Phase Picking mode in PITSA. Now you are able to run the automatic phase picker when pushing the Auto Pick Phase button. PITSA only asks you whether all traces should be processed (the semi colon represents all traces).

6.2 Interactive onset determination

To control or to adjust the automatically estimated onset times of the P-wave, PITSA enables you to do this interactively by selecting the Wavelet Parameters button. Again PITSA requires the input of the amount of pulled in seismograms. Next you have to specify how many traces should be plotted in one box. PITSA is also asking for the step width of the window scrolling through the selected channel list.

Fig. 6.1: The PITSA Phase Picking menu.
Fig. 6.3 displays the workspace in PITSA and Fig. 6.4 shows the associated menu for determining the onsets of the P-waves manually.

The upper part of the workspace shows the whole seismogram and the lower part represents a zoomed version of that trace. Shifting the coloured window in the upper part will cause a different zooming region in the lower part of the window. A detailed description is given in the PITSA manual. An additional feature is the possibility of using short cuts within this analysis. Pressing the letters given in brackets written on the different buttons will activate the function associated with this button. This requires a mouse position within the PITSA main frame. It is also possible to change the vertical zooming factor. Here you have to positioning the mouse at the trace of interest. There are three different possibilities of vertical scaling:

- **z**  
  enlargement by a factor of 2

- **u**  
  reduction by a factor of 2

- **q**  
  automatic scaling with respect to the maximum value

Fig. 6.2: PITSA workspace after selecting the vertical components and pushing the *Plot All* button.
normalization of all traces to a common amplitude scale

Fig. 6.3: Phase picking workspace in PITSA. The upper part displays the whole trace length. The lower part represents the zoomed version of the upper trace. This can be changed by shifting the small scrolling window located in the upper part.

If you want change any information associated with a picked phase you first have to select these phase.

The phase type can’t be changed any more; this has to be done before you pick an onset time.

The onset time of the phase and all other information will be stored into the data base automatically.
### Possible Action on Estimated Onsets Supported by PITSA

In order to change some phase attributes, the phase has to be selected. This is represented by a rectangle drawn at the phase name. It is not possible to change the name of the estimated phase.

<table>
<thead>
<tr>
<th>Phase Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Phase Type (t)</td>
<td>phase name</td>
</tr>
<tr>
<td>Onset Type (o)</td>
<td>type of onset</td>
</tr>
<tr>
<td>First Motion (f)</td>
<td>direction of first motion</td>
</tr>
<tr>
<td>Weight (w)</td>
<td>weighting factor of estimated onset</td>
</tr>
<tr>
<td>Set Amplitude (a)</td>
<td>estimating the amplitude</td>
</tr>
<tr>
<td>Clear Amplitude</td>
<td>deleting an estimated amplitude</td>
</tr>
<tr>
<td>Deltas (d)</td>
<td>estimating time errors</td>
</tr>
<tr>
<td>Clear Deltas (c)</td>
<td>deleting estimated time errors</td>
</tr>
<tr>
<td>Set Rise Time (r)</td>
<td>estimating the rise time of an onset</td>
</tr>
<tr>
<td>Clear Rise Time</td>
<td>deleting of an estimated rise time</td>
</tr>
<tr>
<td>End Phase (e)</td>
<td>estimating the end of a wave group</td>
</tr>
<tr>
<td>Hilbert Transform (h)</td>
<td>computation of the Hilbert transform</td>
</tr>
<tr>
<td>Set Hilbert Flag (l)</td>
<td>creating a Hilbert flag</td>
</tr>
<tr>
<td>Clear Hilbert Flag (k)</td>
<td>deleting a Hilbert flag</td>
</tr>
<tr>
<td>Next Trace (n)</td>
<td>pulling in the next trace in the lower workspace part</td>
</tr>
<tr>
<td>Prev Trace (p)</td>
<td>pulling in the previous trace in lower part</td>
</tr>
<tr>
<td>All Traces</td>
<td>pulling in all traces in the lower part</td>
</tr>
<tr>
<td>Pull In All Comp</td>
<td>pulling in all components</td>
</tr>
<tr>
<td>Pull In Nearest Sta</td>
<td>loading the traces of the nearby station</td>
</tr>
<tr>
<td>Clear Pulled In</td>
<td>deleting all additionally loaded traces</td>
</tr>
<tr>
<td>Refresh</td>
<td>refresh screen</td>
</tr>
<tr>
<td>Pick Magnitude (m)</td>
<td>pick magnitude on trace</td>
</tr>
<tr>
<td>DONE forward (x)</td>
<td>pulling in next traces of channel list</td>
</tr>
<tr>
<td>DONE backward (y)</td>
<td>pulling in previous traces of channel list</td>
</tr>
<tr>
<td>&lt;ESCAPE&gt;</td>
<td>quitting the phase picking</td>
</tr>
</tbody>
</table>

**Fig. 6.4:** Possible action on estimated onsets supported by PITSA.
6.3 Interactive S-wave onset time determination

After determining the onset times of the P-waves you are able to pick the onset times of the S-waves. For this reason it is recommended to pull in the seismograms of the horizontal components into PITSA. Switching on the BB X- and Y-button at the Transfer panel in GIANT will select the horizontal components of the traces in the data base. The Selection of the associated event will cause the transfer of the seismograms to PITSA. The determination of the S-wave onset times is analog to the P-wave estimation. It is not possible to determine the onset of the S-wave automatically. Furthermore, you are forced to pick only one S-wave onset time at the individual traces.

6.4 Locating the quake using Hypo71

Now we are ready to determine the location of the earthquake. Selecting the Run Location Program button will start the localization routine. GIANT is creating the input parameters of Hypo71 automatically. If you are opening the VELOCITY FUNCTION window in GIANT the currently used velocity model for Hypo71 is displayed. It is possible to adjust the control cards of Hypo71 by calling the Control Cards panel. In order to improve the location of a quake its recommended calling the Hypo71 Output panel. You are forced to control some of the parameters:

• is the root mean square (RMS) value of the travel time residuals satisfyingly small?
• has the location routine changed the depth of the starting model?

The latter question is mainly controlling the quality of the location. The depth of the starting model should be changed until a minimum RMS value is reached.

6.5 Interactive improvement of onset times with big residuals

If there is a good location found, you are able to load in the computed residuals of the travel times by pushing the Show greatest residuals button. PITSA will display the residuals sorted by size in the phase picking workspace. You are also able to correct the estimated onset times manually. To distinguish between synthetic and estimated onset times the phase name of the user specified onset is labelled by an “:” (Fig. 6.5). If you have changed the onset times to your satisfaction you can start another run by selecting the Rerun Location button.
6.6 Improve the polarities interactively

In order to compute a fault plane solution of the event, you have to store the resulting location into the data base. This can be done by pushing the Accept Event button in the PITSA phase picking menu. This action is only provided, if an event is successfully located. Now you are able to compute a fault plane solution using Fpfit. If there are any false polarities, PITSA offers you the possibility to control the estimated onsets by activating the Show false polarities button in the phase picking menu. If you have changed any polarity affecting the onset time of the estimated phase you have to start another run of the localization program by selecting the Rerun Location button. This procedure should be repeated until a consistent location and fault plane solution is reached.

Fig. 6.5: Interactive improvement of the onset times. User specified onsets are labelled by an “:”.

[Image of a seismogram showing user-specified and estimated phases]
6.7 Pulling in another earthquake

If you have estimated a satisfyingly good location and fault plane solution you are forced to inform PITSA that you want to work on another earthquake. This will be done by selecting the Free Settings button. This function is only visible if there is a successful location of the quake found. After activating this function you have no longer access to the residuals and false polarities of the former quake.
7 Setting up the database and the import of waveform data

GIANT doesn’t handle the seismic traces directly in the database, but only refers to the name of the waveform data. Therefore it is possible to work with the database even if the waveform data is not physically present on your disk or selected storage media. The organization of velocity models and the calibration information is handled also by name references of the files. Using special environment variables in GIANT enables the user to store the desired information in directories of his choice. The following list of environment variables are necessary for the correct use of giant:

- DBDPATH, DBFPATH: directory path in which the database files are stored.
- IATSN_BASE: name of database.
- IATSN_DATA: directory path pointing to the stored waveform data.
- IATSN_VELOCITY: directory path in which the velocity model file is stored.
- IATSN_CAL: directory path in which the calibration information of the single stations is stored.
- IATSN_TMP: directory path of temporary directory for the storage of the simulated seismograms when running preproc in the simulation mode.
- PITSA_PROG: directory path in which PITSA and other analysis programs are stored.

It turned out to be very comfortable to do the setting of these variables in a shell script. Fig. 7.1 shows a sample script to start GIANT. In the beginning the environment variables of the analysis program PITSA are defined. Then the settings for the previous mentioned GIANT environment variables are done. If several users shall have write permission in the same directory when working on the same database the variable umask has to be set to 2, because GIANT writes temporary files to the working directory. After starting GIANT umask is set back to the former value and the temporary files will be deleted.
7.1 Setting up a new database

If you want to set up a completely new database you can make use of an already existing database. Just copy the file with ending .dbd which includes information about the internal database structure to a new directory. The base name of the file is equal to the database name, so it has to be identical to the environment variable IATSN_BASE. Leave the suffix unchanged, GIANT won’t work without this. Then you have to change the environment variables

```csh
#!/bin/csh
#
# All settings for a test database
#
# PITSA
setenv PITSAHOME /a/loma/pitsa
setenv PITSA_CONFIG_PATH_ENV $PITSAHOME/
setenv PITSA_HELP_PATH_ENV $PITSAHOME/
setenv PITSA_PRINTDEF_PATH_ENV $PITSAHOME/
setenv PITSA_PRINTDEF_NAME_ENV 8x11_landscape.PS
setenv PITSA_HYPO71_PATH_ENV /a/loma/chile/velocity/

# RAIMA
setenv GIANTHOME /a/loma/chile
setenv IATSN_BASE cinca95
setenv IATSN_DATA $GIANTHOME/data233a/
setenv IATSN_VELOCITY $GIANTHOME/velocity/
setenv IATSN_CAL $GIANTHOME/calib
setenv IATSN_TMP $GIANTHOME/tmp
setenv DBDPATH $GIANTHOME/doy233a
setenv DBFPATH $GIANTHOME/doy233a
setenv PITSA_PROG /a/rei1/chile_soft/andreas/pitsa

# setting write permission for the group
# set ms = `umask`
umask 2
/a/loma/giant/giant
umask $ms
unset ms

# cleaning up all files
#
\rm vista.taf
\rm giant.sta
\rm giant.pha
# End of file
```

Fig. 7.1: Shellscript for the GIANT startup and the correct setting of all required environment variables
Setting up the database and the import of waveform data

DBDPATH and DBFPATH to the new directories. Now you can initialize the database with the utility program `initdb`. Try the following command string:

```
initdb <name of database>
```

This program creates the `.dat` and `.key` files that are necessary for the use of GIANT. Look at the files you have created. The list should look like this:

<table>
<thead>
<tr>
<th>File Name</th>
<th>File Name</th>
<th>File Name</th>
<th>File Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>calibration.dat</td>
<td>f_corn.key</td>
<td>q_value.key</td>
<td>solution.dat</td>
</tr>
<tr>
<td>spetrum.dat</td>
<td>test.dbd</td>
<td>cluster.key</td>
<td>focal_mech.dat</td>
</tr>
<tr>
<td>record_no.key</td>
<td>solution.key</td>
<td>start_time.key</td>
<td>trace_rec.dat</td>
</tr>
<tr>
<td>compu_phase.dat</td>
<td>phase.key</td>
<td>scal_wavelet.dat</td>
<td>solution_id.key</td>
</tr>
<tr>
<td>station.dat</td>
<td>vec_phase.dat</td>
<td>event_no.key</td>
<td>plateau.key</td>
</tr>
<tr>
<td>seis_event.dat</td>
<td>source_spec.dat</td>
<td>station.key</td>
<td></td>
</tr>
</tbody>
</table>

Furthermore you have to create the directories for the waveform data, the velocity models and calibration information and set the environment variables correctly.

### 7.2 Import of seismic traces (waveform data) to the database

#### 7.2.1 The `giant_setup` utility

The possible input file formats for the waveform data used in the GIANT database system are GSE and PDAS. These formats were finally chosen because they are widely used for data exchange and so nearly everybody has some little routine to convert his/her data into these formats. This argument fits especially for the GSE-format. On the other hand PDAS instruments are often deployed in field experiments and the format is quite easy and understandable.

The utility program to import the waveform data to the database is called `giant_setup`. This program reads the so-called experiment file, and checks the imported waveform data (this means: the header information) against the information stored in the experiment file. You can see this experiment file - we call it normally `info.dat` - as the pendant of your field book, including all information about the station deployment, sensors and useful information connected to your seismic stations. In the beginning you will find it a bit complicated to set up the experiment file, but finally you will be pleased by the completeness of information you include from the beginning into the database.

The `giant_setup` utility is a command line driven program. To get the list of supported options just type `giant_setup` at your shell prompt. Then you should get a message like shown in Fig. 7.2.
To import your waveform data without any complications, you have to set the environment variables DBDPATH and DBFPATH correctly in your shell before calling giant_setup. Furthermore there are two other environment variables in use, which are called DBTAF and DBLOG. Set these two variables to a directory where you have write permission. During the import of the waveform data there will be written some log-files from the database engine. If you start giant_setup in a directory where you are not allowed to write (for example on a CDROM device) and these environment variables aren’t set, you won’t be able to import your waveform data.

The option \texttt{-b} gives the basename of the database (this is the same name that you have to assign to the environment variable IATSN_BASE) to which you want to write the waveform data.

\textbf{Option \texttt{-c}} is followed by the name of the experiment file. It has to be set with the pathname relative to the directory where you start giant_setup.

The command line option \texttt{-long} doesn’t require any parameter. It is a flag to indicate which type of experiment file format - the normal or the long one - you are working with.

If you have already picked some phases and located the event with an other program you can import this information by using the \texttt{-p} option. You have to transform your phase picks into the env-Format which ist the ordinary format of the velest localisation program. The \texttt{-p} option is only supported together with the \texttt{-d} option for the event directories.

Finally you have to choose one of the options \texttt{-d} or \texttt{-f} followed by a relative directory path or a filelist, respectively. Using the \texttt{-d} option you have to give a pathname, that points to a directory structure. giant_setup assumes then that each subdirectory contains the wave-
Setting up the database and the import of waveform data

form data of one single event at several stations and therefore groups automatically these waveforms to one event. This is very convenient when you have already pre-selected your data (for example with a network trigger).

If you don’t know in the beginning which station has triggered what event or you don’t want to pre-select your data at all, you should choose the **-f** option. The parameter given to `-f` is a simple ascii file containing a list of waveform files you want to include in the database. No absolute pathnames are allowed. The list has to contain only pathnames relative to the directory from which the giant_setup utility is run. Using `-f` suppresses the grouping of waveforms to events - you have to do this later manually in GIANT. Using unix csh commands you could get a list like shown for example in Fig. 7.3. The file “list” includes the relative pathnames for calling giant_setup in the same directory as executing the csh commands.

```
tllaran:/cerro/cori/data/95> ls
01/ 02/ 03/ 04/ 05/ 06/ 07/ 08/
tllaran:/cerro/cori/data/95> touch list
ctllaran:/cerro/cori/data/95> foreach file (01/*)
foreach? echo $file >> list
foreach? end
ctllaran:/cerro/cori/data/95> more list
01/950102225440_0.0161
01/950102225440_0.0209
01/950102225440_1.0161
01/950102225440_1.0209
01/950102225440_2.0161
01/950102225440_2.0209
01/950102232274_0.0161
01/950102232274_0.0182
01/950102232274_0.0210
01/950102232274_1.0161
01/950102232274_1.0182
01/950102232274_1.0210
01/950102232274_2.0161
01/950102232274_2.0182
01/950102232274_2.0210
```

**Fig. 7.3:** Example of csh commands to get a file list to use with giant_setup. Directory “/cerro/cori/data” contains several subdirectories with waveform data. You can create a list of files in subdirectory 01 as shown above by touching a textfile, and echoing all files in this textfile with an `foreach` loop (in a csh). This textfile you can use with the `-f` option of giant_setup when it is run from this directory. The relative pathes of the files are written to the database and files within one subdirectory are **not grouped** automatically.
7.2.2 The experiment file - normal and long format

The experiment file holds all general information of your field experiment or your station setup as already mentioned above. The information in this file is the minimum of information required to guarantee reasonable results of your analysis.

There are two types of experiment files you can use. They basically differ in the number of columns. The “normal” one has 16 fields to fill, the other 17, so we refer to this type as “long” format. The single lines don’t require a special format, only the columns have to be separated by at least one space. Let’s begin with the explanation of the normal experiment file by taking a look on Fig. 7.4. There you can see a short example of an experiment file for the aftershock experiment drawn out after the occurrence of the 1995 Antofagasta Chile earthquake.
Fig. 7.4: Experiment file for the Aftershock experiment drawn out after the 1995 Antofagasta earthquake in Chile. This type of experiment file is called the normal format. It contains 16 columns with logistic information, like datalogger type and number, sensor type and number, geographical position of station, station name, valid registration period and file format of datalogger with gain information. For a detailed description of the single entries in the experiment file, see the text. To identify the column we put the column number (symbol |#xx|) at the top and the bottom of the figure.

<table>
<thead>
<tr>
<th>#1</th>
<th>#2</th>
<th>#3</th>
<th>#4</th>
<th>#5</th>
<th>#6</th>
<th>#7</th>
<th>#8</th>
<th>#9</th>
<th>#10</th>
<th>#11</th>
<th>#12</th>
<th>#13</th>
<th>#14</th>
<th>#15</th>
<th>#16</th>
</tr>
</thead>
<tbody>
<tr>
<td>7163 REFTEK 1. 32 L4-3D 1314 05 CAC -22.9992 -70.3050 100 95.08.10 17:00 95.10.10 16:05 Wylegalla</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7261 REFTEK 1. 32 L4-3D 1306 06 MEX -23.2847 -70.0628 1200 95.08.11 20:55 95.09.26 16:45 Rietbrock</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>321 PDAS 1. 14/2 L4-3D 1301 07 DES -23.3403 -70.3237 450 95.08.17 17:15 95.10.11 17:35 Wylegalla</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7259 REFTEK 1. 32 L4-3D 1307 08 PRT -23.4569 -70.2253 851 95.08.10 21:15 95.10.11 17:20 Baumbach</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7258 REFTEK 1. 32 L4-3D 1311 09 ERC -23.1397 -69.8742 1368 95.08.12 16:30 95.10.11 16:00 Wylegalla</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7263 REFTEK 1. 32 L4-3D 1302 10 AME -23.9167 -69.7581 850 95.08.11 14:15 95.09.19 21:05 Wylegalla</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7262 REFTEK 1. 32 L4-3D 1312 11 NAV -23.7717 -70.0442 675 95.08.10 19:00 95.09.19 20:00 Baumbach</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7165 REFTEK 1. 32 L4-3D 1303 12 PAT -23.9433 -70.2900 646 95.08.10 17:00 95.08.15 13:30 Baumbach</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7166 REFTEK 1. 32 L4-3D 1310 13 COL -23.7856 -70.4089 311 95.08.10 15:15 95.10.10 21:10 Baumbach</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7158 REFTEK 1. 32 L4-3D 1313 14 QC1 -23.6239 -70.3419 535 95.08.11 20:30 95.08.21 18:15 Baumbach</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7159 REFTEK 1. 32 L4-3D 1309 15 PEL -23.6483 -69.8706 990 95.08.11 17:15 95.10.11 14:05 Wylegalla</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7162 REFTEK 1. 32 L4-3D 1304 16 TRO -23.4222 -69.8600 940 95.08.11 18:00 95.09.11 15:45 Wylegalla</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7257 REFTEK 1. 32 L4-3D 1305 17 ALG -22.8625 -69.8064 1500 95.08.12 19:45 95.08.16 17:45 Baumbach</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>223 PDAS 1. 14/2 L4-3D 931 18 MIC -22.7014 -70.1625 900 95.08.13 18:00 95.09.08 17:55 Wylegalla</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>324 PDAS 1. 14/2 L4-3D 936 19 NEU -22.6804 -69.9608 1300 95.08.13 20:20 95.09.20 15:49 Wylegalla</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>222 PDAS 1. 14/2 L4-3D 932 20 VAL -22.6475 -69.7161 1500 95.08.13 22:10 95.10.11 16:55 Wylegalla</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>326 PDAS 1. 14/2 L4-3D 1121 22 ELE -22.2867 -69.6519 1200 95.08.16 18:55 95.08.19 18:40 Grunevald</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>327 PDAS 1. 14/2 L4-3D 1133 23 NEG -22.2746 -69.3727 1450 95.08.16 17:40 95.08.26 19:15 Grunevald</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>337 PDAS 1. 14/2 L4-3D 1134 24 SOM -22.4918 -69.3850 1350 95.08.16 17:10 95.08.26 20:40 Grunevald</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>269 PDAS 1. 14/2 L4-3D 1193 25 PIM -22.0811 -69.3616 1650 95.08.18 21:35 95.09.09 22:30 Otto</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>328 PDAS 1. 14/2 L4-3D 1122 26 CAT -22.4736 -70.2150 70 95.08.16 16:05 95.09.22 15:15 Wylegalla</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>#1</th>
<th>#2</th>
<th>#3</th>
<th>#4</th>
<th>#5</th>
<th>#6</th>
<th>#7</th>
<th>#8</th>
<th>#9</th>
<th>#10</th>
<th>#11</th>
<th>#12</th>
<th>#13</th>
<th>#14</th>
<th>#15</th>
<th>#16</th>
</tr>
</thead>
</table>

Fig. 7.4: Experiment file for the Aftershock experiment drawn out after the 1995 Antofagasta earthquake in Chile. This type of experiment file is called the normal format. It contains 16 columns with logistic information, like datalogger type and number, sensor type and number, geographical position of station, station name, valid registration period and file format of datalogger with gain information. For a detailed description of the single entries in the experiment file, see the text. To identify the column we put the column number (symbol |#xx|) at the top and the bottom of the figure.
In the **1st field** the unique device number of the instrument (data logger) is shown. If your instrument hasn’t got a device id at all you have to indicate this with the value -1.

The **2nd field** includes a string naming your type of datalogger. This information is quite uncritical for the setup, but can be helpful later, when you find some problem or inconsistency in your network. GIANT ‘knows’ capital letter strings as PDAS, REFT, MARS, OBHGEOMAR, PCM5000, PCM5800, ORION and K2. This is of course a subjective list of instruments we have worked with or that are quite common in field experiments. The information will be put in the database and clicking on the station symbol in the Station Geometry window will give you this information back. If GIANT doesn’t know the string you wrote in the second field, the type UNKNOWN is written into the database. Don’t worry about an unrecognized datalogger type, this information is not critical for the use of GIANT and is thought mostly for a better overview and additional logistic information.

The **3rd column** contains the gain information. It is basically thought for your personal information and helps you to check the gain factor in the calibration files if you find some strange amplitudes in your data.

The **4th field** holds information of the format type of your datalogger. For PDAS instruments you have for example the values 16, 14/2 or 32. It is used to read the waveform files correctly when loading them to PITSA.

In the **5th column** you have to put the type of sensor you used with your data acquisition system. This could be for example well-known seismometer types like LE-3D, MARK or STS2.

The **6th field** contains the number of your sensor. It’s up to you which number you use, but you have to keep in mind that for one time period this number can’t be used at another station (You can’t use your sensor in two places at the same time). This number is important for GIANT! It is used for the first part of the calibration file name, which will be constructed automatically for one combination of datalogger and sensor (seismic station). The entry is thought to be an integer value in the range between 0 and 9999.

The second part of the calibration file name is constructed from the integer value stored in the **7th column** of the experiment file. This number has to be unique for one experiment file and therefore for one database, too. A change in the configuration of your seismic station leads always to a new number, although you still leave the station in the same place. The easiest way to account for this is to put the line number of your experiment file as the desired value. The program **giant_setup** assumes an integer value between 0 and 999.
The 8th field holds the station name. It’s a string up to three characters and it is bound to exactly one geographical position. If you changed the location of your station (datalogger/sensor combination) you must introduce a new station name (and a new station-number, too).

The next three fields contain the coordinates of the station. **Column no. 9** holds the geographical latitude (positive to north), **field no. 10** the geographical longitude (positive to east) and **column no. 11** the height above sea level (positive upwards) in meters.

In the 12th and 13th fields you find the start time of registration validity. These fields have a special format which looks like this: yy.mm.dd hh:mm. Only waveform data with a start time which is later than this time will be imported to the database.

The 14th and 15th field also contain a time information in the same format: yy.mm.dd hh:mm. This is the end time of registration validity. Waveform data with start times later than this time is not imported to the database.

The 16th column finally holds a string where you can put for example the name of the operator of the station - it has to be included to fulfil the requirement of 16 columns, but the string isn’t really used for the setup in GIANT.

**Important:** if you have PDAS files, giant_setup will check the station number in the waveform header against the device number (first column) in the experiment file. Only with GSE-waveform data you are allowed to neglect the device number and to insert the dummy value -1. The calibration file names for each station and component are created automatically out of the information given by the experiment file. How this is done will be explained in chapter 7.2.3 on page 81.

In the “long” format of the experiment file, there is one more field to add. Its position is between the 7th and the 8th column of the “normal” experiment file, the rest of the file is unchanged. The new entry was included for the following reason: with the “normal” experiment file you assume always (without explicitly mentioning it) that you are dealing with a one-component or a three-component station, that will properly assigned to the channels in the database. But what happens if you have a datalogger that can handle for example 6 or even more channels? Then you have to assign the channels of your datalogger to some meaningful channel in the database. Fig. 7.5 shows you an example of this modified experiment file with “long” format. The entry 0 can be used to indicate a 3-component station.
Fig. 7.5: Experiment file for the Hydrofrac experiment drawn out at the KTB deep drilling site in December 1994. This type of experiment file is called the long format. It contains 17 columns with logistic information, like datalogger type and number, sensor type and number, geographical position of station, station name, valid registration period and file format of datalogger with gain information. For a detailed description of the single entries in the experiment file, see the text. To identify the column we put the column number (symbol |#xx|) at the top and the bottom of the figure. The column number 9 holds the information about which channel of the datalogger shall be placed on which channel in the database.

<table>
<thead>
<tr>
<th>#1</th>
<th>#2</th>
<th>#3</th>
<th>#4</th>
<th>#5</th>
<th>#6</th>
<th>#7</th>
<th>#8</th>
<th>#9</th>
<th>#10</th>
<th>#11</th>
<th>#12</th>
<th>#13</th>
<th>#14</th>
<th>#15</th>
<th>#16</th>
<th>#17</th>
</tr>
</thead>
<tbody>
<tr>
<td>083</td>
<td>PDAS</td>
<td>100.0</td>
<td>16</td>
<td>MARK3K</td>
<td>0000</td>
<td>003</td>
<td>A2000</td>
<td>0</td>
<td>49.8158</td>
<td>12.1334</td>
<td>512</td>
<td>94.12.01</td>
<td>00:00</td>
<td>94.12.24</td>
<td>24:00</td>
<td>Nikolaus</td>
</tr>
<tr>
<td>083</td>
<td>PDAS</td>
<td>100.0</td>
<td>16</td>
<td>000MK3</td>
<td>0000</td>
<td>004</td>
<td>A210</td>
<td>4</td>
<td>49.8157</td>
<td>12.1369</td>
<td>504</td>
<td>94.12.01</td>
<td>00:00</td>
<td>94.12.24</td>
<td>24:00</td>
<td>Nikolaus</td>
</tr>
<tr>
<td>083</td>
<td>PDAS</td>
<td>100.0</td>
<td>16</td>
<td>000MK3</td>
<td>0000</td>
<td>005</td>
<td>A211</td>
<td></td>
<td>5</td>
<td>49.8147</td>
<td>12.1321</td>
<td>502</td>
<td>94.12.01</td>
<td>00:00</td>
<td>94.12.24</td>
<td>24:00</td>
</tr>
<tr>
<td>083</td>
<td>PDAS</td>
<td>100.0</td>
<td>16</td>
<td>000MK3</td>
<td>0000</td>
<td>006</td>
<td>A212</td>
<td>6</td>
<td>49.8173</td>
<td>12.1334</td>
<td>500</td>
<td>94.12.01</td>
<td>00:00</td>
<td>94.12.24</td>
<td>24:00</td>
<td>Nikolaus</td>
</tr>
<tr>
<td>360</td>
<td>PDAS</td>
<td>10.0</td>
<td>16</td>
<td>00GS13</td>
<td>0000</td>
<td>007</td>
<td>A300</td>
<td>0</td>
<td>49.8120</td>
<td>12.1108</td>
<td>547</td>
<td>94.12.01</td>
<td>00:00</td>
<td>94.12.24</td>
<td>24:00</td>
<td>Nikolaus</td>
</tr>
<tr>
<td>360</td>
<td>PDAS</td>
<td>10.0</td>
<td>16</td>
<td>00GS13</td>
<td>0000</td>
<td>008</td>
<td>A300</td>
<td>0</td>
<td>49.8120</td>
<td>12.1108</td>
<td>547</td>
<td>94.12.01</td>
<td>00:00</td>
<td>94.12.24</td>
<td>24:00</td>
<td>Nikolaus</td>
</tr>
<tr>
<td>360</td>
<td>PDAS</td>
<td>10.0</td>
<td>16</td>
<td>00GS13</td>
<td>0000</td>
<td>009</td>
<td>A300</td>
<td>0</td>
<td>49.8120</td>
<td>12.1108</td>
<td>547</td>
<td>94.12.01</td>
<td>00:00</td>
<td>94.12.24</td>
<td>24:00</td>
<td>Nikolaus</td>
</tr>
<tr>
<td>360</td>
<td>PDAS</td>
<td>100.0</td>
<td>16</td>
<td>000S13</td>
<td>0000</td>
<td>010</td>
<td>A310</td>
<td>4</td>
<td>49.8135</td>
<td>12.1115</td>
<td>535</td>
<td>94.12.01</td>
<td>00:00</td>
<td>94.12.24</td>
<td>24:00</td>
<td>Nikolaus</td>
</tr>
<tr>
<td>360</td>
<td>PDAS</td>
<td>100.0</td>
<td>16</td>
<td>000S13</td>
<td>0000</td>
<td>011</td>
<td>A311</td>
<td>5</td>
<td>49.8104</td>
<td>12.1114</td>
<td>540</td>
<td>94.12.01</td>
<td>00:00</td>
<td>94.12.24</td>
<td>24:00</td>
<td>Nikolaus</td>
</tr>
<tr>
<td>360</td>
<td>PDAS</td>
<td>100.0</td>
<td>16</td>
<td>000S13</td>
<td>0000</td>
<td>012</td>
<td>A312</td>
<td>6</td>
<td>49.8115</td>
<td>12.1074</td>
<td>562</td>
<td>94.12.01</td>
<td>00:00</td>
<td>94.12.24</td>
<td>24:00</td>
<td>Nikolaus</td>
</tr>
<tr>
<td>343</td>
<td>PDAS</td>
<td>100.0</td>
<td>16</td>
<td>000S13</td>
<td>0000</td>
<td>013</td>
<td>A400</td>
<td>0</td>
<td>49.8210</td>
<td>12.1107</td>
<td>515</td>
<td>94.12.01</td>
<td>00:00</td>
<td>94.12.24</td>
<td>24:00</td>
<td>Nikolaus</td>
</tr>
<tr>
<td>343</td>
<td>PDAS</td>
<td>100.0</td>
<td>16</td>
<td>000S13</td>
<td>0000</td>
<td>014</td>
<td>A400</td>
<td>0</td>
<td>49.8210</td>
<td>12.1107</td>
<td>515</td>
<td>94.12.01</td>
<td>00:00</td>
<td>94.12.24</td>
<td>24:00</td>
<td>Nikolaus</td>
</tr>
<tr>
<td>343</td>
<td>PDAS</td>
<td>100.0</td>
<td>16</td>
<td>000S13</td>
<td>0000</td>
<td>015</td>
<td>A400</td>
<td>0</td>
<td>49.8210</td>
<td>12.1107</td>
<td>515</td>
<td>94.12.01</td>
<td>00:00</td>
<td>94.12.24</td>
<td>24:00</td>
<td>Nikolaus</td>
</tr>
<tr>
<td>343</td>
<td>PDAS</td>
<td>100.0</td>
<td>16</td>
<td>000S13</td>
<td>0000</td>
<td>016</td>
<td>A410</td>
<td>4</td>
<td>49.8227</td>
<td>12.1104</td>
<td>480</td>
<td>94.12.01</td>
<td>00:00</td>
<td>94.12.24</td>
<td>24:00</td>
<td>Nikolaus</td>
</tr>
<tr>
<td>343</td>
<td>PDAS</td>
<td>100.0</td>
<td>16</td>
<td>000S13</td>
<td>0000</td>
<td>017</td>
<td>A411</td>
<td>5</td>
<td>49.8210</td>
<td>12.1131</td>
<td>502</td>
<td>94.12.01</td>
<td>00:00</td>
<td>94.12.24</td>
<td>24:00</td>
<td>Nikolaus</td>
</tr>
<tr>
<td>343</td>
<td>PDAS</td>
<td>100.0</td>
<td>16</td>
<td>000S13</td>
<td>0000</td>
<td>018</td>
<td>A412</td>
<td>6</td>
<td>49.8185</td>
<td>12.1106</td>
<td>515</td>
<td>94.12.01</td>
<td>00:00</td>
<td>94.12.24</td>
<td>24:00</td>
<td>Nikolaus</td>
</tr>
</tbody>
</table>
7.2.3 The calibration information and calibration file format

The `giant_setup` utility uses the entries in column 7 and 8 for building the calibration file name that will be assigned to the waveform data included. A trace that was recorded at some station with sensor number `xxxx` and station number `yyy` will be called: `xxxx_yyy.X` where `X` has to be `z`, `n` or `e` respectively to indicate vertical or the orientated horizontal components. This has the advantage that each component can have its own gain or preamplifier factor and that you can have different generator constants for the components. GIANT assumes to find the calibration files in the directory that is given by the environment variable `IATSN_CAL`.

The calibration file format was chosen to be the official GSE calibration file format describing the transfer function of your instrument with the positions of the poles and zeroes in the complex s-plane (PAZ format). For a detailed description of the GSE calibration format we suggest further reading in the PITSA or PREPROC manuals (see References). In this manual we shorten ourselves just to show you an example of a valid calibration file for a 1Hz velocity transducer in Fig. 7.6.

```
CAL1  BSJ   55_1 sz  PDAS PAZ 950910 1820 951010 1615
2
-4.64566  4.43310
-4.64566-4.43310
3
 0.00000  0.00000
 0.00000  0.00000
 0.00000  0.00000
273.200e+9
```

**Fig. 7.6:** Example of a valid calibration file in PAZ - GSE format. Mark L4 3 component Seismometer was used at station BSJ with an PDAS datalogger. The calibration file is valid in the time period from September, 9th in 1995 starting at 18:20h until September 10th, 1995 at 16:15h.
8 References


9 Appendix

The following structure is implemented into GIANT 1.1:

9.1 Data structure

Station struct

typedef struct station {
    char stat_code[6];         station code
    int chan_code;             channel id (1->Z, 2->N, 3->E)
    int stat_type;             type of recording system
    float stat_lon;            station longitude (Deg)
    float stat_lat;            station latitude (Deg)
    float stat_elav;           station elevation (km)
    float fcommon[3];          for further use
} Station;

Calibration struct

typedef struct calibration {
    double start_time;        start time of calibration
    double end_time;           end time of calibration
    char cal_name[40];         name of calibration file
    float fcommon[3];          for further use
} Calibration;

Seis_event struct

typedef struct seis_event {
    int event_no;              unique event number
    int cluster_id;            unique cluster number
    float fcommon[3];          for further use
} Seis_event;
**Trace_rec struct**

typedef struct trace_rec {
    int record_no; // unique record number
    double start_time; // time of first sample
    double end_time; // time of last sample
    float t_samp; // sampling rate (sec)
    int on_line; // data format (GSE | PDAS)
    char file_name[40]; // name of the data file
    int comp_spec; // usable for spectrum computation
    float fcommon[3]; // fcommon[0] flag for magnitude
                      // fcommon[1] value of magnitude
} Trace_rec;

**Spectrum struct**

typedef struct spectrum {
    int has_spec; // flag if spectrum is valid
    int spec_start; // index of first sample
    int spec_end; // index of last sample
    int noise_start; // index of first sample
    int noise_end; // index of last sample
    int nfft; // number of samples for the fft
    int type; // type of spectrum
    int taper_type; // type of taper function
    float taper_frac; // fraction of the window for tapering
    float noise_frac; // fraction of the window for tapering
    float rad_corr; // correction for radiatin pattern
    float rho_corr; // density used for the moment
    float vel_corr; // velocity used for the moment
    float surf_corr; // correction for the free surface
    float hypo_dist; // hypo_central distance
    float fcorn; // source corner frequency
    float moment; // source moment
    float src_exp; // source exponent
} Spectrum;
float qu0; absorption factor
float qalpha; frequency dependence of absorption
float res_freq; resonance frequency for a 1-layer model
float res_ampl; resonance amplitude for a 1-layer model
float delta_t; no use
float smooth_freq; smoothing width for the amplitude spectrum
float plateau; plateau value of the amplitude spectrum
float freq1; lowest frequency used in inversion
float freq2; highest frequency used in inversion
int max_it; maximum number of iterations in the inversion
int iteration; number of iteration used in the inversion
float residual; mean residual value
float fcommon[3]; for further use

} Spectrum;

Scal_wavelet struct
typedef struct scal_wavelet {
    char phase_name[20]; name of the phase including weight and polarity
    double onset_time; arrival time
    int onset_delta; onset region was determined
    double onset_range[2]; start- and end-time of the onset region
    double first_crossing; time of first crossing
    float rise_time; rise time of the phase
    float max_ampl; maximum amplitude of the phase
    double max_time; time of the maximum amplitude
    float min_ampl; minimum amplitude of the phase
    double min_time; time of the minimum amplitude
    float period; dominant period of the phase
    float moment; signal moment of the phase
    double t_param; not used
    float b_param; not used
    float c_param; not used
    int has_time_end; flag if an end time was determined
double time_end;  \quad \text{end time of the phase}
float azimuth;  \quad \text{determined azimuth of the phase}
float incident;  \quad \text{determined incident angle of the phase}
int rotation_type;  \quad \text{type of rotation}
float fcommon[3];  \quad \text{for further use}
}

\textbf{Vec\_phase struct}

typedef struct vec\_phase { \quad \text{currently not used}
    char vec\_name[20];  \quad \text{name of the vector phase}
double onset\_time1;  \quad \text{arrival time on comp 1}
double onset\_range1[2];  \quad \text{begin- and end-time of onset time range on comp 1}
double onset\_time2;  \quad \text{arrival time on comp 2}
double onset\_range2[2];  \quad \text{begin- and end-time of onset time range on comp 2}
float max\_vector1[3];  \quad \text{arrival time on comp 3}
double max\_time1;  \quad \text{begin- and end-time of onset time range on comp 3}
float min\_vector1[3];  \quad \text{amplitude of minimum vector}
double min\_time1;  \quad \text{time of minimum vector}
float max\_vector2[3];  \quad \text{amplitude of maximum vector}
double max\_time2;  \quad \text{time of maximum vector}
float min\_vector2[3];  \quad \text{amplitude of minimum vector 2}
double min\_time2;  \quad \text{time of minimum vector 2}
float fcommon[3];  \quad \text{for further use}
}

\textbf{Solution struct}

typedef struct solution { \quad \text{
    int event\_no;  \quad \text{unique event number}
    int solution\_id;  \quad \text{unique solution id}
    double orig\_time;  \quad \text{origin time of the earthquake}
    int best\_solution;  \quad \text{flag if this solution is the best}
    float event\_lon;  \quad \text{event longitude (Deg)}
    float event\_lat;  \quad \text{event latitude (Deg)}
    \text{}}
float event_depth;  
char hypo_prog[20]; 
char vel_model[20]; 
float rms_residual; 
float gap; 
float lat_error; 
float lon_error; 
float depth_error; 
int num_of_p; 
int num_of_s; 
float fcommon[3]; 
}

```c
Solution;
```

**Focal_mech struct**

typedef struct focal_mech {
    float strike_1;  
    float dip_1;  
    float rake_1;  
    float strike_2;  
    float dip_2;  
    float rake_2;  
    char progr_name[40]; 
    float fcommon[3]; 
} Focal_mech;

**Compu_phase struct**

typedef struct compu_phase {
    char phase_name[40]; 
    float residual; 
    float used_weight; 
    float used_delay; 
    float azimuth; 
    float backazimuth; 
} Compu_phase;
float incident;  
incident angle (Deg)

float epi_distance;  
epicentral distance (km)

float hypo_distance;  
hypocentral distance (km)

float fcommon[3];  
for further use

} Compu_phase;

**Source_spec struct**

typedef struct source_spec {
  float plateau;  
  plateau value

  float f_corn;  
  source corner frequency

  float q_value;  
  mean absorption value (Q)

  float src_exp;  
  source exponent

  float seis_moment;  
  seismic moment

  float radius;  
  source radius

  float s_drop;  
  stress drop

  float res_ampl;  
  mean resonance amplitude

  float res_freq;  
  mean resonance frequency

  float res_type;  
  resonance type

  float qual_fac;  
  quality measurement

  float fcommon[3];  
  for further use

} Source_spec;

**9.2 Set structure**

**Connection of the record struct thru the following links**

**set connection**

owner

member

**station_set**

station

trace_rec
calibration_set
  station
  calibration

wavelet_set
  trace_rec
  scal_wavelet

spectrum_set
  trace_rec
  spectrum

event_trace_set
  seis_event
  trace_rec

event_hypo_set
  seis_event
  solution

focal_set
  solution
  focal_mech

compu_phase_set
  solution
  compu_phase

wave_compu_set
  scal_wavelet
  compu_phase
hypo_spectrum_set
   solution
   spectrum

vec_phase_set
   vec_phase
   scal_wavelet

source_spec_set
   solution
   source_spec

false_pol_set
   focal_mech
   compu_phase

true_pol_set
   focal_mech
   compu_phase
# Table of Contents

## CHAPTER 1  Introduction

1.1 The Growth of an Idea ................................................. 2  
1.2 Acknowledgments ................................................... 3  

## CHAPTER 2  Software Installation

2.1 User Installation .................................................... 1  

## CHAPTER 3  Basic Operations

3.1 Why You Should Read the Rest of this Chapter.................. 1  
3.2 Typeface Conventions ............................................. 1  
3.3 Starting PITSA ..................................................... 1  
3.3.1 Colormap Allocation Problems .................................. 3  
3.3.2 Command Line Arguments ...................................... 3  
3.4 Message Windows .................................................. 4  
3.5 Selecting a Menu Item ............................................. 4  
3.6 Dialog Boxes and Text Input ....................................... 5  
3.6.1 Date-Time Formats .............................................. 6  
3.7 Dialog Menus ..................................................... 7  
3.8 Channel Lists ..................................................... 7  
3.9 Applying Tools to Multiple Channels ............................. 7  
3.10 Accepting New or Processed Traces ............................. 8  
3.11 Status Line ....................................................... 8  
3.12 Moving and Changing the Size of the Main Window .......... 9  
3.13 Function keys ..................................................... 9  
3.14 Last Command ...................................................... 9  
3.15 Quit ............................................................ 9  

## CHAPTER 4  Setup

4.1 Color Settings ..................................................... 1
Table of Contents

4.1.1 Example: Changing the Drawing Color .......................... 1

4.2 Program and Track Mode ........................................... 3
  4.2.1 Re-prompting for Input with the “?” Key ...................... 4
  4.2.2 Input from a Text File with the “~” Key .................... 4
  4.2.3 Looping in Track Mode ....................................... 4
    4.2.3.1 Example: Looping with Track Mode .................. 5
  4.2.4 Using the Default Value of Input with the “$” Key .......... 6

4.3 Saving Images from the Screen ................................... 6
  4.3.1 Hardcopy Mode ............................................. 6
  4.3.2 Hardcopy Destination ....................................... 7
    4.3.2.1 Writing Hardcopies to Screendump Files .............. 7
  4.3.3 Use of the F2 and F3 Function Keys ....................... 8
  4.3.4 Doubling the Font Size ................................... 8

4.4 Plot All Flag ................................................... 10

CHAPTER 5       Files and Traces

5.1 Data Traces within PITSA .......................................... 1

5.2 Supported File Formats ......................................... 2
  5.2.1 The ISAM Database File System ............................. 2
  5.2.2 ASCII Text File Format .................................... 2
  5.2.3 GSE Format ............................................... 2

5.3 Changing Directories ............................................ 3

5.4 Retrieve Files .................................................. 3
  5.4.1 Reading Data From ISAM File Systems ...................... 3
    5.4.1.1 Example: Reading ISAM files ....................... 4
  5.4.2 Reading Plain ASCII Files ................................ 5
    5.4.2.1 Single Trace ASCII File ............................. 7
    5.4.2.2 Multiple Trace ASCII File ......................... 7
  5.4.3 Reading GSE Format ........................................ 8

5.5 Save Files ..................................................... 8
  5.5.1 Writing an ISAM File System ............................... 9
  5.5.2 Writing ASCII Files ...................................... 9
  5.5.3 Writing GSE Files ....................................... 9

5.6 Add Traces From File .......................................... 9

5.7 Copy Traces ................................................... 10

5.8 Rearrange Traces ............................................... 11

5.9 Delete Traces .................................................. 12

CHAPTER 6       Routine Tools

6.1 Zoom .......................................................... 2
  6.1.1 Tapered vs. Untapered Windows ............................ 2
    6.1.1.1 Tapering Functions ................................. 2
  6.1.2 Channel List for Zooming .................................. 2
  6.1.3 Zoom Window Selection Methods ............................ 2
    6.1.3.1 Single Cursor ......................................... 3
    6.1.3.2 Double Cursor ........................................ 3
    6.1.3.3 Index ................................................ 3
    6.1.3.4 Accept window as is ................................. 3
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>6.1.4 Accepting the Zoomed Window</td>
<td>4</td>
</tr>
<tr>
<td>6.1.5 Selecting the Tapering Fraction</td>
<td>4</td>
</tr>
<tr>
<td>6.2 Edit</td>
<td>6</td>
</tr>
<tr>
<td>6.2.1 Point Editing</td>
<td>6</td>
</tr>
<tr>
<td>6.2.2 Glitch Editing</td>
<td>8</td>
</tr>
<tr>
<td>6.2.3 Despiking</td>
<td>9</td>
</tr>
<tr>
<td>6.3 Instrument Simulation</td>
<td>9</td>
</tr>
<tr>
<td>6.3.1 Please Use These Tools with Great Care!</td>
<td>10</td>
</tr>
<tr>
<td>6.3.2 Instrument Response Files and Formats</td>
<td>10</td>
</tr>
<tr>
<td>6.3.3 Choose Instrument Menu</td>
<td>11</td>
</tr>
<tr>
<td>6.3.4 Multiple Traces</td>
<td>11</td>
</tr>
<tr>
<td>6.3.5 Example: Creating an all-pass instrument response file</td>
<td>11</td>
</tr>
<tr>
<td>6.4 Phase Picking</td>
<td>12</td>
</tr>
<tr>
<td>6.4.1 Auto Pick Phase(s)</td>
<td>13</td>
</tr>
<tr>
<td>6.4.2 Adjust Phase(s)</td>
<td>14</td>
</tr>
<tr>
<td>6.4.2.1 Working with Many Traces</td>
<td>14</td>
</tr>
<tr>
<td>6.4.2.2 Controlling the Zoom Box</td>
<td>14</td>
</tr>
<tr>
<td>6.4.2.3 Controlling Which Traces are Displayed for Phase Adjustment</td>
<td>15</td>
</tr>
<tr>
<td>6.4.2.4 Picking Phases in Adjust Phase(s)</td>
<td>16</td>
</tr>
<tr>
<td>6.4.2.5 The display of overlapping phase labels</td>
<td>19</td>
</tr>
<tr>
<td>6.4.2.6 The active phase</td>
<td>20</td>
</tr>
<tr>
<td>6.4.2.7 Phase Labels</td>
<td>20</td>
</tr>
<tr>
<td>6.4.2.8 The Phase Menu</td>
<td>22</td>
</tr>
<tr>
<td>6.4.3 Show False Polarities</td>
<td>29</td>
</tr>
<tr>
<td>6.4.4 Show Greatest Residuals</td>
<td>29</td>
</tr>
<tr>
<td>6.4.5 Sort Traces by Distance</td>
<td>29</td>
</tr>
<tr>
<td>6.4.6 Sort Traces by Azimuth</td>
<td>29</td>
</tr>
<tr>
<td>6.4.7 Output Phase(s)</td>
<td>29</td>
</tr>
<tr>
<td>6.4.7.1 Processing of HYPO71 Phase Output Files</td>
<td>30</td>
</tr>
<tr>
<td>6.4.7.2 Processing of phase output files in the ISOP format</td>
<td>30</td>
</tr>
<tr>
<td>6.4.7.3 Processing of phase output files in the Long format</td>
<td>30</td>
</tr>
<tr>
<td>6.4.7.4 Phase Output Status Message</td>
<td>30</td>
</tr>
<tr>
<td>6.4.8 Output Station(s)</td>
<td>31</td>
</tr>
<tr>
<td>6.4.9 Run Location Program</td>
<td>31</td>
</tr>
<tr>
<td>6.4.9.1 Running HYPO71</td>
<td>31</td>
</tr>
<tr>
<td>6.4.9.2 Solving Problems with HYPO71</td>
<td>32</td>
</tr>
<tr>
<td>6.4.10 Clear Phases</td>
<td>32</td>
</tr>
<tr>
<td>6.4.10.1 Clearing All Phases</td>
<td>32</td>
</tr>
<tr>
<td>6.4.10.2 Clearing Selected Phases</td>
<td>32</td>
</tr>
<tr>
<td>6.4.11 Delete Traces</td>
<td>33</td>
</tr>
<tr>
<td>6.4.12 Plot All</td>
<td>33</td>
</tr>
<tr>
<td>6.4.13 DONE</td>
<td>33</td>
</tr>
<tr>
<td>6.5 Magnitudes</td>
<td>34</td>
</tr>
<tr>
<td>6.6 Integrate</td>
<td>40</td>
</tr>
<tr>
<td>6.7 Differentiate</td>
<td>41</td>
</tr>
<tr>
<td>6.8 Baseline Corrections</td>
<td>42</td>
</tr>
<tr>
<td>6.8.1 Running Average (Remove or Keep)</td>
<td>43</td>
</tr>
<tr>
<td>6.8.2 Offset</td>
<td>43</td>
</tr>
<tr>
<td>6.8.3 Linear Trend</td>
<td>43</td>
</tr>
<tr>
<td>6.8.4 Linear Regression</td>
<td>44</td>
</tr>
</tbody>
</table>
# Chapter 7 Advanced Tools

## 7.1 Filter
- 7.1.1 Forward-Backwards (Bilateral) Filtering ................................. 2
- 7.1.2 Butterworth Band Pass ......................................................... 2
- 7.1.3 Butterworth Low Pass .......................................................... 4
- 7.1.4 Butterworth High Pass .......................................................... 5
- 7.1.5 De-ringing Filter ................................................................. 5
- 7.1.6 Gaussian Band Pass ............................................................... 6
- 7.1.7 Notch Filter ........................................................................ 7
- 7.1.8 Seidl’s simulation ................................................................. 8
- 7.1.9 Difference Equation ............................................................... 8
- 7.1.10 GSE Calibration File ............................................................ 10
- 7.1.11 Evaluate GSE Response ....................................................... 10

## 7.2 Spectrum
- 7.2.1 Number of Points Used for FFT .............................................. 12
- 7.2.2 FFT .............................................................................. 12
- 7.2.3 Inverse FFT ................................................................. 15
- 7.2.4 Multiplex to FFT Format ....................................................... 16
- 7.2.5 Demultiplex from FFT Format ............................................... 17
- 7.2.6 Maximum Entropy Spectrum ................................................. 17
- 7.2.7 POW Spectrum ............................................................... 18
- 7.2.8 Wavelet Transform ............................................................. 19
  - 7.2.8.1 Wt .................................................................... 20
  - 7.2.8.2 inverse Wt ................................................................. 24

## 7.3 Cross Correlation ................................................................. 25

## 7.4 (De)convolution ................................................................. 26
- 7.4.1 Convolution (FREQ) ............................................................. 26
- 7.4.2 Convolution (TIME) .............................................................. 27
- 7.4.3 Deconvolution ..................................................................... 27

## 7.5 Particle Motion ................................................................. 28
- 7.5.1 2D Snake .................................................................... 29
  - 7.5.1.1 Estimating polarization angles from the 2-D display ....... 31
  - 7.5.1.2 Alternative displays of the particle motion snake ...... 33
  - 7.5.1.3 Phase picking from the particle motion plot ............... 33
- 7.5.2 3D Snake .................................................................... 33

## 7.6 Hilbert Transform (Envelope) .................................................... 37

## 7.7 Rotate Components ............................................................. 38
- 7.7.1 Back-azimuth ................................................................. 38
- 7.7.2 Incidence Angle ............................................................... 39
- 7.7.3 Rotate N’,E’ -> N,E ............................................................ 39
- 7.7.4 Rotate N,E -> R,T ............................................................ 39
  - 7.7.4.1 Determination of apparent incidence angle ............... 39
- 7.7.5 Rotate Z,N,E -> L,Q,T ...................................................... 41

## 7.8 Polarization Filter .............................................................. 42
- 7.8.1 Montalbetti and Kanasewich Filter ......................................... 42
- 7.8.2 Vidale Filter .................................................................. 44

## 7.9 Cross Spectrum ................................................................. 46

## 7.10 Coherence Spectrum .......................................................... 47

## 7.11 Response Spectrum .......................................................... 48
# PITSA Users Manual

## Table of Contents

### 7.12 Spectral Ratio

### CHAPTER 8 Utilities

<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>8.1</td>
<td>Test Signals</td>
<td>1</td>
</tr>
<tr>
<td>8.1.1</td>
<td>Add Noise</td>
<td>2</td>
</tr>
<tr>
<td>8.1.2</td>
<td>Sine/Cosine</td>
<td>3</td>
</tr>
<tr>
<td>8.1.3</td>
<td>Spike(s)</td>
<td>3</td>
</tr>
<tr>
<td>8.1.4</td>
<td>Constant</td>
<td>4</td>
</tr>
<tr>
<td>8.1.5</td>
<td>Brune Source Signal</td>
<td>5</td>
</tr>
<tr>
<td>8.1.6</td>
<td>Mixed Signal</td>
<td>5</td>
</tr>
<tr>
<td>8.1.7</td>
<td>Ricker Wavelet</td>
<td>6</td>
</tr>
<tr>
<td>8.1.8</td>
<td>Seismometer</td>
<td>7</td>
</tr>
<tr>
<td>8.1.9</td>
<td>Chirp Signal</td>
<td>7</td>
</tr>
<tr>
<td>8.1.10</td>
<td>RPN Equation</td>
<td>8</td>
</tr>
<tr>
<td>8.2</td>
<td>Trace Utilities</td>
<td>9</td>
</tr>
<tr>
<td>8.2.1</td>
<td>Single Channel Utilities</td>
<td>10</td>
</tr>
<tr>
<td>8.2.2</td>
<td>Double Channel Utilities</td>
<td>11</td>
</tr>
<tr>
<td>8.2.3</td>
<td>Triple Channel Utilities</td>
<td>12</td>
</tr>
<tr>
<td>8.2.4</td>
<td>Scale Traces Together</td>
<td>12</td>
</tr>
<tr>
<td>8.2.5</td>
<td>Re Autoscale Traces</td>
<td>13</td>
</tr>
<tr>
<td>8.2.6</td>
<td>Change Axis Type</td>
<td>14</td>
</tr>
<tr>
<td>8.2.7</td>
<td>Stack Traces</td>
<td>14</td>
</tr>
<tr>
<td>8.2.8</td>
<td>Unify Traces</td>
<td>15</td>
</tr>
<tr>
<td>8.2.9</td>
<td>Normalize Traces</td>
<td>15</td>
</tr>
<tr>
<td>8.3</td>
<td>Header Access</td>
<td>15</td>
</tr>
<tr>
<td>8.3.1</td>
<td>Station</td>
<td>15</td>
</tr>
<tr>
<td>8.3.2</td>
<td>Event</td>
<td>16</td>
</tr>
<tr>
<td>8.3.3</td>
<td>Record</td>
<td>17</td>
</tr>
<tr>
<td>8.3.4</td>
<td>Plot</td>
<td>17</td>
</tr>
<tr>
<td>8.3.5</td>
<td>Output</td>
<td>18</td>
</tr>
<tr>
<td>8.4</td>
<td>Phase Utilities</td>
<td>18</td>
</tr>
<tr>
<td>8.4.1</td>
<td>Mark slowness window at receivers</td>
<td>18</td>
</tr>
<tr>
<td>8.4.2</td>
<td>Align phases for receiver slowness</td>
<td>19</td>
</tr>
<tr>
<td>8.4.3</td>
<td>Cut phase windows</td>
<td>19</td>
</tr>
<tr>
<td>8.4.4</td>
<td>Relative onset time determination</td>
<td>19</td>
</tr>
<tr>
<td>8.5</td>
<td>Resampling</td>
<td>22</td>
</tr>
<tr>
<td>8.5.1</td>
<td>Simulate discretization in time</td>
<td>23</td>
</tr>
<tr>
<td>8.5.2</td>
<td>Reconstruction of discretized signals</td>
<td>24</td>
</tr>
<tr>
<td>8.5.3</td>
<td>Integer decimation</td>
<td>25</td>
</tr>
<tr>
<td>8.5.4</td>
<td>Resampling of interpolation polynomial (4-deg)</td>
<td>25</td>
</tr>
<tr>
<td>8.5.5</td>
<td>Simulate A/D Converter</td>
<td>26</td>
</tr>
<tr>
<td>8.5.5.1</td>
<td>How Gain-Ranging Works</td>
<td>27</td>
</tr>
<tr>
<td>8.5.5.2</td>
<td>Input Parameters</td>
<td>27</td>
</tr>
</tbody>
</table>
APPENDIX D  Command Files

APPENDIX E  GSE waveform format

APPENDIX F  GSE Instrument Response File

APPENDIX G  Automatic Phase Picking

APPENDIX H  Problem-Solving with HYPO71
CHAPTER 1

Introduction

PITSA is a flexible and powerful system for doing signal processing on digital seismic data. It has been used extensively in research and education, and can be used also for routine processing (such as is required at a seismic observatory). However, the extreme flexibility of PITSA makes it less suitable for this last task than a dedicated program (if one is available!).

The user can perform data editing functions such as trend removal and removal of spikes and glitches. PITSA offers a number of utilities for manipulation of seismic traces, such as shifting or scaling of traces, adding and concatenating traces, and stacking. For enhanced visualization of seismic traces, the user can create seismogram section plots with hypocentral distance on the horizontal axis and time on the vertical axis. PITSA automatically adjusts its scaling to different sampling rates.

PITSA contains extensive filtering functions, including Butterworth bandpass, lowpass, and highpass filters, Gaussian bandpass filters, notch filters, de-ringing filters, and polarization filters. Additional filters can be defined by the user by providing either the ARMA coefficients for the filter difference equation or the corresponding pole and zero distribution in the complex plane.

PITSA can be used to estimate earthquake magnitudes, integrate or differentiate seismic traces, analyze particle motions in 2 or 3 dimensions, perform convolution or deconvolution, correct for the transfer function of instruments and simulate arbitrary instruments from broadband signals, rotate components, perform baseline corrections, calculate wave envelopes, cross-correlate traces, and calculate FFTs and inverse FFTs. In addition, the user will find tools for cross-spectral analysis, coherence estimation, and the calculation of maximum entropy spectra.

Several tools are provided for onset time determination, including standard interactive phase picking, phase picking from particle motion diagrams and automatic P wave determination using the P phase picker of Baer and Kradolfer (1987). Phase picks which have been made automatically can be edited interactively by the user. The onset times can be directly used for locating earthquakes using HYPO71PC (Lee and Valdés, 1989).

In addition to its use for processing actual data, PITSA can create various test signals, resample traces and simulate the performance of gain-ranging A/D converters. This makes PITSA a versatile tool for demonstrating the principles of digital signal processing in a classroom environment. These capabilities are used extensively in

Internally, PITSA uses a data format designed for the specific needs of earthquake seismology. In addition to the trace data, PITSA stores logistical information on each trace (plotting information as well as event and station information). The information is kept in ISAM (Indexed Sequential Access Method) file systems for fast access. In addition, the input of plain ASCII files and files using the GSE (Group of Scientific Experts) format is possible.

PITSA is “trainable”, which means the user can teach it to repeat certain tasks without having to input redundant information. It is a common requirement of seismological research to process a series of traces in an identical manner. For example, it could be necessary to load a trace, perform a baseline correction, integrate it, calculate an FFT, and finally create a hardcopy. In its Program mode, PITSA records user keystrokes and menu traverses in a file. In its Track mode, PITSA uses this file to repeat the same sequence of operations except for the cases where user interaction is required. The user can even instruct PITSA to obtain input from a file during this process. For example, instead of having PITSA ask repeatedly for the file name of a data file to process, the file names could be read from a designated input file. Hence, for repetitive tasks the amount of user interaction—and the likelihood of errors—can be kept to a minimum.

PITSA has a menu-based user interface which guides the user through the many options available. Screen colors and drawing colors can be changed to suit the user. Dialog boxes and pop-up menus can be moved around freely to make optimal use of the screen. Hardcopies of the screen can be made at any time and sent to a printer or to a file.

1.1 The Growth of an Idea

The idea for PITSA started to develop during the spring of 1987 while one of us (Frank Scherbaum) was working at the Cooperative Institute for Research in Environmental Sciences (CIRES) in Boulder, Colorado, USA. Facing the need to analyze spectral parameters for about 3000 microearthquake records, the concept—an interactive set of signal processing tools which could be combined in an arbitrary fashion and programmed to do seismological routine analysis on a PC (running DOS of course) with minimal human interaction—popped up during a hike in the Indian Peaks Wilderness in Colorado. PITSA, for Programmable Interactive Toolbox for Seismological Analysis, sounded like a good name for such a satisfying idea. The first version of PITSA was programmed during the summer of 1987 and was used in the context of performing an inversion of spectral parameters of microearthquakes in Hawaii (Scherbaum, 1990; Scherbaum and Wyss, 1990).

In 1988, during a subsequent stay at the National Research Center for Disaster Prevention in Tsukuba, Japan, PITSA got its first major overhaul. Some of the concepts used in the original version (e.g., static memory allocation, EGA-specific graphics toolkit) put too many constraints on the type of computer that could be used and the length of the data which could be analyzed. PITSA was partially rewritten in the context of doing a study of regional events of much longer trace duration than the microearthquake signals analyzed previously (Scherbaum and Sato, 1991). The main changes at that time were the implementation of dynamic memory allocation and the use of Metagraphics’ MetaWINDOW™/PLUS graphics toolkit for the graphics functions.
During the summer of 1989, at the 25th General Assembly of IASPEI in Istanbul, Turkey, PITSA was demonstrated for the first time to a larger audience. The decision to produce a version of PITSA which could be distributed to other people was strongly motivated by the response to these demonstrations. Recognizing the variety of computer platforms people were using, and in anticipation of the growing importance of Unix workstations, it also seemed to be a worthwhile goal to try to make PITSA more hardware independent. Since the first two versions of PITSA were born out of the need to perform special tasks within the context of particular studies, most of the programming had been done in a 'quick and dirty' way. If Jim Johnson had not come to Munich in the spring of 1990 to start working on the X-Window version of PITSA, it certainly would have stayed that way.

It quickly became clear that it would not be possible to support a variety of computer architectures with a common code base without making major changes to the existing DOS-specific code. Following Jim's re-design of the plotting interface, virtually the entire program was rewritten to his strict standards of coding and error checking. In addition, we decided to use a virtual memory management system under DOS. Although we were largely successful in creating a common code base which would support both the DOS and Unix operating systems, management of the code size under DOS became a nightmare, threatening further development of PITSA. Therefore when the DOS version of PITSA was published in Volume 5 of the IASPEI Software Library, we decided to discontinue development of PITSA for the DOS operating system.

Current development of PITSA is focused solely on Unix-like operating systems using the X-Window graphic environment. This does not prevent the use of PITSA by people with PC hardware, however. By using the free Linux operating system, PCs can now run the latest version of PITSA, with capabilities far beyond those of the old DOS version.

This edition of the PITSA Manual is the first update in nearly 5 years. In that time, PITSA has changed tremendously, mostly through the hard efforts of Andreas Rietbrock, Joachim Wassermann, Matthias Ohrnberger, and Matthias Hardt, who developed many new tools to support various research efforts. Typical of graduate students, however, their efforts at documentation have not always been as keen as their devotion to their research. In 1997 the PITSA Team moved from the University of Munich to a new home at the University of Potsdam, where maintenance and development of PITSA is being turned over to a professional programmer, and PITSA's code is once more being cleaned up and revised. Some of the tools which were familiar in previous versions of PITSA have disappeared, for various reasons. An updated Manual was desperately needed!

1.2 Acknowledgments

Many of our colleagues, friends, and students have contributed to the development of PITSA through their encouragement, supportive criticism, suggestions and proofreading of the manuscript: Manfred Baer, Paul Bash, Nicolas Deichman, Thomas Dreher, Julien Frechet, Manfred Henger, Thomas Ketter, Michael Korn, Willie Lee, Anthony Lomax, Hansruedi Maurer, Dieter Mayer-Rosa, Christian Rocken (we are still waiting for the interpolator), Peter Rummel, Haruo Sato, Eberhard Schmedes, Dieter Stoll, and Peter Troitsky. We owe special thanks to Matthias Hardt, Andreas Rietbrock, and Joachim Wassermann for their help with debugging and but also with the coding of some of the tools.
Jim Johnson's stay at the Institut für Allgemeine und Angewandte Geophysik der Ludwig Maximilians Universität München was made possible through funding by Lennartz electronic, Tübingen, FRG, and the Institute of Geophysics of the ETH Zürich, Switzerland.

In 1991 IRIS became involved in the project by providing financial support to Jim Johnson and by loaning us a Sun workstation and a large hard disk. The University NAVSTAR Consortium (UNAVCO) also began to provide indirect support of PITSA by providing Jim Johnson with office space and computer support. Many thanks go out to Scott Watanabe and Myron McCallum of UNAVCO for helping Jim deal with numerous UNIX, X-Window, C and System Administration problems.

*Personal Note by Frank Scherbaum:* While I was fighting the memory- and code size problems on the PC and trying to keep my sanity in the presence of DOS, I was more than once close to giving up the whole project. If there hadn’t been the support by Marie-Jose, the talks with Jim on martial arts and computer programming, and the music of Tom Waits (Well there’s diamonds on my windshield and these tears from heaven…) I certainly would have given up.

*Personal Note by James Johnson:* I would like to thank Frank for getting this whole project going. I have learned a lot and will learn a lot more as I work on this project. Sylvia Chamberlain had to put up with my obsessive hours behind the computer screen and without her support and understanding, I would have never survived.
In the typical multi-user computer network PITSA should be installed in a system area by the system administrator so that all users of the system will have access to a single copy of the programs. In a single-user system PITSA could be installed in a users own home area. In this example, we will assume that the system administrator will be installing PITSA into the directory `/usr/home/pitsa`.

The PITSA program files and sample data files are distributed as a compressed tar-file named of `pitsa.dist.050193.tar.Z` where 050193 is the date of the release. The actual date of the release you use and the exact contents of the compressed tar files will vary slightly from the example given here. The file can be un-compressed and un-tarred with the following Unix commands:

```
cd /usr/home/pitsa
zcat pitsa.dist.050193.tar.Z | tar xvf -
chmod -R a+rX.
```

The above commands assume that the directory `/usr/home/pitsa` exists and that the tarfile `pitsa.dist.050193.tar.Z` has been moved to that directory. After the files have been un-tarred, the PITSA distribution file can be removed.

In the event that PITSA comes on some other media, follow the instructions that come with it.

### 2.1 User Installation

Each user who wants to use PITSA will have to make a few simple changes to her own environment, specifically, to the `.cshrc` file in her home directory. Because its name (like those of several other system files) starts with a dot, `.cshrc` is normally invisible. The Text Editor tool included with OpenWindows can open these files for editing, using the option to show invisible files. A similar text editor should be available under any other operating system.

First, the following lines should be added to the users `.cshrc` file. The lines beginning with `#` are comment lines, so they can be omitted. These environment variables tell the operating system where PITSA and its various supporting files and secondary programs (e.g., HYPO71) reside on the computer’s file system. We assume that
PITSA has been installed by the system administrator in the directory /usr/home/pitsa.

    # to minimize typing
    setenv PITSAHOME /usr/home/pitsa
    # puts PITSA in users path
    set path = ($path $PITSAHOME)
    # path for pitsa.cfg file
    setenv PITSA_CONFIG_PATH_ENV $PITSAHOME/
    # path for printer definition files
    setenv PITSA_PRINTDEF_PATH_ENV $PITSAHOME/pltdef/
    # default printer definition file
    setenv PITSA_PRINTDEF_NAME_ENV 8X11_landscape.PS
    # path to HYPO71
    setenv PITSA_HYPO71_PATH_ENV $PITSAHOME/hypo71

Now the modified .cshrc file needs to be re-introduced to the operating system by using the UNIX command source. This only needs to be done during a login session in which the .cshrc file has been changed, because the operating system checks the .cshrc file at each login

    source ~/.cshrc

Now you are ready to run PITSA.
3.1 Why You Should Read the Rest of this Chapter

Even if you are not a dedicated reader of manuals, you should take the time to read at least this chapter. It will give you the essential information about PITSA’s user interface and basic operations which are common to many of PITSA’s tools. With this knowledge you will be able to explore the many tools and features of PITSA efficiently.

3.2 Typeface Conventions

We will use the following font conventions in this Manual:

Table 3-1. Typeface conventions.

<table>
<thead>
<tr>
<th>Typeface</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain Courier</td>
<td>Used for user input, computer output, names of data files and directories, content of data files.</td>
</tr>
<tr>
<td>Italicized Times Roman</td>
<td>Used to indicate PITSA menu choices or options.</td>
</tr>
</tbody>
</table>

3.3 Starting PITSA

Assuming someone has installed PITSA according to the instructions in Chapter 2, you are now ready to start PITSA. You must be in OpenWindows (or some X-Win-dow environment). Then type the following command (in a Command Tool, Shell Tool or xterm window):

```
pitsa&
```

The “&” starts PITSA in the background and returns a prompt in the Command Tool window so you can issue additional commands. Depending on the contents of
the PITSA configuration file (Appendix B), some text similar to that shown below should appear in the window where PITSA was started:

PITSA Version 5.0 from Thu Feb 02 15:16:48 MET DST 1999
now loading.....

by
Frank Scherbaum, James Johnson and Andreas Rietbrock

Additional contributions by
Elke Schmidtke, Joachim Wassermann, Matthias Hardt and Matthias Ohrnberger

HEADER: 11744 2936
Configuration path: /usr/home/pitsa/
Hypo71 path: /usr/home/pitsa//hypo71
LocSAT path: ./
MENU_POST: <Btn3Up>
MENU_SLCT: <Btn1Up>
TEXT_MARG: 4
CANVAS_WIDTH: 600
CANVAS_HEIGHT: 400
DRAW_1_COLOR: black
DRAW_2_COLOR: red
BACKGROUND_COLOR: white
KILL_NOTE: FALSE
SET_FOCUS: TRUE
SET_FOCUS_LOOP: 10
MAX_NOCH: 30
MAX_TRLEN: 8192000
Printer definition file path: /usr/home/pitsa//pltdef/
Printer definition file name: 8X11_ landscape.PS

Screen size is: 1152 X 900

Then the PITSA main window should appear (Figure 3-1).
Admittedly, it is not very exciting, but soon you will learn how to add some seismological content. The identification “spitsa” in the title bar of Figure 3-1 simply reflects the name given to the executable file of the developmental version of PITSA used to make this screen-shot.

3.3.1 Colormap Allocation Problems

When you issue the command to start PITSA in a Command Tool window, you may also see a long list of warning messages like:

- Warning: Cannot allocate colormap entry for "gray79"
- Warning: Cannot allocate colormap entry for "gray78"
- Warning: Cannot allocate colormap entry for "gray77"
- ...

The reason for these warnings is that another program (FrameMaker is one known culprit) which is already running on your workstation has allocated these colormap entries. This can cause display problems in PITSA, so if it occurs you should logout and login again before starting PITSA. If you need to run PITSA simultaneously with an offending program, start PITSA first. The other program will probably be able to build its own colormap if it encounters a conflict.

3.3.2 Command Line Arguments

There are two command line arguments that can be specified when starting PITSA. If the `-c` option is used, the argument following the `-c` is taken to be the name of a command file (Appendix D) to execute. After the command file is finished, PITSA will be in its home state. The `-C` option works in the same way except that after the command file is finished, PITSA will terminate. An example might be:

`my_machine:/usr/a_user% pitsa -c load_data.cmd`
This example would execute the command file `load_data.cmd` (see Section 4.2) before allowing the user to make menu selections.

### 3.4 Message Windows

On occasion PITSA will display a message window providing special information (e.g., an error message, results of an analysis, etc.).

*Figure 3-2. A message window.*

Message windows come in two flavors. If a message vanishes automatically after a few seconds (“volatile message”, no further interaction is required. If a message does not vanish automatically after a few seconds (“non-volatile message”, it expects to be acknowledged by clicking the *Continue* button.

Both volatile and non-volatile messages can be moved by clicking the left mouse button in the border of the message and dragging it to a new location. In Figure 3-2 above, the arrow indicates one place the mouse pointer could be in order to move a message.

### 3.5 Selecting a Menu Item

PITSA’s tools are all accessed through menu commands, but when the program is started (Figure 3-1), no menus are visible. This is because PITSA uses a pop-up style main menu. To see this menu, just click the right mouse button while the mouse pointer is somewhere within the PITSA main window. Press then release the mouse button; the menu will not appear until the mouse button is released. When this is done, the following pop-up main menu will appear (Figure 3-3):

*Figure 3-3. PITSA’s main menu.*

In the above figure, the menu item *Last Command* is highlighted. This is because the mouse pointer is inside the menu items box. The highlighted command may be activated by clicking the left mouse button.

Except for the *Last Command* and *Quit* selections, all the menu items in the main menu have sub-menus. In order to access these sub-menus, PITSA uses a ‘walking menus’ approach. If the mouse pointer is moved (no buttons need be pressed) over
the arrow to the right of the menu item, a new menu box will appear as in Figure 3-4.

Figure 3-4. The sub-menu of Routine Tools has been activated by moving the mouse pointer over the arrow to the right of the Routine Tools selection.

In the above figure, the Routine Tools sub-menu has been activated. Notice that some of the sub-menu selections themselves have sub-menus (which we resist calling sub-sub-menus). If the left mouse button were now clicked while in the Routine Tools -> Zoom menu item, no action would take place and the entire menu would disappear. This is because the Routine Tools -> Zoom item has additional selections that must be made. In order to make a valid selection, the user must ‘walk’ all the way down to the bottom of the string of sub-menus, which means getting to a menu item with no arrow to the right of it. Figure 3-5 shows the menu after selecting the sub-menu of Routine Tools -> Zoom.

Figure 3-5. The Main Menu with two levels of sub-menus activated. In this case, if the left mouse button were to be clicked, the selection Routine Tools -> Zoom -> Untapered would be made.

Remember: Menu names and options are italicized in this manual.

3.6 Dialog Boxes and Text Input

Many tools in PITSA require the user to enter some additional parameters or information. Text input is obtained through dialog boxes. Unlike message windows, these cannot be moved.
Figure 3-6. An example of a PITSA text input window.

<table>
<thead>
<tr>
<th>Enter time of first sample:</th>
</tr>
</thead>
<tbody>
<tr>
<td>1983 01 01 23 59 59.999</td>
</tr>
</tbody>
</table>

Year Month Day Hour Min Sec, sec
Dec 10th 1989 15:55:34.644 is entered as:
1989 12 10 19 55 34.644

The first line is the general question, followed on the second line by the text input area which is followed by an explanation of the text to be input.

Notice that the text input area is highlighted. This means that the text input window has keyboard focus (any key strokes will be directed to this window). In most cases text input windows will have keyboard focus when they appear. If they do not, you will have to move the cursor into the text input area.

On many occasions (as in the example shown), PITSA will display a dialog box with some default value(s) for the input it is expecting. You can accept the default value(s) by simply hitting RETURN.

If you do not wish to use the default value(s), the text in the input window can be edited with standard key strokes, such as the forward and backward arrows. The small carot at the baseline before the first character of the text input is the cursor. The following table lists actions that can be taken on the text input window. Two useful actions to remember are that a Shift-DEL will clear the input window and a double click with the mouse pointer in the text input window will act as a RETURN.

Table 3-2. Editing keys for text in dialog boxes.

<table>
<thead>
<tr>
<th>Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-&gt;:</td>
<td>Move to the next character position on the right</td>
</tr>
<tr>
<td>&lt;-</td>
<td>Move to the previous character position on the left</td>
</tr>
<tr>
<td>BACKSPACE, DEL</td>
<td>Delete the last character and move one position left.</td>
</tr>
<tr>
<td>Shift-DEL</td>
<td>Clear input window.</td>
</tr>
<tr>
<td>Shift-Click</td>
<td>Move to beginning of character at mouse position.</td>
</tr>
<tr>
<td>ESC</td>
<td>Restore entry field and return to top level of PITSA.</td>
</tr>
<tr>
<td>CR, Double-Click</td>
<td>Accept current entry and continue.</td>
</tr>
</tbody>
</table>

3.6.1 Date-Time Formats

Figure 3-6 shows an example of a PITSA dialog box which requests the user to input a date and time. It includes a template for such input, in which each item is separated by a space. PITSA will accept some variations on this format. Here are the rules which govern the formatting of date-time entries to PITSA, not only in dialog boxes, but also in reading ASCII-format data files (Section 5.4.2):

- Year is given with 4 digits.
- All six elements (year, month, day, hour, minute, seconds) must be given, in this order.
- The elements of the format may be separated by spaces, even multiple spaces, or single hyphens or colons. No spaces are allowed around hyphens or colons.
Some examples of legal date-time specifications:

1998 10 24 10 30 12.512345
1997 9 1 1 55 20.2
1998-5-24 10:30:1

### 3.7 Dialog Menus

PITSA also gets user input from stand alone pop-up menus. Figure 3-7 shows an example of a dialog menu:

**Figure 3-7. An example of a PITSA dialog pop-up menu.**

A menu selection is made by simply clicking (left mouse button) on the desired menu option. The `<ESCAPE>` option will terminate the current operation and bring PITSA back to the main menu state.

### 3.8 Channel Lists

PITSA organizes traces by numbering them, starting with 1. In many tools, PITSA will ask for a channel list to process. To specify the traces that are desired, the user enters the trace numbers separated by commas. There are also some abbreviations that can be used to select a range of traces.

The colon `:` provides an easy way to define a range of channels. If the user wants to read in channels \( n_1 \) up to \( n_2 \), entering \( n_1:n_2 \) would be equivalent to entering the complete channel list from \( n_1 \) to \( n_2 \). (e.g., \( 1:3 \) would be equivalent to \( 1,2,3 \)).

The semicolon `;` is understood as “up to the last channel”. Hence, \( n_1; \) would select all channels from \( n_1 \) to the end or the maximum number of channels allowed. If you wanted to specify all ten traces, you would only have to enter `;`.

Repeated indices are allowed, and channel indices can be specified in any order.

### 3.9 Applying Tools to Multiple Channels

When a channel list of more than one trace is selected for a tool, PITSA will pop-up a message window to ask an additional question after all processing steps have been completed (Figure 3-8). In most tools, a number of selections are made pertaining to the way the tool processes a trace. For example, when an FFT is performed, the number of points for the FFT has to be selected. PITSA gives you the
option of applying all the selections that have been made for the first trace to the remaining traces. This is accomplished by selecting the *Use selection(s) for remaining traces*. Alternately, you can have PITSA ask for the input values individually for each trace by selecting *Ask again for each trace*. The *ESCAPE* option will abort the entire procedure.

**Figure 3-8. Additional menu that appears after processing the first trace of a multi-trace channel list.**

![Popup Menu](image)

### 3.10 Accepting New or Processed Traces

Most of the tools in PITSA either alter existing traces or create new traces. In this case, PITSA always requests instructions from the user as to what to do with these traces (Figure 3-9).

**Figure 3-9. Menu that appears after PITSA has either processed existing traces or created new ones.**

![Popup Menu](image)

The *Accept/Append Traces* option will cause PITSA to add the new traces to the current list. In the case that traces have been altered by some processing step, such as integration, PITSA can also replace the source traces with the processed traces with the *Accept/Replace Traces* option. If new traces have been created, such as in creating test signals, the new traces can only be appended. The *Accept/Replace Traces* option will still appear, but its effect will be the same as *Accept/Append Traces*. The *Ignore New Traces* option will still appear, but its effect will be the same as *Accept/Append Traces*. The *Ignore New Traces* option will toss out the new traces while the *ESCAPE* option will abort the procedure. The *ESCAPE* option is different from the *Ignore New Traces* option in the event that more than one trace is being operated on. In the case of *Ignore New Traces*, PITSA will continue on to the next trace in the channel list (Section 3.8) while *ESCAPE* will put PITSA back into its home state.

### 3.11 Status Line

At the bottom of the main window there is a status line (Figure 3-10) which displays the state of some of the setup options.
Figure 3-10. The status line at the bottom of PITSA’s main window.

Action indicates what PITSA is currently doing (i.e., plotting, thinking, etc.),
Mode shows if PITSA is in Program or Track Mode and Hardcopy shows if the
Hardcopy Mode is ON or OFF.

3.12 Moving and Changing the Size of the Main Window

The PITSA main window can be both moved and re-sized like standard OpenWindows applications. The only stipulation is that the PITSA main window should only be re-sized when it is in its home state—all loaded traces are displayed and the main menu is available. If PITSA is resized during the operation of one of its tools, the actual plotting area will not change until PITSA returns to its home state.

3.13 Function keys

Earlier versions of PITSA included on-line context-sensitive help, activated by the F1 function key. This feature is, regrettably, absent from the current version. An alternative strategy, based on an HTML version of this manual, is being developed.

Of the remaining function keys, only F2 and F3 are currently used in PITSA, and they are used for printing functions (Section 4.3.3), sending high- and low-resolution screendumps to the printer or to a file. Printing can only be done when the Hardcopy Mode is set to ON using the Setup menu (Chapter 4).

3.14 Last Command

PITSA contains a miniature history function which can be used to repeat the last command which has been selected from the main menu at the top level of the program. Simply select the Last Command option from the main menu. Notice, that this feature only repeats the main menu selection, however, none of the submenu selections which may pop up at a later time. Nevertheless, in many situations this feature provides a convenient shortcut.

3.15 Quit

Selecting Quit will terminate the PITSA session (Figure 3-11).
Figure 3-11. The *Quit* menu option will terminate the PITSA session.

<table>
<thead>
<tr>
<th>Main Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Last Command</td>
</tr>
<tr>
<td>Routine Tools →</td>
</tr>
<tr>
<td>Advanced Tools →</td>
</tr>
<tr>
<td>Files/Traces →</td>
</tr>
<tr>
<td>Utilities →</td>
</tr>
<tr>
<td>Special Plots →</td>
</tr>
<tr>
<td>Setup →</td>
</tr>
<tr>
<td>Quit →</td>
</tr>
</tbody>
</table>
This chapter describes how to use the Setup menu options (Table 4-1), which control how PITSA looks and acts. Aspects of PITSA’s behavior which may be modified fall into four main categories:

- Choice of screen colors
- Running PITSA in a semi-automated fashion using Program mode and Track mode
- Saving screen shots as graphic files or sending them to a printer
- Whether or not to replot all traces after an action has been performed.

The current settings for the Program or Track modes and the hardcopy option are always shown in the status line at the bottom of the main screen.

### 4.1 Color Settings

On a color monitor, there are three different colors which you may set to change the visual appearance of the PITSA plotting screen (Table 4-1). We’ll demonstrate this by showing how to change the setting of Drawing Color 1.

#### 4.1.1 Example: Changing the Drawing Color 1.

- Select the Setup -> Drawing Color 1 option.
- After this selection is made, the entire PITSA window will be painted with the current Drawing Color 1 (the default is black). To change the color, clear out the entry in the text window and type the name of the color you want. The text window can be quickly cleared by typing a `<Shift><DEL>`. For example, if you want the Drawing Color 1 to be yellow, simply type that into the text input window as in Figure 4-1.
Table 4-1. Menu selections available under Setup.

<table>
<thead>
<tr>
<th>Menu Selection</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Background Color</td>
<td>Changes the background color.</td>
</tr>
<tr>
<td>Drawing Color 1</td>
<td>Changes the color PITSA uses for all primary graphics.</td>
</tr>
<tr>
<td>Drawing Color 2</td>
<td>Changes the color PITSA uses for all secondary graphics, including things like resulting traces, phase picks, etc.</td>
</tr>
<tr>
<td>Program Mode</td>
<td>If Program Mode is not currently on, this selection turns on the Program Mode. If Program Mode is already on, then the current command file is closed and Program Mode is turned off. When PITSA is in Program Mode, all commands and input are stored in a command file that can be later re-played with Track Mode.</td>
</tr>
<tr>
<td>Track Mode</td>
<td>Track Mode executes a command file that has been created while PITSA was in Program Mode.</td>
</tr>
<tr>
<td>Hardcopy Mode ON</td>
<td>Turns on the Hardcopy Mode—a screeendump can be created by pressing the F2 key. When Hardcopy Mode is on, plotting is slowed down considerably and thus it is preferable to keep Hardcopy Mode off until it is needed.</td>
</tr>
<tr>
<td>Hardcopy Mode Off</td>
<td>Turns PITSA’s Hardcopy Mode off.</td>
</tr>
<tr>
<td>Double Font Size</td>
<td>Will double the size of text on the computer screen. This is useful when creating hard copies in order to get larger text.</td>
</tr>
<tr>
<td>Normal Font Size</td>
<td>Turns off the Double Font Size option.</td>
</tr>
<tr>
<td>Turn Plot All On</td>
<td>By default, PITSA replots all channels currently loaded after every operation is complete. For a large number of traces, this can take a long time. This option can be turned off with Turn Plot All Off (next selection) and on with this selection.</td>
</tr>
<tr>
<td>Turn Plot All Off</td>
<td>Turns off the Plot All option as described above.</td>
</tr>
</tbody>
</table>

Figure 4-1. Text input window that appears for changing Drawing Color 1.

```
Enter the name for the new Drawing 1 color:
yellow
The current Drawing 1 color is being displayed
```

- After you hit Enter, PITSA will fill the window with the color you selected and prompt you with the following question “Take the new Drawing 1 color? (y/n)” (Figure 4-2).

Figure 4-2. Text input window to verify the new Drawing 1 Color.

```
Take the new Drawing 1 color? (y/n)
y
```

- If you like the color choice you made, you can hit RETURN and it will be accepted. If you don’t like the color, you can enter ‘n’ and re-enter the color you want. As with all input windows in PITSA, you can hit the ESC key to cancel the operation.
4.2 Program and Track Mode

The Program / Track Mode combination is a powerful way to process large amounts of data routinely. Especially if the same sequence of operations is needed with different data files, but with only slightly different input parameters for each file.

If Track Mode is set to ON, PITSA is running under partial control of a so-called command file which contains the sequence of operations PITSA should perform. Normally the command file that is executed is created by recording steps that are taken in PITSA while the Program Mode is on. The two modes are analogous to record and play on a cassette tape deck. Commands are recorded while in the Program Mode and then later played back in the Track Mode. The Program Mode is a little more sophisticated than simply recording steps since conditions can be placed on some input so that when the command file is played back in Track Mode, some input windows will not appear.

To set Program mode to ON, select Program Mode from the Setup menu. You will be asked to name of the command file you are creating. After you enter a valid Unix file name (e.g., test.cmd) you can proceed to perform the sequence of operations you want to perform. Commands and input are recorded in the command file until the Program Mode is toggled to OFF, by selecting Setup -> Program Mode again from the main menu.

If the command file name you specified already exists, the following menu dialog will appear (Figure 4-3):

Figure 4-3. Menu dialog that appears if the command file specified for Program mode already exists.

Re-enter File Name will return you to the text input window that asks for the file name, Overwrite File will erase the current file and start ‘recording’ at the beginning of an empty file, and Append will append to the end of the existing file. <ESCAPE> will cancel the operation.

The directory that PITSA will use to read and write command files will initially be the directory where PITSA was started. This directory can be changed by selecting Files/Traces -> Change Directory (Section 5.3).

The command file is an ASCII text file which can be viewed with any text editor. For information on the format of this file, see Appendix D.

The command file can be executed at any time by toggling the Track Mode to ON by selecting Setup -> Track Mode from the main menu. PITSA will ask for the name of the command file to process (e.g., test.cmd). Once a valid file name is entered (one that exists and is in the correct format), PITSA will be run under control of the command file.
4.2.1 Re-prompting for Input with the “?” Key

There won’t be many procedures that will be repeated with exactly the same input parameters for all the input required. Usually you will want to define a procedure where some of the input parameters will be fixed while others are specified interactively. This is quite easy to do in Program Mode. By default, PITSA (in Track Mode) replays all text input exactly as it was typed while Program Mode was ON. In fact, PITSA does not even pop up the input windows since it already knows what the input should be. To force PITSA to re-prompt for input at a certain step, the corresponding text that you input while in Program Mode should be preceded with a question mark ‘?’. PITSA will strip off the question mark before using the input (for the current process) and make a note in the command file that this input should be acquired from the user interactively when the command file is executed. While in Track Mode, all the input which was not preceded with a ‘?’ will have disappeared and the corresponding values will be taken from the command file.

4.2.2 Input from a Text File with the “~” Key

PITSA can also be directed to read parameters from a text file. While in Program Mode, instead of giving the answer to a question directly, you can enter the file name of a file where PITSA will find the answer; to tell PITSA that you are referring to a file, precede the file name with a tilde ‘~’. PITSA will read the first line of this file and assume it contains the answer to the question being asked. It will then create a new file with the same name with the first line stripped off—PITSA “consumes” one line of the text file each time it needs that particular input parameter.

This input file must exist before using the “~” key option in either Program or Track Mode, as the input file is stripped of the first line in both modes. Therefore it is not easy to see how one can create the file at all. If you know PITSA well enough, you might be able to construct the file directly. However, you can also build input files while running PITSA in Program Mode by editing the input file and a “master input file” in two other Unix windows while issuing commands to PITSA. When PITSA requires text from the input file (because you used the “~” key), you would copy a single line into the input file (before hitting the RETURN key), and also append the line to the end of the master input file. After the Program Mode is finished, the master input file can be copied to be used in the Track Mode.

4.2.3 Looping in Track Mode

It is sometimes useful to run PITSA in a semi-automated endless loop, and this can be done with the modifier keys introduced above. The basic technique is to enter Track Mode from within Program Mode. Then enter the name of the command file currently being created as the name of the command file to read from. In this case PITSA will turn the Program Mode OFF and start executing the command file from the beginning in Track Mode, repeating the operations that have just been performed. Wherever input was preceded with a ‘?’, the user will be asked for new input, while the other parameters are taken from the command file. Wherever input was preceded with a ‘~’, PITSA will read the first line of this parameter file and take it as the answer to the question being asked. As soon as the Track Mode gets to the bottom of the command file, it will “rewind” the command file and start again. This is not really an endless loop if input is being taken from a file since after each input item is taken from the file, it becomes one line shorter. Eventually, the input file will become empty and Track Mode will terminate with an error (Figure 4-4):
4.2.3.1 Example: Looping with Track Mode.

Suppose you had 5 ISAM file systems with a single trace in each file on which you wanted to perform a baseline correction followed by an integration. For this example you should use the test signals utilities (Section 8.1) to create 5 ISAM files with names TLOOP1 through TLOOP5, and save them in a directory named demodata below the PITSA directory.

Issue the following commands to start PITSA.

```bash
cd ~/pitsa/demodata
cp input.sav input.fil
rm testloop.cmd
rm tloop?n.*
pitsa&
```

What we just did was to change into the directory where the demo data files live, and create a file named input.fil that contains the names of the five ISAM file systems we want to operate on (you could also use your favorite editor to do this). Then we deleted files that would have been created if this example had been run before, and started PITSA. The file input.sav is the master input file that we don’t want destroyed, which is why we made a copy of it to ‘feed’ to PITSA. You should view the contents of input.sav so you can follow along with what is being input to PITSA as input.fil is being consumed. The input file has the ISAM file names listed twice since we will first read them in (requiring the file names), operate on them, then save them (again requiring a file name). We started PITSA in the background so that the Unix window in which PITSA was started would not be tied up. Once PITSA has started, make the following menu selections:

- Select Setup -> Program Mode
- Enter testloop.cmd as the name of the command file.
- Select Files / Traces -> Retrieve Files -> ISAM
- Enter ~input.fil for the name of the ISAM file.
- Select Routine Tools -> Baseline Correction -> Offset Removal
- Select Accept/Append Traces
- Select Routine Tools -> Integrate -> Tick’s rule
- Enter 2 for the channel to process.
- Select Accept/Append Traces
- Select Files / Traces -> Save Files -> ISAM
- Enter ~input.file for the name of the ISAM file system.
- Enter ; for the channel list to write. This will be the default.
- Select Setup -> Track Mode
- Enter testloop.cmd as the name of the track file.
- Select CONTINUE
When we start tracking the command file that we are building, PITSA will execute the commands in a loop until all input is taken from the input file and an error message will appear. Once the command file finishes, there will be 5 new ISAM file systems with three traces in each file system (the original trace, the trace with offset removed, and the integrated trace).

### 4.2.4 Using the Default Value of Input with the “$” Key

There is one more text input modifier that can be used to control how the Track Mode deals with text input. If the first character of the line is a dollar sign ‘$’ then the default value that is passed to the text input window from PITSA will be used. This can be useful when creating command files that will be used on data sets of unknown length. For example, suppose it is desired to take the FFT of any trace. If the number of FFT points is entered as a specific number, then the FFT will always use the same number of points. If, however, the ‘$’ modifier is used, then the value that PITSA calculates for the number of points for the FFT (calculated as the minimum power of 2 that covers all points) will be used.

Table 4-2. Input modifiers for text input windows in Program and Track Mode.

<table>
<thead>
<tr>
<th>Input Modifier</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>? &lt;text&gt;</td>
<td>When Track Mode gets to this input window, it will stop and re-ask the question instead of using the text input.</td>
</tr>
<tr>
<td>$ &lt;text&gt;</td>
<td>When Track Mode gets to this input window, it will use the default text passed into the text window instead of the text input.</td>
</tr>
<tr>
<td>~ &lt;file name&gt;</td>
<td>Input will be obtained from in input file named after the ~. This is true for both Track and Program Mode.</td>
</tr>
</tbody>
</table>

### 4.3 Saving Images from the Screen

Several options in the Setup menu relate to a very important task—saving screen images, either as printed hardcopy or as graphic files. Saving a graphics file to the hard disk is considered to be another form of “hardcopy”.

#### 4.3.1 Hardcopy Mode

In order to make hardcopies, PITSA must first be in the hardcopy mode. This is achieved by selecting Setup - > Hardcopy On. Once the hardcopy mode is on, you can make a hardcopy at any time by hitting the F2 or F3 function keys (the difference is explained in Section 4.3.3). This will cause a copy of the current screen image to be written to a screendump file or to the printer directly. When the hardcopy mode is on, PITSA will be quite a bit slower displaying graphics. This is because PITSA’s hardcopies are not simply pixel dumps of the screen. PITSA stores all the information needed to generate high resolution vector plots of the screen, which means that PITSA has to record a lot of extra information in temporary files which slows down the graphics. In order to turn the hardcopy mode off, select Setup - > Hardcopy Mode Off from the main menu.
4.3.2 Hardcopy Destination

When Setup → Hardcopy Mode On is selected, the user will be asked several questions. The first question will have to do with where the screendumps are sent, either directly to the printer or to a numbered file. The following menu will appear:

Figure 4-5. The menu dialog pop-up that appears when Setup -> Hardcopy Mode On is selected.

If you select the To Printer option, PITSA will then ask for the name of the plotter definition file. This is the file PITSA uses to build printer commands. PITSA expects this file to be in the directory defined by the system variable PITSA_PRINTDEF_PATH_ENV, which you defined in your .cshrc file. PITSA will insert the default printer definition file name that is defined by the environment variable PITSA_PRINTDEF_NAME_ENV, which should also be in the .cshrc file, but others could be defined as well.

Figure 4-6. Text input window that asks for the name of the plotter definition file.

The default printer definition file which comes with the standard distribution of PITSA is called 8X11_landscape.PS. This printer definition file will generate screendumps compatible with standard PostScript printers using a page size of 8-1/2 x 11 inches in landscape mode.

After the plotter definition file has been specified, you can send a screendump to the printer at any time by pressing the F2 or F3 keys (Section 4.3.3).

Note: In order for the hardcopy feature to work correctly, the user must make sure that the printer configuration file contains the correct information (see Appendix C).

4.3.2.1 Writing Hardcopies to Screendump Files

If To Numbered File is selected in Figure 4-5, then an additional text input window will appear. This text input window will ask for a base filename to use for the plot output files, which will be stored in the current directory by default. The file names will be based on the specified base filename, starting with plotout<base-name>.001 for the first file and plotout<base-name>.002.plotout<base-name>.003, etc. for subsequent files.

As with the printer option discussed above, the F2 and F3 keys are used to save a screen image to a file (Section 4.3.3).

You can print the screendump files using the Unix command lpr. To print the file test1.001, type:
4.3.3 Use of the F2 and F3 Function Keys

To send the current screen image to the printer or save it to a file, press the F2 or F3 function key. The F2 key makes a high-resolution image—all the vector drawing information is retained and used. The F3 key implements a low-resolution format, a bitmapped image from the screen. Obviously, file sizes will be smaller and print times will be shorter with the F3 option.

4.3.4 Doubling the Font Size

When screen images are created—especially when they are to be printed or saved to a file—it is sometimes desirable to increase the font size so that text is more legible. This can be easily accomplished by selecting Setup -> Double Font Size. When this item is selected, all characters will be doubled in size. An example of the effect of this option is shown in Figure 4-8 and Figure 4-9.
Figure 4-8. A sample display with normal font size.

Figure 4-9. Same as Figure 4-8 with the font size set to double.

In Figure 4-9 the time labels on the x-axis overlap because of the large font size. The window could be made larger so that the numbers do not overlap. On the screen, the characters look rough. However, when a screendump is created, the characters will be plotted smoothly.
4.4 Plot All Flag

PITSA normally replots the screen after any operation which causes the screen to change, no matter how insignificant the change. Although we have tried to reduce the plotting overhead as much as possible, in some cases (e.g., if you are working with a large number of long traces) you may want to override PITSA’s default behavior. Setting the *Plot All* flag to OFF prevents PITSA from reploting the main screen after each processing function. Turning the *Plot All* flag OFF does not affect any other plotting operations. You can turn off the *Plot All* flag by selecting *Setup* -> *Turn Plot All Off* from the main menu and turn it on by selecting *Setup* -> *Turn Plot All On*. When the *Plot All* flag is OFF, PITSA will display a message window showing how many traces are currently loaded.
This chapter covers basic trace management and file I/O options in PITSA. Here you will find information on how to load and save data from and to disk, and how to copy, rearrange, or delete data traces.

Specifically, this chapter covers the commands and options available under the *Files/Traces* menu:

**Table 5-1. A list of the options available under *Files/Traces*.**

<table>
<thead>
<tr>
<th>Menu Selection</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Directory</td>
<td>Changes the directory PITSA uses to read and write data files.</td>
</tr>
<tr>
<td>Retrieve Files</td>
<td>Retrieve data files from disk, replacing all current traces.</td>
</tr>
<tr>
<td>Save Files</td>
<td>Saves a user-selectable list of currently loaded traces to disk.</td>
</tr>
<tr>
<td>Add Traces From File</td>
<td>Retrieves data files from disk, but unlike <em>Retrieve Files</em>, new traces are appended to the current list of traces.</td>
</tr>
<tr>
<td>Copy Traces</td>
<td>Creates copies of selected existing traces.</td>
</tr>
<tr>
<td>Rearrange Traces</td>
<td>Rearranges the display order of existing traces.</td>
</tr>
<tr>
<td>Delete Traces</td>
<td>Removes selected traces from memory (not disk).</td>
</tr>
</tbody>
</table>

### 5.1 Data Traces within PITSA

A data trace within PITSA consists of a collection of information, kept within a data structure (C language). The pointer to the actual trace is just one of the elements of this 'data header'. Other elements contain plotting information (e.g., the current zooming information, labels, etc.), station information (coordinates, name, etc.), event information (coordinates, magnitudes, etc.), and record information (time of first sample, sampling rate, phase picks, etc.). Some of this information is essential to PITSA (e.g., the sampling rate), others are only used occasionally (e.g., picked phases).
5.2 Supported File Formats

PITSA currently supports several standard file formats, but not as many as some earlier versions of the program. In particular, support for SEED and SUDS is no longer provided. The main reason for this reduction in scope is the difficulty in maintaining support for multiple formats which are themselves undergoing continual evolution. The issue of supporting various popular formats is never finally decided, however, and it is possible that some of these formats could make a return, or that new ones will be added. The authors welcome your comments regarding file formats which should be supported, and especially your source codes for implementing those formats. Currently PITSA supports the following types of data files:

<table>
<thead>
<tr>
<th>Format Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ISAM</td>
<td>Indexed Sequential Access Method. This is PITSA's native data format and all header information, such as scaling and zooming parameters, are stored in this type of data file.</td>
</tr>
<tr>
<td>ASCII</td>
<td>This format contains data points, one per line, in an editable ASCII text file. In addition to the data points, a minimal amount of header information is required.</td>
</tr>
<tr>
<td>GSE</td>
<td>The GSE waveform format is an ASCII file format and therefore platform independent. It contains a one or two line short standardized header (as was specified by the GSE group), the data sections and a checksum entry at the end for verification purposes.</td>
</tr>
</tbody>
</table>

5.2.1 The ISAM Database File System

On disk, data are kept in an ISAM (Indexed Sequential Access Method) database file system for fast and easy access. ISAM file systems consist of at least three files: two files containing the headers and the indexing information for all the traces and one trace file per channel. The trace file is simply a binary image of the floating point data which—in principle—can be accessed independently. All files in an ISAM file system have the same filename base, and different extensions to indicate their function. The extensions are .nx0 and .dt for the database files, and .001, .002, etc. for the trace files.

5.2.2 ASCII Text File Format

In addition to ISAM file systems, PITSA can read and write data files in a plain ASCII text file. A number of header fields are defined for this format, but none of them are required—only a special line must appear at the beginning of each trace. The trace data are given, one point per line. ASCII files can contain multiple data traces.

5.2.3 GSE Format

In the Conference on Disarmament an Ad Hoc Group of Scientific Experts (GSE) was established in 1976 working on the task of giving guidelines for international cooperative measures to detect and identify seismic events for the use of monitoring a Comprehensive Test Ban Treaty. Since then the GSE has developed several data exchange systems which have been widely tested in two technical tests.
(GSETT1 and GSETT2). The complete GSE message concept allows to exchange quite more information than only seismic waveform data. However at this point we refer in our context only to the GSE waveform format and in Chapter 6.3 to the format used for specifying calibration (instrument response) information. GSE is widely used and at present implemented in most AutoDRM systems for quick and reliable data exchange worldwide. There exist several subformats inside GSE, the most common are supported in PITSA. For a further description see Appendix E.

5.3 Changing Directories

The directory that PITSA will use to load and save data files will initially be the directory where PITSA was started. This will also be the directory where PITSA will read and write command files for the Program and Track Mode. This directory can be changed by selecting Files/Traces -> Change Directory. When this selection is made, the following text input window will appear (Figure 5-1):

Figure 5-1. The Change Directory dialog window.

<table>
<thead>
<tr>
<th>Enter the new path name for data files</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
</tr>
</tbody>
</table>

Current path is ./

To enter a new directory, type Shift-Delete to clear the default entry and then type the desired path. Paths can be either relative or absolute.

Note that PITSA does not check that the path you specified is valid! If you are subsequently unable to load the files you want, double-check the directory path which PITSA is using.

5.4 Retrieve Files

In order to read in data from disk, start PITSA from the directory containing the data (or use the Change Directories command) and select Retrieve Files from the Files/Traces menu. The user will be prompted for the file type. The Retrieve Files command will first clear PITSA of any currently-loaded traces. Traces may be added to the currently-loaded set using the Add Traces from File menu command (Section 5.6).

5.4.1 Reading Data From ISAM File Systems

To read data from an ISAM file system, select ISAM as the file type with the Retrieve Files menu command. You will be asked to enter the name of the ISAM file system. Enter only the basename without any extension.

If you have selected a valid ISAM file name, PITSA will check for the existence of the corresponding files on disk, make a consistency check and determine the total number of traces within the file system. Then you will be prompted for the channel list to load. See Section 3.8 for details of channel list specification.
5.4.1.1 Example: Reading ISAM files.

For this example, we will load in an ISAM file system named isam1 that is stored in the PITSA/demodata directory. You should have received a sample dataset with the PITSA distribution, but it will not necessarily be the same one. Therefore, substitute the appropriate path, file names, channel numbers, etc., for your own dataset in the commands given below:

- Select Files/Traces -> Retrieve Files -> ISAM from the main menu.
- Enter isam1 as the name of the file system.

PITSA will now be asking for the channel list to load. In order to read in channels 1, 3, 4, 5, 2, 9, 10, 11, and 12 from the example file system, enter: 1, 3:5, 2, 9; followed by a CR (Figure 5-2).

**Figure 5-2. Abbreviated channel list selection for trace input.**

Next, PITSA will check the file system for internal consistency and extract the data headers corresponding to the selected channels. Finally it will retrieve the data traces and display them on the screen (Figure 5-3). Of course your display will be different if you used a different dataset. Notice that PITSA re-numbers the traces starting with 1.

**Figure 5-3. Reading a selected number of channels from an ISAM file system.**
5.4.2 Reading Plain ASCII Files

To load a plain ASCII datafile into PITSA, select option ASCII for the file type with the Retrieve Files menu command. In addition to the data values which are stored one per line, optional header information may be included at the top of the file. A line containing header information starts with a hash (#) symbol, followed immediately by the name of the header parameter to be given, a space, and the value of that header parameter. It is required that each trace begin with a line containing a hash (#) symbol in the first position. This may be followed by header information, or the remainder of the first line may be blank. Header information may be given in any order.

Although it is possible to read a file of trace data with no header information, this will seldom be a useful option for anything except demonstration purposes. PITSA will use default values for any parameters it requires for plotting or other functions. At the very least you will probably want to specify the sampling rate (PITSA uses 100 sps as default) and the start time of the trace.
### Table 5-3. Header Fields Defined for the ASCII File Format

<table>
<thead>
<tr>
<th>Header Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>EVT_X</td>
<td>Event longitude or x-coordinate (degrees or km)</td>
</tr>
<tr>
<td>EVT_Y</td>
<td>Event latitude or y-coordinate (degrees or km)</td>
</tr>
<tr>
<td>EVT_Z</td>
<td>Event focal depth (km)</td>
</tr>
<tr>
<td>EVT_COORD_TYPE</td>
<td>Event coordinate units:&lt;br&gt;0 = degrees/degrees/km&lt;br&gt;1 = km/km/km</td>
</tr>
<tr>
<td>EVT_TIME</td>
<td>Origin time (see Section 3.6.1 for formats)</td>
</tr>
<tr>
<td>EVT_COMMENT</td>
<td>Comment (39 characters max)</td>
</tr>
<tr>
<td>EVT_AZ</td>
<td>Azimuth (epicenter to station)</td>
</tr>
<tr>
<td>EVT_BACK_AZ</td>
<td>Back-azimuth (station to epicenter)</td>
</tr>
<tr>
<td>EVT_HYPO_DIST</td>
<td>Hypocentral distance (km)</td>
</tr>
<tr>
<td>EVT_EPI_DIST</td>
<td>Epicentral distance (degrees)</td>
</tr>
<tr>
<td>EVT_TYPE</td>
<td>E.g., “Local”, “Tele” (5 characters max)</td>
</tr>
<tr>
<td>EVT_LOCAL_MAG</td>
<td>Local magnitude (M_L)</td>
</tr>
<tr>
<td>EVT_BODY_WAVE_MAG</td>
<td>Body wave magnitude (m_b)</td>
</tr>
<tr>
<td>EVT_SURFACE_WAVE_MAG</td>
<td>Surface wave magnitude (M_S)</td>
</tr>
<tr>
<td>EVT_DURATION_MAG</td>
<td>Duration magnitude (M_D)</td>
</tr>
<tr>
<td>EVT_MOMENT_MAG</td>
<td>Moment magnitude (M_W)</td>
</tr>
<tr>
<td>START_TIME</td>
<td>Trace start time (see Section 3.6.1 for formats)</td>
</tr>
<tr>
<td>SAMP_FREQ</td>
<td>Sample frequency (samples/sec)</td>
</tr>
<tr>
<td>NDAT</td>
<td>Number of data points</td>
</tr>
<tr>
<td>STA_CODE</td>
<td>Station code (5 characters max)</td>
</tr>
<tr>
<td>STA_CHAN</td>
<td>Channel code, e.g., bhz, spn (5 characters max)</td>
</tr>
<tr>
<td>STA_TYPE</td>
<td>E.g., “WWSSN” (7 characters max)</td>
</tr>
<tr>
<td>STA_X</td>
<td>Station longitude or x-coordinate (degrees or km)</td>
</tr>
<tr>
<td>STA_Y</td>
<td>Station latitude or y-coordinate (degrees or km)</td>
</tr>
<tr>
<td>STA_Z</td>
<td>Station elevation, km</td>
</tr>
<tr>
<td>STA_COORD_TYPE</td>
<td>Station coordinate units:&lt;br&gt;0 = degrees/degrees/km&lt;br&gt;1 = km/km/km</td>
</tr>
<tr>
<td>STA_COMMENT</td>
<td>Comment (39 characters max)</td>
</tr>
<tr>
<td>STA_LOCATION_NUMBER</td>
<td>Station location ID code (integer)</td>
</tr>
<tr>
<td>INSTRUMENT_NUMBER</td>
<td>Instrument ID number (integer)</td>
</tr>
</tbody>
</table>
Reading ASCII files gives you the flexibility to quickly visualize a wide variety of data types. However, in order to use the full power of PITSA you may want to provide more information (e.g., label settings, station and/or event information, etc.). You can set most of the header parameters from within PITSA using the Header Access option from the Utility menu.

### 5.4.2.1 Single Trace ASCII File

The following lines show the beginning of an ASCII format data file containing a single trace (although it could just as well be the beginning of a multi-trace file), including a number of header items. A few points of the trace data are shown after the last header line.

```
#SAMP_FREQ 100.163937
#STA_X -121.096001
#STA_Y 36.661301
#STA_Z 0.488000
#STA_COORD_TYPE 0
#STA_CODE BEMV
#STA_CHAN spV
#EVT_X -121.714729
#EVT_Y 37.227287
#EVT_Z 0.000000
#EVT_COORD_TYPE 0
#EVT_TIME 1989 10 24 10 42 23.391325

-57
-53
-55
-59
...
```

Note that different formats have been used to input date-time parameters for the header fields START_TIME and EVT_TIME. See Section 3.6.1 for a discussion of legal formats for these fields.

An example of the beginning of an ASCII data file with no header information is given next:

```
#11715
7662
6470
7424
6708
7900
...
```

After PITSA processes the file, you will be shown the channel selection dialog box as usual—in this case it will contain only a single channel.

### 5.4.2.2 Multiple Trace ASCII File

Multiple-trace ASCII files can be constructed by concatenating single-trace ASCII files. No additional header fields are required.
A simple multiple-trace ASCII file is illustrated in the following lines:

```
#START_TIME 1997-01-31 02:44:35.000000
#NDAT 18000
#SAMP_FREQ 100.000000
#STA_CODE MIE_
  11715
  7662
  6470
  (17994 points not shown)
-2112
-1397
-1874
#START_TIME 1997-01-31 02:44:35.000000
#NDAT 18000
#SAMP_FREQ 100.000000
#STA_CODE NUN_
 -3748
 -2317
 -1364
 (17997 points not shown)
``` 

After PITSA processes the file, you will be shown the channel selection dialog box as usual.

### 5.4.3 Reading GSE Format

PITSA is able to read GSE files in single-trace or multi-trace files. However, not all possible flavors of GSE are supported. The currently supported format types are given in Table 5-4. For conversion between different flavors of GSE, please use the conversion routine ‘codeco’ from Urs Kradolfer (for more information on conversion utilities, please see [http://orfeus.knmi.nl/other.services/conversion.html](http://orfeus.knmi.nl/other.services/conversion.html)).

To load a GSE datafile into PITSA, select option GSE for the file type with the Retrieve Files menu command. If the GSE-file contains more than one trace the user is asked for the channel list to be loaded.

<table>
<thead>
<tr>
<th>GSE format</th>
<th>GSE subformat</th>
<th>Differences</th>
</tr>
</thead>
<tbody>
<tr>
<td>GSE1.0</td>
<td>CMP6 (6 bit compressed ASCII)</td>
<td>0-2</td>
</tr>
<tr>
<td>GSE1.0</td>
<td>INTV (variable integer format, ASCII)</td>
<td>0-2</td>
</tr>
<tr>
<td>GSE2.0</td>
<td>CM6 (6 bit compressed ASCII)</td>
<td>2</td>
</tr>
<tr>
<td>GSE2.0</td>
<td>INT (integer format, ASCII)</td>
<td>0</td>
</tr>
</tbody>
</table>

### 5.5 Save Files

The user can write trace data from PITSA to disk in either ISAM, GSE, or ASCII format.
5.5.1 Writing an ISAM File System

First the user selects ISAM as file format from the Save file menu. Next, they enter a valid file name for the new ISAM file system without extension. Before writing the data to disk, PITSA will check for the existence of a file system with that name. If it finds one, the user will be asked if they want to append to it (enter letter a), overwrite it (enter letter o), or cancel the whole output (enter letter i for ignore or hit the <Escape> key). If the user has selected the overwrite option it may take a couple of seconds to delete all the corresponding files, depending on the actual size of the file system.

Next, the user will be asked for the list of channels to write (Section 3.8). During the trace output, you will see note windows popping up, informing you about the trace file names currently being written.

5.5.2 Writing ASCII Files

To save the currently loaded traces in ASCII format, select ASCII as the output file format from the Save Files menu. In a submenu you can specify if you want to write all channels to a single file - single file option - or each selected channel to an extra file - multiple file option. In the multiple file selection each file will get an automatically created extension \texttt{.axx}', where \texttt{xx}' is running from \texttt{01}' to \texttt{99}'. You will be asked to enter a filename and the channel list of selected channels to write. If the specified file name already exists, PITSA will ask you for overwrite permission.

PITSA will write all available header information for each trace to the file, including any header fields defined during processing with the \textit{Header Access} command.

5.5.3 Writing GSE Files

To save the currently loaded traces in GSE format, select GSE as the output file format from the Save Files menu. As for the ASCII output either a single file or a multiple file can be written according to your selection in the following sub-menu. You will be asked to enter a filename and the channel list of selected channels to write. When writing multiple files, each file will get an automatically created extension as \texttt{.gxx}', where \texttt{xx}' is a running from \texttt{01}' to \texttt{99}'.

The type of GSE chosen for writing is given by four entries in the pitsa.cfg file, named GSE_1OR2, GSE_FORM, GSE_NDIFF, GSE_RESOL. Here you can select between the subformats of GSE as given in Table 5-4. A more detailed description of these entries is to be found in Appendix B. If no entries could be found in the pitsa.cfg file then GSE1.0, variable Integer format INTV, and 2nd differences with a resolution of 16 are used as default values.

PITSA will write all available header information for each trace to the file, as long as they are used in the GSE format.

5.6 Add Traces From File

Selecting this option will allow the user to read additional channels into PITSA from an ISAM, ASCII or GSE file and append them to the currently loaded traces. If you load traces with the \textit{Retrieve Files} option, PITSA first clears out all the exist-
ing channels before loading in the new channels. Using *Add Traces from File*, you can combine traces from different file formats, e.g., adding traces from an ASCII file to traces currently loaded from an ISAM file system.

When you select *Add Traces from File*, you will be asked for the name of the file from which to add traces, and then for the channel list of the channels to add. New traces are always appended at the bottom of the screen, but they can be re-arranged afterwards (Section 5.8). Figure 5-4 shows the result of loading three channels, and then using the *Add Traces from File* command to add three additional channels with different sample rates. PITSA adjusts its labeling depending on the sampling rate and the trace length.

**Figure 5-4. Adding traces from an ISAM file system.** The top three channels were loaded first.

![Figure 5-4](image)

### 5.7 Copy Traces

It is often useful in the research or educational context to duplicate a trace for further (or alternative) processing. This is done with the *Copy Traces* menu Command. When you select this command, you will be asked for the source channel list (to copy from) and the destination channel list (to copy to). The number of channels in these lists must match. Undefined traces are filled with copies of the first trace. Existing traces will be over-written if they appear in the destination channel list.

Figure 5-5 shows the result of using *Copy Traces* to duplicate channels 1 and 3 of Figure 5-4 into channels 8 and 9. Channel 7 was not defined in the process and it was filled automatically by another copy of channel 1.
5.8 Rearrange Traces

The *Rearrange Traces* command allows the user to rearrange the order of traces on the screen (e.g., to change the sequence of a three-component record from vertical, N-S, E-W to E-W, N-S, vertical). The user must only enter two sets of channel lists, corresponding to the current and the desired sequence. The number of channels in the two lists must, obviously, be equal. No traces are created or destroyed with this command. Figure 5-6 shows the result of interchanging the traces 7-9 with traces 4-6 in Figure 5-5.
5.9 Delete Traces

This option is used to remove selected traces from PITSA’s memory. After selecting Files/Traces -> Delete Traces, you will be asked for the channel list of traces to delete. After deletion, traces will be lost from memory and can only be recovered by re-loading from the hard disk (if they have been saved) or some backup medium. Disk files are *not* affected by this option. You must use a Unix command, outside of PITSA, to delete a file from disk. Figure 5-7 shows the result of using Delete Traces to remove channels 4-6 from Figure 5-6.
Figure 5-7. Deleting traces 4, 5, and 6 from Figure 5-6.
CHAPTER 6  

**Routine Tools**

This chapter describes the tools in PITSA which you are likely to use most frequently. They fall into two categories:

- Tools for manipulating trace data, such as “zooming in” for a closer view of a portion of a trace or cutting a small portion out for further analysis, performing simple point-by-point data editing functions, making baseline corrections, and integrating or differentiating traces.

- Basic “seismological” tools, such as phase picking, instrument correction, earthquake location, and magnitude estimation.

These tools are accessed through the *Routine Tools* command in the main menu. The options available under *Routine Tools* are shown in Table 6-1:

**Table 6-1. The options available under Routine Tools.**

<table>
<thead>
<tr>
<th>Menu Selection</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zoom</td>
<td>Select a portion of a trace using the cursor or by giving the indices of the points desired.</td>
</tr>
<tr>
<td>Edit</td>
<td>Simple data editing tasks such as single point editing, glitch editing, and automatic spike removal.</td>
</tr>
<tr>
<td>Instrument Simulation</td>
<td>Simulating some standard seismometer using the PREPROC software library written by Zmeskal and Plesinger.</td>
</tr>
<tr>
<td>Phase Picking</td>
<td>An extensive set of tools for picking and editing phase arrivals, an automatic P picker, and a location routine.</td>
</tr>
<tr>
<td>Magnitudes</td>
<td>Calculating several types of magnitudes.</td>
</tr>
<tr>
<td>Integrate</td>
<td>Digital integration on selected traces.</td>
</tr>
<tr>
<td>Differentiate</td>
<td>Digital differentiation on selected traces.</td>
</tr>
<tr>
<td>Baseline Correction</td>
<td>Correct baseline offset of traces by several methods.</td>
</tr>
</tbody>
</table>
6.1 Zoom

In order to zoom in on a portion of the traces, the Zoom tool from the Routine Tools menu is selected.

6.1.1 Tapered vs. Untapered Windows

First you will be prompted for the type of zooming window. There are two choices:

- Untapered zooming
- Tapered zooming.

6.1.1.1 Tapering Functions

If you select Tapered zooming, the data within the selected window will be multiplied by a taper function which rises from a value of 0 at the margins to a value of 1 in the central portion of the window. The extent of the regions (at the left and right margins of the window) over which the taper function will be applied is determined later by the choice of the taper fraction parameter (Section 6.1.5).

The types of taper functions which are available are:

- Bartlett
- Cosine
- Hamming
- Hanning
- Boxcar
- Parzen
- Welch

For a discussion of the characteristics of different taper functions, see Press et al. (1988). PITSA includes so many taper functions primarily for educational purposes. The choice of taper function is mainly important if you intend to carry out additional operations in the frequency domain.

6.1.2 Channel List for Zooming

As with most tools in PITSA, you will be asked to specify the list of channels on which to operate. It is possible to zoom on more than one trace at a time, however, the traces must all have the same sampling rate, trace lengths and onset times (PITSA will confirm this).

6.1.3 Zoom Window Selection Methods

Next you will be asked to select a method for specifying the zoom window (Figure 6-1).
Several combinations of cursor selection and index selection are available.

6.1.3.1 Single Cursor

To look at a window of predetermined length but select the onset of the window using a cross hair cursor, choose the option *Single Cursor*. You will be prompted for the window length (in points) and then be given a cross hair cursor to interactively select the first point of the zoom window. Click the left mouse button to select a point.

6.1.3.2 Double Cursor

To select both margins of the zoom window interactively, choose *Double cursor*. You will be presented with the cross hair cursor twice. Click the left mouse button to select each point.

6.1.3.3 Index

To zoom in on a trace portion of \( n \) points in length starting at point \( m \), select option *Index* and enter the appropriate values for the index of the starting point and the length of the desired zoom window.

6.1.3.4 Accept window as is

To take the complete trace length, select *Accept window as is*. The zooming procedure is often automatically activated as the first option for other tools, but it is not always desirable to use it. The *Accept window as is* option aborts the zoom tool.

Figure 6-2 shows an example of the use of the cursor to select the left margin of a zoom window. The note window shows the actual cursor position in absolute time, and the indices and data values of the current sample point and its nearest neighbors.
6.1.4 Accepting the Zoomed Window

After selecting the window margins, you will be prompted for acceptance of the selection (Figure 6-3).

Figure 6-3. Accepting the zoomed window.

If Adjust zoom window is selected the current zoom window will be re-displayed and you will be able to adjust the margins. If you select the left (or right) margin during adjusting, PITSA assumes that you want the left (or right) margin extended back to the first point. Using this technique you can increase the size of the zoom window without having to exit the zoom tool. When you are satisfied with the selection of the window margin, choose Accept zoom window.

6.1.5 Selecting the Tapering Fraction

If you have chosen to use a tapering function in the zoom tool, PITSA will now (i.e., after the zoom window has been selected) prompt you for the tapering fraction which defines the proportion of the zoom window to which the tapering function will be applied.
The taper fraction parameter was a value between 0 and 1. A value of 0 would cause no tapering at all, and a value of 1 would cause the entire zoom window (100%) to be affected by the taper function (except a single point in the center of the zoom window). With a value of 0.5, 50% of the window would be affected (25% on each side).

After the taper fraction is selected, PITSA will display the zoomed up trace(s) followed by the trace(s) with the taper function applied. Overlaid on the tapered traces will be the actual taper function used (Figure 6-4).

**Figure 6-4. The zoom window with tapering.**

![The zoom window with tapering](image)

There is a slight difference in entering the amount of tapering to be applied to the zoom window if the user has chosen the Index selection mode. In this case, tapering is defined by 4 indices: n1, n2, n3, and n4. n1 and n4 are simply the indices of the left and right zoom window margins, respectively. Indices n2 and n3 define where the tapering of the left and the right margin, respectively, stop. In this case, the user will be asked to enter values for indices n2 and n3 instead of entering a taper fraction. It is permissible to enter values which yield different tapering window lengths at the left and right margins.

Next you are presented with the standard PITSA menu window to select what to do with the new traces. Figure 6-5 shows the PITSA window after zoomed traces have been appended.
Figure 6-5. The PITSA window after zooming in on the P arrivals of the top three traces and selecting the Accept/Append Traces option.

If multiple traces were selected for tapered zooming, the menu for trace acceptance will be shown for each trace (Figure 6-3). This can be averted by selecting Use selection(s) for remaining traces when PITSA asks how to deal with remaining traces.

6.2 Edit

The tools under the Routine Tools -> Edit menu are used to correct minor problems in a data trace, involving at most a few specific data values. The options are:

- Point Editing
- Glitch Editing
- Despiking

The point and glitch editing tools are cases for which you are first given the chance to zoom in on a portion of the trace(s) in order to obtain a better visual resolution. This works in an identical manner to untapered zooming (Section 6.1.1).

6.2.1 Point Editing

*Point Editing* accesses individual data point values. You can manually change a selected data value or interpolate the selected value by using the average value of the two neighboring points.

*Point Editing* will first show a cross hair cursor to select the point to edit (Figure 6-6). The note window on the top of the PITSA window shows the currently selected channel, absolute time of the actual sample, and the indices and data values of the
current sample and its neighbors. The current sample is selected for point editing by clicking the left mouse button.

Figure 6-6. Point editing. The user moves the cross hair cursor to select the point to be edited.

![Point editing](image)

PITSA will now pop up a menu asking the user how to edit the point (Figure 6-7).

Figure 6-7. Pop-up menu for point editing methods.

![Pop-up menu](image)

Selecting Manual Edit will allow the user to enter a value for the selected point, while the Interpolate option will change the value of the selected point to the average of the previous and successive data points. In either case, the display returns to the zoomed trace with whatever changes have been made.

Figure 6-8 shows the result of selecting the point shown in Figure 6-6 and changing its value to $10000.0$ with the Manual Edit option—creating a spike. To remove this spike, you could select this data point with the cross hair cursor and select the Interpolate option in Figure 6-7.
To exit the point editing routine, select any point and then select either Quit Editing or <ESCAPE>. The currently selected point will not be changed. Any other points that were changed by point editing, however, will retain their new values even if the <ESCAPE> option is selected.

### 6.2.2 Glitch Editing

Glitch Editing is used to remove corrupted sequences of data. It is a fairly crude tool, in the sense that no point-by-point editing is possible—all data points in the selected trace section will be given values which are interpolated between the two end points. It is generally used to remove a pulse of high-amplitude noise.

You will first be given a chance to zoom in on a small portion of the trace which is of interest. Selection of the trace section to edit is made using the cursor (and left mouse button) twice. After selecting the two end-points of the section to be edited, you will be presented with a limited menu of choices, shown in Figure 6-9.

The only choice for actually editing the selection is the Interpolate option, in which case the values inside the glitch (all points between, but not including, the margin points) will be linearly interpolated between the selected end points. The display returns to the zoomed trace.
To exit the tool, select an arbitrary set of glitch margins and then select Quit Editing or ‘<ESCAPE>’. As in Point Editing, all changes which have been made to the data are permanent, even if the ‘<ESCAPE>’ option is used.

### 6.2.3 Despiking

The Despiking tool automatically remove spikes from data traces. It should be used with care, especially with traces for which the sampling rate is not much higher than the frequency of energetic signal components. In such cases this tool can distort the signal significantly (see Figure 6-10). It is mainly useful when picking P-arrivals automatically, to remove spurious signals which would otherwise be chosen as P arrivals.

After a channel list has been selected, PITSA will prompt for a smoothing level. Picking this value involves more art than science. The smoothing level parameter is greater than zero, and smaller values result in more smoothing (i.e., more aggressive removal of things that look like spikes). The default value is 0.5.

After a trace has been processed, PITSA will display the “before” and “after” traces and provide the usual menu of choices for what to do with the new trace. If the channel list contained more than one trace, PITSA will provide the option to use the two input parameters (the smoothing value and “what should be done”) for the remaining traces.

**Figure 6-10.** The Despiking tool was used to remove spikes from trace 1. The result is in trace 2. Trace 3 shows the difference between the original trace and the despiked trace. Notice that the despiked trace has been distorted in the signal region.

### 6.3 Instrument Simulation

Seismic signals as recorded at a seismic station differ considerably from the true ground motion. The recording system acts as a filter which changes the signal con-
tents of the seismic waveforms. Before we can interpret recorded signals in terms of properties of the source and/or the Earth we have to correct for the recording process. By applying signal processing techniques to the recorded data we can attempt first to obtain an approximation to the true ground motion at the surface ("restitution"). We simulate a standardized recording process (e.g., for magnitude determination) by applying an additional filter—representing the response characteristics of the desired instrument—to the true ground motion signal.

These important and difficult processes are performed in PITSA with the options under the Routine Tools -> Instrument Simulation menu.

### 6.3.1 Please Use These Tools with Great Care!

The implementation of instrument simulation in PITSA is far from thorough. We have borrowed source code to implement a subset of the functions in the software package PREPROC (written by Miroslav Zmeskal and Axel Plesinger). For many cases the results in PITSA will be “correct”, but there are also many situations in which the codes we are using may fail—meaning not so much that the program will crash, but that the results will not represent what we think they should. PREPROC contains extensive and elaborate testing and decision-making routines, with alternative algorithms to deal with most circumstances which can arise. The routines in PITSA will be most useful in an educational context and for exploration of various datasets. We recommend against using PITSA for research or analysis in which the reliability of the instrument simulation routines must be guaranteed, unless you have specifically verified the results against a known benchmark. For such purposes you should really use PREPROC or a specially-written and well-tested code which can deal with your particular requirements. Eventually, we hope to incorporate the full power of PREPROC for this kind of work in PITSA.

Probably the most important caveat we can offer to the use of the instrument simulation routines in PITSA is to ensure that the original recording system has a bandwidth at least as wide as that of the instrument to be simulated. PITSA will allow you to “simulate” a broadband recording from a short-period one, but the results will have more to do with round-off errors and algorithmic lapses than with seismology.

### 6.3.2 Instrument Response Files and Formats

The response characteristics of a seismic system are defined in a so-called “instrument response file” or “calibration file”, an ASCII text file which encodes the ground velocity frequency response of the recording system in one of three formats which are listed in Table 6-2.

<table>
<thead>
<tr>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FAP</td>
<td>frequency - amplitude - phase triplets</td>
</tr>
<tr>
<td>PAZ</td>
<td>poles and zeroes of the transfer function</td>
</tr>
<tr>
<td>FIR</td>
<td>coefficients of the corresponding FIR filter</td>
</tr>
</tbody>
</table>

These formats conform to the recommendations of the GSE (Group of Scientific Experts) and are a subset of the GSE calibration section format. They are described explicitly in Appendix F. Instrument response files can be created during conversion to PITSA’s ISAM format or by using a text editor. PITSA “knows” the calibration data for some standard seismic systems (Table 6-3).
When the *Instrument Simulation* menu item is selected, PITSA will ask first for a list of channels to process, and then for the name of a calibration file. PITSA will look for this file in the current PITSA directory (Section 5.3).

### 6.3.3 Choose Instrument Menu

PITSA will next display the *Choose Instrument* menu which asks the user which instrument should be simulated. The instrument choices are listed in Table 6-3:

<table>
<thead>
<tr>
<th>Menu Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>WWSSN (SP)</td>
<td>World-Wide Standard Seismograph Network, short period</td>
</tr>
<tr>
<td>WWSSN (LP)</td>
<td>World-Wide Standard Seismograph Network, long period</td>
</tr>
<tr>
<td>Kirnos</td>
<td>Medium period, wide-band system</td>
</tr>
<tr>
<td>Wood-Anderson</td>
<td>Used for determination of $M_L$</td>
</tr>
<tr>
<td>Ground displacement</td>
<td>Restitution of true ground motion</td>
</tr>
<tr>
<td>User-defined</td>
<td>Arbitrary</td>
</tr>
</tbody>
</table>

After you select a standard instrument or *Ground displacement* from the options listed above, PITSA will display the original trace and the simulated trace and display the normal menu of choices for “what to do” with the new trace. If *User-defined* is selected, you will first be asked for the name of the corresponding calibration file.

### 6.3.4 Multiple Traces

If multiple traces are selected in the channel list, PITSA assumes they all have the same calibration file. If this is not true, you must process the traces individually or in groups which do share a calibration file.

After the first trace of a multiple trace selection has been processed, PITSA will ask if the input entered for the first trace should be used for the remaining traces, or if new input values should be taken for each trace. PITSA’s behavior in this situation is predictable.

### 6.3.5 Example: Creating an all-pass instrument response file

It should be obvious that the simulation process requires accurate calibration files for both the actual recording system and the system to be simulated. However, it often happens that we do not know the exact properties of the seismic recording system used to record our data, but we still want to approximate how the recording would have looked on a different instrument. As long as the instrument we want to simulate is more narrow-band than the original recording system, we can approximate the system to be deconvolved by one of constant amplification and zero phase shift (either in displacement or in velocity). The issue of what constitutes sufficiently “more narrow band” in this context is beyond the scope of this Manual.

We will create an instrument response file in PAZ format for a hypothetical recording system with flat response.
For the PAZ format, the instrument response file contains the positions of the poles and zeros in the complex S plane in the format defined in Appendix F. Since the corresponding transfer function for a flat response should have no poles and zeros at all, lines 2 and 3 should contain a 0. The scaling factor should be set to 1.0E09 to make up for the fact that the GSE format expects the scaling factor to cause a normalization into nanometers, or nanometers/sec, respectively. PITSA, however, works consistently in SI units (m and m/sec, respectively). The instrument response file (which we might call allpass.cal) will be quite simple:

```
CAL1                          PAZ
0
0
1.0E09
```

Figure 6-11 shows the results of reading an unknown “broadband” signal (trace 1), deconvolving it with allpass.cal as the calibration file, and simulating a WWSSN short period signal (trace 2).

**Figure 6-11.** Use of a generic “allpass” calibration file to simulate a short-period recording from a broadband recording.

6.4 Phase Picking

The Routine Tools -> Phase Picking option places PITSA into its phase picking mode of operation. All the tools needed to perform routine phase picking and event location have been grouped together and are available when PITSA is in this mode. PITSA will pop up a menu of the options available (Figure 6-12) and after an operation is complete, PITSA will return to this menu. PITSA will not re-plot all the traces loaded in memory when it returns to the phase picking menu as it does when it returns to the main menu state. Instead, it will just leave up the last plot that was created before returning to this menu. It is analogous to having the Plot All Flag off while PITSA is in its standard mode of operation.
Since phase picking is a very time-consuming task, PITSA has implemented a P-phase picker (Baer and Kradolfer, 1987) in order to determine the phase onset and the phase description automatically (option Auto pick phase(s)). Under this option you can edit the picked phase(s), change their phase description interactively, pick additional phases and/or delete phases (option Adjust phase(s)). The traces loaded into PITSA can be sorted by their distance from the event and plotted (options Sort traces by distance and Plot All).

Phase and station files can be written to files in various formats (HYPO71 or Long) for use by other programs. Once phase and station files have been created, you can run HYPO71 directly from PITSA and load in the phase residuals (options Run location program and Read location results).

PITSA will remain in the phase picking mode until either the DONE or <ESCAPE> option is selected, at which point PITSA will return to its standard mode of operation.

Note: Phase pick information is stored in the data headers for the current PITSA session, i.e., in memory. You must explicitly save the data files (as ISAM files) in order to retain the phase pick information in the PITSA headers permanently, i.e., on disk. All the information in memory is lost upon exiting PITSA.

Phases can also be picked from within the particle motion option.

### 6.4.1 Auto Pick Phase(s)

To automatically pick phases, select Auto pick phase(s) from the Phase Picking menu. After entering the list of channels to process, determination of onset times, first motion polarities, and evaluation of the reliability of the picks is done automatically using the algorithm of Baer and Kradolfer (1987)—see Appendix G.
There is no interactive control of the picking process, but the parameters can be modified in PITSA’s configuration file (Appendix B).

After the automatic phase picking is completed, the phase picking menu will reappear. Normally, the next step would be to interactive edit and adjust the automatic picks, using the *Adjust phase(s)* option.

### 6.4.2 Adjust Phase(s)

Selecting the *Adjust phase(s)* option of the *Phase Picking* menu provides tools to adjust and edit the description of existing phases that were either selected by the user or created with the automatic phase picker.

#### 6.4.2.1 Working with Many Traces

After asking for a channel list, PITSA will display a text input box, asking for the number of traces to look at in each step. For a small number of traces—say, up to five or six—it will be fine to just take the default value (all traces) for this parameters. For larger numbers of traces, however, the interface will be more effective if you work with subsets of traces.

If you enter a number which is smaller than the total number of traces loaded, PITSA will display a second text input box asking for the number of traces to *increment* at each step. It is straight-forward to specify some small number—say, three— for both parameters and have PITSA cycle through all the traces three at a time. By specifying the number to increment as one less than the number to view at each step, however, you can retain the last trace with adjusted picks as a guide to pick adjustments in the next group of traces.

For example, if you have selected 12 traces on which to adjust phase picks, and you then entered 5 for the number to look at in each step and 4 for the number of channels to increment in each pass, then PITSA would first display traces 1 through 5 and allow the user to pick, adjust and edit phases. Once the user is finished with these first 5 traces, PITSA would then present the user with traces 5 through 9, repeating the display of trace 5. On the next step, you would view traces 9 through 12.

Use the *DONE forward* and *DONE backward* options of the *Adjust phase(s)* menu to move through the incremental display of traces.

#### 6.4.2.2 Controlling the Zoom Box

Figure 6-13 shows how PITSA looks when it is in the phase pick/adjust mode. In this case, PITSA has presented the user with three traces at a time. The upper part of the screen is the zoom control area and shows the traces in their entirety with a zoom box overlaid.

The zoom box controls what part of the traces are visible in the bottom portion of the screen, which is the phase picking area. The portions of the traces that are zoomed in the bottom part of the screen are controlled by moving the zoom box to the area of interest in the upper part of the display. To move the zoom box, place the cursor inside the zoom box, then drag the box while depressing the left mouse button.
To change the size of the zoom box place the cursor just outside of a margin of the zoom box and drag the margin to a new location, again holding down the left mouse button.

### 6.4.2.3 Controlling Which Traces are Displayed for Phase Adjustment

In addition to controlling the position and size of the zoom box, the upper window also controls which traces are visible in the bottom (zoomed) part of the screen. For adjusting phase picks, the user may want maximum resolution and want to see only the current trace in the zoomed portion of the screen. The selection of which traces (of those displayed in the upper part of the screen) are displayed in the zoomed portion of the display is controlled by using all three mouse buttons.

Clicking either the middle or right mouse button while the pointer is in one of the upper traces causes the trace will be inverted (meaning it will not be displayed in the zoomed portion of the display and will not be available for phase adjustment) and a message (Figure 6-14) to appear on the screen. You are now in trace selection mode.
Figure 6-14. Pop-up note for trace selection in phase picking.

For example, if the user were to click the right mouse pointer while in the top trace in the upper portion of the screen, then the PITSA window would look like Figure 6-15. The upper trace has been inverted to indicate that it will not be displayed in the bottom portion of the screen. Since replotting the lower traces is time consuming and the user may want to toggle on/off several traces, PITSA does not replot the bottom part of the screen until the user has clicked the left button to leave trace selection mode.

Figure 6-15. Trace selection example: trace 1 has been turned off.

While PITSA is in the trace selection mode, the user can not perform any other actions such as picking a phase or selecting one of the Phase Menu options; the buttons in the Phase Menu will become disabled. Trace selection can also be controlled with the Next Trace, Prev Trace and All Traces options available in the Phase Menu.

6.4.2.4 Picking Phases in Adjust Phase(s)

Manual phase picking (and editing of picks, either automatic or manual) is carried out using the cursor and all three mouse buttons on the zoomed traces in the lower part of the main display. The cursor must be inside one of the zoomed trace boxes in order for the mouse buttons to function in this context. Each mouse button has a different function:
Table 6-4. Mouse button usage for editing phase picks.

<table>
<thead>
<tr>
<th>Button</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Right Mouse Button</td>
<td>Delete the phase closest to the current mouse point.</td>
</tr>
<tr>
<td>Middle Mouse Button</td>
<td>Insert a new phase at the current mouse pointer location.</td>
</tr>
<tr>
<td>Left Mouse Button</td>
<td>Adjust the phase closest to the mouse pointer.</td>
</tr>
</tbody>
</table>

PITSA contains some rules about phase picking which are important to understand before attempting to perform manual phase editing with the cursor and mouse buttons. If you’re having trouble picking or adjusting phases, it is very likely that you are trying to violate one of these restrictions:

- You should select the phase type (using the Phase Type pop-up menu) before you try to pick a phase. Even if you have not yet picked any phases on the current traces yet, PITSA will be using an assumed phase type, for example, the last phase you picked on a previous trace.
- PITSA keeps the same phase type in memory until you change it.
- You cannot pick a phase earlier than an existing P phase on the same trace (because it is the first-arriving phase). You must either adjust the position of the existing pick, or delete it and pick a new P phase.
- You cannot pick the same phase twice on a single trace. You must delete the existing pick and re-pick it.
- Because of the previous restriction, you cannot pick phases for more than one event on a given set of traces.

**Insert a new phase pick**

To insert a phase, you must first select the phase type. Bring up the Phase Type pop-up menu by clicking on the appropriate option of the Phase Menu, and select one of the phase types.

**Figure 6-16. The Phase Type menu**

To actually set the new pick, move the cursor to the desired position and click the middle mouse button (Figure 6-17). When a phase is picked, a box is drawn above the trace that shows the phase id and a line is drawn down to the trace. Also, a vertical line is drawn at the phase pick location in the zoom control trace in the upper part of the display.
Moving a phase pick

Once a pick has been made as in Figure 6-17, its position can be adjusted by using the left mouse button. When the left mouse button is depressed PITSA will look for the closest pick (meaning the line dropped from the top of the zoom box to the trace) within about 100 screen pixels from the mouse pointer position. If PITSA finds a phase pick close enough to the cursor, it will replace the phase pick with a vertical line running from the top of the trace to the bottom as in Figure 6-18. Also, a note will pop up showing the absolute time and data value at the current location of the pick, and for the two immediate neighbors.
As long as the left mouse button is held down, the vertical line will follow the cursor, allowing the user to adjust the position of the phase pick. If the trace on which the pick is being made is highly magnified, you may observe the vertical line jumping from one trace point to the next; this is because PITSA only allows picks to be made on actual data points. When the left mouse button is released, the vertical line is replaced by a standard phase label.

**Delete a phase pick**

To delete a phase pick, position the cursor near the phase location and click the right mouse button. PITSA will find a phase pick within about 100 screen pixels of the tip of the cursor.

**6.4.2.5 The display of overlapping phase labels**

PITSA tries to place the phase label directly above the location of the pick on the trace. If there are several phase picks close together, then this is not possible without overlapping the phase labels. Instead, PITSA will move the phase labels to the side so that all phase labels can be plotted without overlapping. Then a line is drawn from the bottom middle of the phase label to the phase location on the trace (Figure 6-19).
6.4.2.6 The active phase

Notice that in Figure 6-19 one phase label has a box around it while the other does not. This is because the box indicates that a phase is “active” and that phase-specific Phase Menu selections will apply to that phase. Only one phase at a time can be active and to change the active phase, the user selects the desired phase by clicking near it with the left mouse button. This in effect adjusts the phase, but if the mouse is not moved in between the button down and up events, then the phase location will be unaffected.

6.4.2.7 Phase Labels

A phase label in PITSA has several parts. First there is a phase id followed by a colon which is followed by five single-character phase descriptor fields (phase id : 12345). The phase id can be any string up to 19 characters long. Each phase descriptor encodes an attribute of the phase pick. An underscore in a phase descriptor field indicates that the attribute has not been set. Trailing underscores are not displayed, in order to reduce confusion in the display. Table 6-5 lists the options available for the different phase descriptor fields:
Table 6-5. The meaning of the phase descriptor characters.

<table>
<thead>
<tr>
<th>Character Position</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>If an H is present in this position then the phase was either picked or adjusted while the corresponding trace was Hilbert transformed.</td>
</tr>
<tr>
<td>2</td>
<td>If an A is present in this location then amplitude information has been input for this pick.</td>
</tr>
<tr>
<td>3</td>
<td>Onset of the phase. Possibilities are I for impulsive and E for emergent.</td>
</tr>
<tr>
<td>4</td>
<td>HYPO71 codes for first motion of the phase. Possibilities are:</td>
</tr>
<tr>
<td></td>
<td>U -&gt; Up</td>
</tr>
<tr>
<td></td>
<td>D -&gt; Down</td>
</tr>
<tr>
<td></td>
<td>+ -&gt; Poor up</td>
</tr>
<tr>
<td></td>
<td>- -&gt; Poor down</td>
</tr>
<tr>
<td></td>
<td>N -&gt; Noisy</td>
</tr>
<tr>
<td></td>
<td>? -&gt; Unreadable</td>
</tr>
<tr>
<td>5</td>
<td>HYPO71 codes for weight of the phase:</td>
</tr>
<tr>
<td></td>
<td>0 -&gt; Full weight</td>
</tr>
<tr>
<td></td>
<td>1 -&gt; 3/4 weight</td>
</tr>
<tr>
<td></td>
<td>2 -&gt; 1/2 weight</td>
</tr>
<tr>
<td></td>
<td>3 -&gt; 1/4 weight</td>
</tr>
<tr>
<td></td>
<td>4 -&gt; 0 weight</td>
</tr>
</tbody>
</table>

Figure 6-20 shows a phase label with a phase id of P and four set attributes. PITSA has the ability to read in synthetic or residual phases and these are displayed as only the phase id string without a colon. These phases cannot be adjusted or edited as they are meant to be references.

Figure 6-20. A phase label.
6.4.2.8 The Phase Menu

Figure 6-13 shows the PITSA Phase Menu on the right side of the PITSA main window. When Routine Tools -> Adjust phase(s) is entered, this menu will pop up on the screen and remain until the user selects one of the DONE options or <ESCAPE>. Some of the options in this menu apply only to the active phase (Section 6.4.2.6); PITSA will ignore these commands unless a phase has been selected first.

The following sections describe in detail how the different options work.

Phase Type

This option is used to specify the phase type before a new phase is picked. In earlier versions of PITSA it could be used to change the phase ID of the active phase, but this is no longer implemented. To change a phase ID, you must delete a phase and re-pick it.

PITSA will pop up the menu shown in Figure 6-16 on page 6-17. This menu has a number of pre-defined phase IDs or you can select the Other option and specify an arbitrary phase ID of up to 19 characters.

Selecting <ESCAPE> will pop down the menu. The selected phase type will become the default phase type for subsequent phase picks until it is changed again.

Onset Type

This option is used to change the onset type for the selected phase which is stored in the third phase descriptor field of the phase label (Table 6-5 on page 6-21). It operates on the active phase. The pop-up menu is shown in Figure 6-21. Selecting Impulsive or Emergent resets the third character of the phase descriptor field. Selecting None clears the onset character field in the phase label and replaces it with an underscore. <ESCAPE> will end the operation without changing the onset character.

First Motion

This option is used to set the polarity of the first motion of the active phase, which is stored in the fourth phase descriptor field of the phase label. The pop-up menu is shown in Figure 6-22. See Table 6-5 on page 6-21 for description of the label codes. Selecting None clears the first motion field of the phase label and sets this character to an underscore. <ESCAPE> exits the pop-up menu, leaving the descriptor field unchanged.
Weight

This option is used to set, clear or change the weight of the active phase (the fifth position of the phase descriptor field), which is used in earthquake location programs. The pop-up menu is shown in Figure 6-23. See Table 6-5 on page 6-21 for the encoding of the weight character in the phase descriptor. Selecting None clears the entry in the phase label and sets this character to an underscore. <ESCAPE> exits, leaving the descriptor field unchanged.

Set Amplitude

The Set Amplitude option is used to measure the amplitude and period of the active phase, which are stored in the data header of the trace. You will select two extrema of opposite polarity (e.g., from a maximum to the following minimum); PITSA will measure the peak-to-peak amplitude and period (twice the time length between the extremal points) of the phase from these points.

When this option has been selected, PITSA displays a star that tracks the cursor and snaps to local minima or maxima along the trace (see Figure 6-24). A note window pops up to provide help.
When the star is at the extremal point you wish to use as the beginning of the measurement window, hold the left mouse button down and drag the cursor to the following extremal point. As you drag the cursor, PITSA draws a line from the first extremal point of the pick to the nearest local extremal point (Figure 6-25).

When the left mouse button is released, PITSA will pop up a message similar to the one in Figure 6-26 which shows the amplitude and period the user selected. The star will have returned and follows the cursor as before. At this point, the user has the option of re-selecting the amplitude (in the manner just described), canceling the operation (clicking the center mouse button) or accepting the values presented (clicking the right mouse button).

If the measured values are accepted, the second character in the phase descriptor field (Table 6-5 on page 6-21) will be set to A. Currently amplitude information is only used when phase output files are created See “Output Phase(s)” on page 29.
Figure 6-26. Display of measured amplitude and period information.

Clear Amplitude

This option is used to quickly clear the amplitude and period measurements associated with the active phase. The A in the second position of the phase descriptor field of the active phase will be reset to an underscore.

Delta

This option is used to set the region of confidence of the onset time of the active phase. The window representing the confidence of the pick need not be symmetric about the onset time. When selected, PITSA will produce a vertical line which tracks the movement of the cursor on the trace that contains the selected phase (Figure 6-27).

Figure 6-27. Measurement of the region of confidence of the onset time of a phase.

The region of confidence is specified by clicking the mouse button at its boundaries. In order to be valid, the two mouse clicks must be on opposite sides of the selected phase.

Once a region of confidence has been selected, PITSA will display an error bar along with the phase pick as in Figure 6-28. If a phase pick is adjusted after this step, then PITSA will clear the existing region of confidence and you will have to re-select it.
Clear Delta

If the currently selected phase has an error bar, then this option can be used to clear it. The error bar will be removed and the confidence region will be reset for the phase pick.

Set Rise Time

In the stand-alone version of PITSA, this option will be dimmed in the Phase Menu, meaning it is unavailable. It is available when PITSA is used within the GIANT software package.

Clear Rise Time

In the stand-alone version of PITSA, this option will be dimmed in the Phase Menu, meaning it is unavailable. It is available when PITSA is used within the GIANT software package.

End Phase

In some applications it is useful to mark the end of a phase. This option is used to create a companion phase (the “end phase”) to the active phase for this purpose. The new phase will initially have the same onset time as the original phase, and will have the same phase ID with the text “.end” appended. After this option is selected, clicking once with the left mouse button on the original phase will cause the phase labels to be replotted with some separation. Then the onset time of either phase can be adjusted in the normal manner.

Trace Transform

This option is used to apply the Hilbert Transform to the traces in the zoomed boxes of the display. When this selection is made, the note window shown in Figure 6-29 will appear.
Figure 6-29. The Trace Transform note window.

Move the cursor inside the zoomed box of the trace to be transformed and click either the middle or right mouse button. The transformed trace will be redrawn in red and the letter “H” will appear at the beginning of the trace. You can toggle the Hilbert transform on and off in any of the zoomed boxes until the left mouse button is clicked. Figure 6-30 shows the PITSA window after trace (2) has been Hilbert transformed.

Figure 6-30. The PITSA window after trace (2) has been Hilbert transformed.

If the boundaries of the zoom box are changed, any traces that have been Hilbert transformed will be un-transformed before the new zoomed traces are redrawn.

Note that the labelling of phases to show that they were picked from a transformed trace is now entirely manual. The next two options of the Phase Menu control these functions.

Set Transform Flag

This option will set the active phase’s descriptor to indicate that it was picked while the Hilbert transform was on, by setting the first position of the phase label’s phase descriptor field to an “H”.

Clear Transform Flag

This option will set the active phase’s descriptor to an underscore character to indicate that it was picked on an un-transformed trace.
Next Trace

This option will change which traces are displayed in the bottom part of the screen (the zoomed up traces). When this selection is made, PITSA looks for the first trace in the upper part of the screen that is on, toggles it off, turns the next trace on and turns all other traces off. This can be used to conveniently step through the traces at maximum resolution.

Prev Trace

This option is the reverse of Next Trace. PITSA looks at the traces in the upper part of the screen from bottom to top for the first trace that is on, toggles it off, turns the trace that is above it on, and toggles the remaining traces off.

All Traces

This option turns on all the traces in the upper part of the screen so that all traces are displayed in the lower part of the screen (the zoomed traces).

Pull In All Comp

This option is used to ensure that all components of a given station are loaded into the phase picking screen. After selecting this option, move the cursor onto the trace of interest (either in the upper or lower set of traces); As the pointer moves into different traces, a note window displays the station name and component of the trace. When any mouse button is clicked, PITSA looks for any traces with the same station name that are not loaded into the phase picking screen. If it finds some, they are added to the channel list that is being picked.

Pull In Nearest Sta

This option works nearly the same as the Pull In All Comp option except that PITSA looks for the closest station (calculated by looking at the station coordinates) that is not already loaded into the phase picking screen and adds it to the channel list that is being picked.

Clear Pulled In

If traces have been pulled in with either the Pull In All Comp or Pull In Nearest Sta options, then they can be taken out of the channel list loaded into the phase picking screen with this option.

Refresh

This option causes the phase picking screen to be redrawn. This can be useful when placement of phase labels has become messy because of adjusting, adding or deleting phases.

Pick Magnitude

In the stand-alone version of PITSA, this option will be dimmed in the Phase Menu, meaning it is unavailable. It is available when PITSA is used within the GIANT software package.
6.4.3 Show False Polarities

In the stand-alone version of PITSA, this option will be dimmed in the Phase Menu, meaning it is unavailable. It is available when PITSA is used within the GIANT software package.

6.4.4 Show Greatest Residuals

In the stand-alone version of PITSA, this option will be dimmed in the Phase Menu, meaning it is unavailable. It is available when PITSA is used within the GIANT software package.

6.4.5 Sort Traces by Distance

When this option is selected, PITSA will sort the traces loaded into PITSA by either hypocentral or epicentral distance, if the necessary information is available in the data headers. If the information is not available, this field is grayed out and inactive.

6.4.6 Sort Traces by Azimuth

When this option is selected, PITSA will sort the traces loaded into PITSA by azimuth, if the necessary information is available in the data headers. If the information is not available, this field is grayed out and inactive.

6.4.7 Output Phase(s)

This option is used to write phase pick data to a file in several standard formats. When this option is selected, a menu pops up that gives the user three format options (Figure 6-31). These options are HYPO71, ISOP and Long. The HYPO71 format is directly readable by the HYPO71 program (Lee and Lahr, 1975; Lee and Valdés, 1989). The Long format is a general format that includes all the phase pick information.
After a format has been selected, PITSA will ask the user for a channel list and a name for the output file. The file will be written in the current PITSA data directory. If the file name entered does not already exist, then PITSA will create the file and add all the phase picks in the channel list to the file. If, however, the file does exist, PITSA will overwrite the file without warning.

6.4.7.1 Processing of HYPO71 Phase Output Files

The HYPO71 program expects to see only P and S arrivals and only one P or S arrival per station. PITSA will group the traces together by station and if there are more than one P or S arrivals, then PITSA selects the phase pick with the highest quality by looking at the weight and whether or not the phase is impulsive or emergent. Also, HYPO71 requires three additional pieces of information besides the onset time and phase name. It must know if it is impulsive or emergent, the first motion and the weight. PITSA checks to make sure all these values are set and if they are not, it fills these values in with default values. The default values are impulsive, unknown first motion, and full weight (Table 6-5 on page 6-21).

6.4.7.2 Processing of phase output files in the ISOP format

The ISOP format can be used to dump picked phases into a file following the format description of the ISOP project. There are no default values used in this format.

6.4.7.3 Processing of phase output files in the Long format

This output format contains most information about the picks made inside PITSA. It just dumps all information that have been found for the picked phases in a file. As for the ISOP format there are no default values defined, if information is missing.

6.4.7.4 Phase Output Status Message

After PITSA has finished writing to the phase output file, it will pop up a status message in the upper right hand corner of the screen (Figure 6-32).

Figure 6-32. The phase output status message.
6.4.8 Output Station(s)

This option is used to generate station files in the format used by HYPO71. PITSA asks for a channel list and the name of the file to create. The file will be created in PITSA’s current directory.

As in Output phase(s), if the file already exists, PITSA will overwrite this file without warning.

6.4.9 Run Location Program

PITSA can run HYPO71 directly from the program and load in the phase residuals of the run. In order to do this, the user must first generate a phase and station file to be used as input to the location program.

6.4.9.1 Running HYPO71

PITSA will ask the user for a number of files that will be used as input and output. The first file that is asked for is the velocity model file, which is velmod.hdr by default. PITSA will look in the path set by PITSA_HYPO71_PATH_ENV for the velocity model Section 2.1. Next PITSA will ask for the name of the control header file to use which is control.hdr by default; PITSA will also look in the PITSA_HYPO71_PATH_ENV directory for this file. Next PITSA will ask for the station and phase file to use and will look for these files in PITSA’s current directory Section 5.3. Finally PITSA will ask for the name (hypo_out by default) of the output file which is where HYPO71 will write the results of the location run.

After all the input is entered, PITSA will issue a system command to run HYPO71 and wait for it to finish. Any output generated by HYPO71 will appear in the window where PITSA was started. Then PITSA will ask the user if they want to load in the results of the location (Figure 6-33). If the user selects Load in results, then PITSA will read in the new location from the output file HYPO71 created and create synthetic phases for each residual. If there were errors in the HYPO71 run, the user may want to skip trying to load in results by selecting the Do not load in results option.

Figure 6-33. The menu PITSA pops up after the HYPO71 location program has finished. The user can either load in the new location and phase residuals with the Load in results option or skip reading in this information by selecting Do not load in results.

<table>
<thead>
<tr>
<th>Popup Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>What to do?</td>
</tr>
<tr>
<td>Load in results</td>
</tr>
<tr>
<td>Do not load in results</td>
</tr>
<tr>
<td>(ESC)</td>
</tr>
</tbody>
</table>

If the Load in results option is selected, then PITSA will first clear out any synthetic phases that exist (remember that synthetic phases do not have a colon after the phase id). PITSA will then display a message in the upper left hand corner of the screen that shows the new location and some statistics (Figure 6-34).

Figure 6-34. After PITSA loads in a new location and phase residuals, it pops up this message in the upper left hand corner of the screen. The statistics
for the P and S residuals are the average and maximum residuals in seconds.

| Location: 36.09 [lat deg] -121.74 [lon deg] 18.66 [depth km] |
| P residuals: 0.195 [ave sec] 0.890 [max sec] 11 [# residuals] |
| S residuals: 0.000 [ave sec] 0.000 [max sec] 0 [# residuals] |
| 11 synthetic phases created |

CONTINUE

6.4.9.2 Solving Problems with HYPO71

HYPO71 is a complicated program in its own right, and it may be that you encounter problems running it from PITSA. A guide to solving problems in HYPO71 is included here as Appendix H. More complete information will be found in the HYPO71 Manual.

6.4.10 Clear Phases

To delete phase picks from the trace data headers, select the Clear Phases option. The menu in Figure 6-35 will be displayed:

Figure 6-35. The Clear Phases pop-up menu.

6.4.10.1 Clearing All Phases

The user has three options when clearing all phases; they can clear user-picked phases and synthetic phases (All), just user-picked phases (All user picked phases) or just synthetic phases (All synthetic phases). When one of these options is selected, PITSA will first ask for a channel list to clear phases from. Then the user will be presented with a pre-zooming window so that they can select the portion of the traces in the channel list to clear. When the zoom window has been selected, PITSA will display all the traces in the channel list with the zoom selected and overlay all phase picks that would be deleted. Then PITSA asks the user if they really want to delete these phase. The user can either enter a n (the default) to terminate the operation or enter y to go ahead and delete the phases. If the user enters y, then PITSA will erase the phase picks overlaid on the traces, otherwise the phase picks will remain. Then PITSA returns to the Phase Picking Menu.

6.4.10.2 Clearing Selected Phases

The user has the option of stepping through all selected phases (Select), all selected user-picked phases (Select user picked phases) or selected synthetic phases (Select synthetic phases) one at a time and deciding if the phase should be deleted. First PITSA will ask for a channel list and then let the user pre-zoom the traces in the channel list. PITSA will then display the traces selected in the channel list using
the pre-zoom selected. Then PITSA will start stepping through all phases contained in the traces within the zoom area (Figure 6-36).

**Figure 6-36. PITSA’s Clear Selected Phase screen.**

For each phase, PITSA will display the phase label surrounded by a box, display the phase information in a note, and ask the user if the phase should be deleted or not. If the user selects *Keep Phase*, then the phase is not removed from the traces header and the phase is left on the screen without the box around it and PITSA moves on to the next phase. If *Clear Phase* is selected, then the phase label is erased from the screen and the phase information is deleted from the traces header before moving on to the next trace. After all phases have been examined, PITSA returns to the Phase Picking Menu.

### 6.4.11 Delete Traces

**Warning:** Use this option with great care. It will remove files from the memory in PITSA and from your disk! This is the only possibility to physically delete waveforms inside PITSA. So please be careful with this. When using PITSA in connection with the GIANT database, the according waveform files and any other connected entries (i.e. picked phases) are also deleted from the database.

### 6.4.12 Plot All

After PITSA returns from a Phase Picking Menu option, it re-displays the menu but does not re-plot the screen with all the channels loaded into PITSA. If the user would like to see the traces loaded into memory, they can select this option.

### 6.4.13 DONE

This Phase Picking Menu option will end the phase picking mode and return PITSA back to its home state. PITSA's main menu will then become active again.
6.5 Magnitudes

PITSA can be used to estimate earthquake magnitude, but it is important to understand that reliable estimation of magnitude depends critically on the proper calibration of instruments. In practice, many seismological instruments are only roughly calibrated, for example, by using the specifications supplied by the manufacturer.

Five magnitude types are currently supported:

<table>
<thead>
<tr>
<th>Table 6-6. Magnitude Types and Menu Options.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Menu Option</td>
</tr>
<tr>
<td>Bakun/Joyner local magnitude</td>
</tr>
<tr>
<td>Generic local magnitude</td>
</tr>
<tr>
<td>Body Wave Magnitude</td>
</tr>
<tr>
<td>Surface Wave Magnitude</td>
</tr>
<tr>
<td>Moment Magnitude</td>
</tr>
</tbody>
</table>

Before attempting to determine earthquake magnitudes from seismic traces, the user must make sure that the proper corrections for the instrument type have been applied. For $m_b$ and $M_S$, the trace units are expected to be in ground velocity (m/sec) while for $M_L$ and $M_{WA}$ the units are assumed to be in ground displacement (m) amplified by a factor of 2800 to simulate the output of a Wood Anderson instrument.

It is advisable to perform an instrument correction and simulation of standardized instruments before estimating magnitudes. See Section 6.3 for the simulation of standardized instruments or Section 8.2 for amplitude scaling of individual traces.

After selecting one of the Routine Tools -> Magnitude options (Table 6-6), you will be asked for a channel list. Next, you will be given the opportunity to zoom in on the selected traces to focus on the area of maximum amplitudes.

Magnitude calculation is done by selecting the two extremal values in a trace which represent the peak-to-peak amplitude. The same process will determine the corresponding dominant signal period, which is required for $M_S$ or $m_b$. The process is identical to the operation of the Phase Menu -> Set Amplitude option discussed in Section 6.4.2.

Figure 6-37 shows the display at the start of the magnitude estimation process. A star tracks the motion of the cursor by ‘jumping’ to nearest local extreme value of the trace.
When the star is located on the extremum which you wish to use for the start of the magnitude measurement window, click and hold down the left mouse button—this “locks in” the first extremal point. As you drag the mouse away, a line will be drawn from the first extremal point to the extremum nearest the cursor. Figure 6-38 shows an intermediate step in this process in which the cursor has been moved too far and the line is being drawn to the wrong extremal value.

In Figure 6-39 the cursor has been moved back and the correct extremal value has been selected.
Figure 6-39. The magnitude determination window after two values have been selected.

Note in Figure 6-39 that a star continues to track the cursor even after two extremal points have been selected. Once a pick has been made, you may:

- Reselect the start and end points for the magnitude, using the left mouse button to start a new selection line.
- Accept the current selections and calculate a magnitude, by clicking the right mouse button.
- Cancel the operation, by clicking the center mouse button.

Depending on what type of magnitude determination was selected, you may be asked to input additional information for distance-dependent amplitude correction if the needed data values are not set in the trace’s header. For the $m_b$ determination, this term (often called Q) depends on the selected wave type and source depth, while for $M_W$ it is only dependent on epicentral distance. For tabulated values of the calibration term see Willmore (1979). For the calculation of $M_L$ and $M_S$, no further input is required.

When a pick has been made and accepted (Figure 6-40), PITSA will make a magnitude calculation, store it in the trace’s header (Section 8.3.2) and display the result of the calculation.
After the calculations are made, you will have the option of picking additional magnitudes or exiting.

There are several differences to the just described procedure when using the Moment Magnitude option. With this routine the spectra of given phase picks are computed and an inversion is started assuming a Brune source (Brune, 1970). This inversion is based on a hybrid of the simulated annealing and simplex algorithms (Press et al, 1992). The final output is the inverted spectrum and the estimated $M_w$ magnitude. To run this module properly an input file named `annealing.cfg` is needed. In this file the starting values of the simplex and simulated annealing algorithms as well as starting values of the model are given (Figure 6-41).
Figure 6-41. Starting values of the spectral inversion given in annealing.cfg file.

```
MODEL MOMENT 1.0e-6
MOMENT UNSERT 0.0001
MODEL CORNER FREQ 20.0
MODEL CORNER FREQ UNSERT 0.1
MODEL HIGHPASS 0.5
MODEL LOWPASS 30.0
MODEL POLES 2
MODEL INCIDENCE 5.0
MODEL Q 200
MODEL Q UNSERT 0.005
MODEL SEIS Fc 1.0
MODEL SEIS DAMPING 0.7
NUMBER OF RUNS 1000
NUMBER OF ITERATIONS 10
ANNEALING TEMPERATURE 1.0
ANNEALING TEMPERATURE STEP 0.7
RADIATION PATTERN WEIGTH 1.0
VELOCITY (m/s) 5000
DENSITY (m^3/kg) 2700
LOW FREQ INVERS -1.0
HIGH FREQ INVERS 20.0
```

PITSA prompts first for the number of points of the FFT, the tapering factor, pre-pick window length in fraction of the overall FFT window and the number of points for smoothing the spectra (Figure 6-42).

Figure 6-42. Input panel for moment magnitude estimation.

A noise sample with the same length as the phase wavelet is taken just in front of the selected pick.

Next you are asked to input the phase ID which you want to use for estimating the moment magnitude (Figure 6-43).

Figure 6-43. Entering the desired phase ID.

In order to estimate an instrument corrected moment magnitude, PITSA prompts for the calibration file of the instrument (Figure 6-44).
If you don’t want to use a specific calibration file (or you just don’t know it exactly), you are asked to enter `return`. Now, PITSA will ask you to input the calibration information manually (Figure 6-45).

**Figure 6-45. Calibration information of used instrument.**

PITSA will now try to perform an inversion using the given spectra and annealing.cfg file.

The result is plotted as a colored model curve together with the spectra of the selected phase window, the smoothed version and the noise spectrum. Please be aware that PITSA only computes a model spectra if 10 spectral values of the signal are above the noise spectrum.

Next a popup menu will appear in the PITSA main screen. Here the user can decide whether to control the output model fit interactively (Figure 6-46).

**Figure 6-46. Interactive quality control of the fit.**

Selecting `Next Trace` or `Previous Trace` results in entering into the interactive mode. `<Escape>` simply accepts all models and all associated moment magnitudes are stored in the header.
Figure 6-47. Result of inversion in the interactive mode. The blue line is the model curve, the black lines represent the original spectra, a smoothed version and the noise spectra, respectively. Also the popup menu for interactive change of the fit is visible.

If you are in the interactive mode, you are able to control the actions via a popup menu (Figure 6-47). Adjust Mc, fc simply adjust the Moment and the corner frequency of the assumed Brune source model. A cross hair cursor will appear and you can set the fit to a new value. Adjust Q will adjust the Q-value of the model and leaves the rest unchanged. Accept will accept either the original model or the manually adjusted one. Selecting Ignore deletes this spectra out of the channel list and no magnitude is computed.

The moment magnitude $M_W$ is computed using the equations:

$$M_W = \frac{2}{3} \cdot \log_{10} M_0 - 6.063 \quad \text{and} \quad M_0 = \frac{4 \pi \cdot P \cdot \rho \cdot \Delta \cdot v^3}{R}.$$  

$M_0$ represents the Moment, P the plateau value of the spectrum, $\rho$ the density of the propagation medium, $\Delta$ the hypocentral distance, $v$ the P- or S-wave velocity and $R$ the radiation pattern factor.
6.6 Integrate

Numerical integration of a seismic trace is used to convert an acceleration-proportional record to a velocity-proportional record, or a velocity-proportional record to a displacement-proportional record. This may be necessary, for example, in order to make a magnitude measurement (Section 6.5). This is done by selecting one of the methods under Routine Tools -> Integrate. The choice of method has consequences for the spectral properties of the resulting signal:

Table 6-7. Spectral properties of integration methods

<table>
<thead>
<tr>
<th>Method</th>
<th>Effect on spectral properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tick’s rule</td>
<td>Overemphasizes high frequencies with respect to the true frequency response of an integrating filter.</td>
</tr>
<tr>
<td>Trapezoidal rule</td>
<td>Underemphasizes high frequencies with respect to the true frequency response of an integrating filter.</td>
</tr>
</tbody>
</table>

For a discussion of the frequency response of numerical integration using recursive filters see Hamming (1983).

After a channel list has been specified, PITSA will display the first trace along with the integrated trace (Figure 6-48). You have the usual choices of what to do with the new trace, and, in the case of multiple traces, the option to use this choice for all remaining traces as well.

Figure 6-48. Integration result.

An integrated trace will often have a significant linear trend, as in Figure 6-48, which is caused by even a small amount of baseline offset in the original trace.
6.7 Differentiate

Numerical differentiation of a seismic trace is used to convert a velocity-proportional record to an acceleration-proportional record, or a displacement-proportional record to a velocity-proportional record. This may be necessary, for example, in order to make a magnitude measurement (Section 6.5). This is done by selecting Routine Tools -> Differentiate. There are no options for this tool.

After asking for the channel list, PITSA will display the first trace along with the differentiated trace (Figure 6-49). You have the usual choices of what to do with the new trace, and, in the case of multiple traces, the option to use this choice for all remaining traces as well.

Figure 6-49. Differentiation result.

6.8 Baseline Corrections

The tools under the Routine Tools -> Baseline Correction are used to determine and subtract the slowly varying components of a seismic trace. The options are:

- Running Average (Remove)
- Running Average (Keep)
- Offset Removal
- Linear Trend
- Linear Regression

With any of these options, PITSA will ask for a channel list to process, and then display the first pair of original and baseline-corrected traces (Figure 6-50). You have the usual choices of what to do with the new trace, and, in the case of multiple
traces, the option to use this choice for all remaining traces as well. The main difference in the display for these options is that the pop-up note window will provide different information, corresponding to the specific method used.

Figure 6-50. Baseline correction result.

Some of the problems calling for a baseline correction can also be dealt with by low-pass filtering (Section 7.1.3).

6.8.1 Running Average (Remove or Keep)

For either of these two options, the baseline is calculated from the original trace by sliding an averaging window of a given length over the data series. For each window position, the baseline is calculated as the average value in the data window.

The running average of a data trace is sometimes of interest by itself. It can be saved for further processing by selecting the Running Average (Keep) option.

When either option is selected, you will be asked to enter the width of the averaging window in seconds. The window length is directly proportional to the “smoothness” of the correcting baseline.

6.8.2 Offset

Here, the baseline is simply the DC component (average value of all points) of the trace.
6.8.3 Linear Trend

This approach calculates the baseline as the connecting line between the first and the last data points of the trace (Figure 6-51).

Figure 6-51. Linear trend removal.

6.8.4 Linear Regression

Here, the baseline is determined as the best fitting line calculated from a linear regression analysis of the trace (Figure 6-52).
Figure 6-52. Linear regression baseline correction.
CHAPTER 7

Advanced Tools

This chapter describes the more sophisticated processing tools to be found in PITSA, under the Advanced Tools option of the main menu. Table 7-1 outlines the many tools available.

Table 7-1. The options available under Advanced Tools.

<table>
<thead>
<tr>
<th>Menu Selection</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filter</td>
<td>Various filters including band-, high- and lowpass filters; a de-ringing filter; a notch filter; a user-specified pole-zero filter; and a user-defined difference equation filter.</td>
</tr>
<tr>
<td>Spectrum</td>
<td>Calculate FFTs, inverse FFTs and maximum entropy spectra. Demultiplex complex spectra into amplitude, phase, real and imaginary parts; multiplex two real traces into a complex spectrum; Power Spectral Density; discrete wavelet-transform.</td>
</tr>
<tr>
<td>Xcorrelation</td>
<td>Scaled and unscaled cross-correlation of two traces.</td>
</tr>
<tr>
<td>(De)convolution</td>
<td>Convolution and deconvolution of two traces.</td>
</tr>
<tr>
<td>Particle Motion</td>
<td>View ground motion in 2 or 3 dimensions. Also pick phases and angles.</td>
</tr>
<tr>
<td>Envelope / Hilbert Trans</td>
<td>Envelope or Hilbert transform of a trace.</td>
</tr>
<tr>
<td>Rotate Components</td>
<td>Rotate components in 2 or 3 dimensions.</td>
</tr>
<tr>
<td>Polarization Filter</td>
<td>Polarization analysis in 2 or 3 dimensions.</td>
</tr>
<tr>
<td>Cross Spectrum</td>
<td>Cross-spectrum of two traces.</td>
</tr>
<tr>
<td>Coherence Spectrum</td>
<td>Coherence spectrum of two traces.</td>
</tr>
<tr>
<td>Response Spectrum</td>
<td>Response Spectrum</td>
</tr>
<tr>
<td>Spectral Ratio</td>
<td>Spectral ratio of two traces</td>
</tr>
</tbody>
</table>
7.1 Filter

To filter selected traces, select one of the Advanced Tools -> Filter options. From the Filter menu, there are 10 options from which to choose (Table 7-2):

Table 7-2. Options under the Advanced Tools -> Filter Menu.

<table>
<thead>
<tr>
<th>Filter Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Butterworth Filters</td>
<td>Recursive time-domain filters using the bilinear z-transform design of Stearns (1984). Applied in sections of 40 dB/decade or 12 dB/octave for the slope of the transition band. They may be given zero phase characteristic by bilateral filtering.</td>
</tr>
<tr>
<td>Gaussian Band Pass Filter</td>
<td>Zero phase frequency-domain filter. Best time resolution for a given bandwidth.</td>
</tr>
<tr>
<td>De-Ringing Filter</td>
<td>Removes the effect of reverberations in a water layer or a layer of shallow low velocity sediments (Backus, 1959).</td>
</tr>
<tr>
<td>Seidl’s Simulation</td>
<td>Instrument simulation using the method of Seidl (1980).</td>
</tr>
<tr>
<td>Difference Equation</td>
<td>A general linear time-invariant (LTI) system can be completely described by a linear difference equation. Given the coefficients in an ASCII file, PITSA will directly apply the difference equation to the input trace.</td>
</tr>
<tr>
<td>GSE Calibration File</td>
<td>Frequency-domain filter for a GSE calibration section provided in an ASCII file.</td>
</tr>
<tr>
<td>Evaluate GSE Response</td>
<td>Evaluate and display various aspects of the frequency response function (e.g. group delay, phase delay, etc.) for a GSE calibration section provided in an ASCII file.</td>
</tr>
</tbody>
</table>

7.1.1 Forward-Backwards (Bilateral) Filtering

For some of the filter options, PITSA will ask if the filter should be applied “for-ward backwards”, meaning bilaterally (Figure 7-1). If so, the trace will be filtered twice (in opposite directions) to produce a zero phase filter. Bilateral filtering will make the filter transition band(s) twice as steep.

Figure 7-1. Bilateral (“forward-backwards”) filter option.

| Filter forward backwards (y/n) ?                   |
|------------------------------------|------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------|
| y                                  | zero phase filter                                                                                                                                                                                                                                                                                                                        |
| n                                  | Note: zero phase option doubles the steepness of the transition band!                                                                                                                                                                                                                                                                     |

7.1.2 Butterworth Band Pass

The user must provide input for three parameters:

- Low and high cutoff frequencies.
- Whether or not to filter “forwards backwards” (Figure 7-1).
- Number of filter sections. Each filter section corresponds to an increase of the slope of the transition band by 20 dB per decade.
Figure 7-2 shows the impulse response of the filter. Trace 1 is an impulse filtered forwards only (trace 2) and then forwards backwards (trace 3). Notice that the zero phase filter is acausal (the output signal starts before the input signal arrives).

Figure 7-2. Butterworth bandpass filtering of an impulsive signal. Trace 2 used cutoff frequencies of 10.0 and 30.0 Hz, forward filtering only, with a three section filter. Trace 3 uses forward-backwards filtering.

Figure 7-3. FFT of the traces in Figure 7-2. Note the steeper slope of the transition band for the bilateral filter used in trace 3.
7.1.3 Butterworth Low Pass

The user must provide the same input as for the bandpass filter (Section 7.1.2), except only a single cut-off frequency is required.

Figure 7-4. Impulse response of a Butterworth low pass filter (2 section Butterworth Low Pass filter with a corner frequency of 4 Hz) both causal (trace 2) and acausal (trace 3).

Figure 7-5. The FFTs of the traces in Figure 7-4.
7.1.4 Butterworth High Pass

The user must provide the same input as for the bandpass filter (Section 7.1.2), except only a single cut-off frequency is required.

Figure 7-6. Causal (trace 2) and acausal impulse response of the Butterworth high pass filter.

![Figure 7-6](image1)

Figure 7-7. The FFTs of the traces in Figure 7-6.

![Figure 7-7](image2)
7.1.5 De-ringing Filter

De-ringing filters are used to remove reverberations in shallow low-velocity sediments or in water layers. The user enters the assumed reflection coefficient of the shallow layer boundary and the two-way travel time within this layer. If the input values match the conditions which produce ringing in the seismic record, the de-ringing filter will eliminate all reverberations within this layer (see Figure 7-8).

Figure 7-8. Example of the de-ringing filter. The upper trace shows a synthetic input signal containing multiple reflection signals at a distance of 0.5 seconds. The amplitudes decrease with a factor of 0.5. The bottom trace has been filtered with a de-ringing filter with a reflection coefficient of -0.5 and a two-way travel time of 0.5 seconds.

7.1.6 Gaussian Band Pass

The Gaussian bandpass filter is a non-causal filter which is applied in the frequency domain. For a given center frequency $f_{cent}$ and a given bandwidth $\alpha$, the Gaussian:

$$
\exp\left(-\frac{4\pi^2(f-f_{cent})^2}{4\alpha^2}\right)
$$

is calculated and multiplied with the FFT spectrum of the input trace. Subsequently, the inverse FFT is calculated. The user enters values for the center frequency $f_{cent}$ and the bandwidth $\alpha$. 
7.1.7 Notch Filter

Notch filters are designed to remove only a narrow frequency band around a certain center frequency. User input consists of the notch center frequency and the notch width. Notice that the notch width has to be entered in fractions of the notch center frequency. Due to the underlying design procedure (bilinear z-transform), this filter should only be used for notch center frequencies small in comparison to the Nyquist frequency, due to inherent non-linear distortions of the frequency axis. It is wise to always check the actual notch frequency with synthetic data.
Figure 7-11. Example of a notch filter. The upper trace shows a synthetic input signal containing a chirp signal (Section 8.1.9) for frequencies between 0 and 10 Hz. The bottom trace has been filtered with a notch filter with a center frequency of 7.5 Hz and a notch width of 0.5. Notice that the signal is ‘pinched’ at around 3.0 seconds instead of at 7.5 seconds as one might expect since the equation for the chirp signal is $y(t) = \sin(\theta(t) * t)$ and $\theta(t) = 7.5$ Hz when $t = 7.5$ seconds. This is because the instantaneous frequency is defined as $d/dt \theta(t)$ for $y(t) = \sin(\theta(t) * t)$ (Gibson p. 140).

7.1.8 Seidl’s simulation

The numerical simulation of records of particular instruments is one of the fundamental problems in the processing of digital broadband seismograms. Here, as one of the possible approaches, the method of Seidl (1980) has been implemented. It allows the simulation of arbitrary seismograph-galvanometer systems using a time-domain recursive filter. The user must provide input for three parameters:

- Channel list to process.
- Eigenfrequencies and damping values of the actual seismometer, the simulated seismometer and potentially also a galvanometer. If -1,-1 are given for the galvanometer eigenfrequency and damping, the galvanometer response is ignored. In addition, the gain factor (last parameter in input line) can be used to scale the amplitudes of the traces while simulation filtering is performed.

For numerous examples of the performance of this technique see the original paper of Seidl (1980).

7.1.9 Difference Equation

An important way of describing linear time invariant (LTI) systems is by means of linear difference equations with constant coefficients. A general m-th order difference equation can be described by:
The coefficients $a_k$ describe the feedback part of the system and are called the autoregressive (AR) coefficients. Coefficients $b_k$ control the “feed-forward” part and are called moving average (MA) coefficients. In order to use the difference equation directly for filtering in PITSA, you must first create an ASCII file containing the sequence of AR parameters on the first line and the MA parameters on the second line. The coefficients on each line are separated by commas. Since the first summation $\sum_{k=1}^{m} a_k y_{i-k}$ starts at index 1, the first parameter on line 1 of the input file is interpreted as $a_1$. In order to simulate a purely autoregressive system, you would enter a single 1.0 for the MA parameter $b_0$ (line 2). The parameter file for a purely autoregressive filter of second order with AR parameters $a_1 = 1.8$, $a_2 = -0.9$ would look like:

```
1.8, -.9
1.0
```

In Figure 7-12, a sequence of 512 points of Gaussian white noise with an offset of 1 has been filtered using the filter parameters above, thus simulating an AR process of second order. After the channel list for processing has been selected, PITSA will prompt for the name of the parameter file. Before filtering, it will display a list of AR and MA coefficients in the upper left hand corner of the screen.

**Figure 7-12.** Difference equation filter. The upper trace shows the filter input signal. The bottom trace has been filtered using the difference equation with AR parameters $a_1 = 1.8$, $a_2 = -0.9$, and $b_0 = 1.0$. 

$$y_i = \sum_{k=1}^{m} a_k y_{i-k} + \sum_{k=0}^{n} b_k x_{i-k}$$
7.1.10 GSE Calibration File

The GSE calibration file filter is a filter which is applied in the frequency domain. The FFT spectrum of the selected trace is calculated and multiplied with the FFT spectrum calculated from the information given in the input file.

The user is prompted for the name of this file which has to be in GSE calibration section format. Next, the user is asked for the number of points for the FFT. PITSA will provide a default value which is large enough to avoid wrap-around effects. You may always increase the number, as long as it is a power of 2, but using a smaller number will lead to spurious results.

Finally, the inverse FFT is calculated and input and output trace are displayed together.

7.1.11 Evaluate GSE Response

For transfer functions of arbitrary instruments given in GSE format (see Appendix F), PITSA allows the evaluation and display of various properties of the frequency response function such as amplitude- and phase response, real and imaginary parts as well as group delay and phase delay.

The user is prompted for the name of an ASCII file containing the instrument description in GSE format. Subsequently, the user has to provide the sampling frequency in Hz and a fictitious time for the frequency response function (here called time of first sample). This time is checked against the validity time provided in the GSE header. If the fictitious time does not fall within the validity time range, a warning is issued (without further consequences).

Next, the user is asked for the number of points for the FFT. PITSA will provide a default value which is large enough to avoid wrap-around effects. You may always increase the number, as long as it is a power of 2, but using a smaller number will lead to spurious results. Together with the sampling frequency used, the number of points defines the frequency range used for the evaluation of the frequency response function. The smallest frequency for which the response is evaluated is given by the sampling frequency divided by the number of points used for the FFT. This value defines also the frequency increment between neighboring frequency points. The maximum frequency for which the response function is evaluated and displayed corresponds to half of the sampling frequency.

Next, the user has to select the quantity to display. The possible options are:

- **Amplitude.** In this case the amplitude of the frequency response function is displayed.
- **Phase shift [degrees].** Displays phase shift in degrees. Note that a simple phase unwrapping algorithm is used.
- **Real part.** Real part of the frequency response function.
- **Imaginary part.** Imaginary part of the frequency response function.
- **Group delay in seconds**
- **Phase delay in seconds.**

After the axis type has been selected from either **LIN-LIN, LIN-LOG, LOG-LIN,** and **LOG-LOG,** the selected quantity is displayed. As an example, the amplitude part of the frequency response for WWSSN short period instrument is displayed in...
7.2 Spectrum

PITSA contains several tools with which to carry out investigations of the spectral content of seismic traces and move between the frequency and time domains. The fundamental tools, of course, are the Fast Fourier Transforms (FFT) and inverse FFT. The spectral values shown have been multiplied by the sampling rate in order to approximate the values of the Fourier transform within the given frequency band (Press et al., 1988). While the type of spectral information displayed may be chosen freely between amplitude, phase, real or imaginary component, internally it is always kept in its full complex form.

To process the amplitude, phase, real, or imaginary component of a spectrum separately (as if they were real valued time series), you can demultiplex the complex spectrum into a real trace containing only the component of interest. The inverse operation, namely to combine (multiplex) two real valued traces containing amplitude and phase, or real and imaginary components of a complex spectrum into its multiplexed form, can be performed as well.

For signals which have been produced by autoregressive processes, the FFT is not the best way to estimate the spectral content of the signal. In this case the maximum entropy spectrum offers a much better spectral resolution.
Table 7-3. Spectral Analysis Tools.

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FFT</td>
<td>Fast Fourier Transform</td>
</tr>
<tr>
<td>Inverse FFT</td>
<td>Inverse Fast Fourier Transform</td>
</tr>
<tr>
<td>Multiplex to FFT Format</td>
<td>Combine constituent component traces into full complex spectrum.</td>
</tr>
<tr>
<td>Demultiplex from FFT Format</td>
<td>Convert full complex spectrum into constituent component traces.</td>
</tr>
<tr>
<td>ME Spectrum</td>
<td>Maximum entropy spectrum.</td>
</tr>
<tr>
<td>POW Spectrum</td>
<td>Power Spectral Density</td>
</tr>
<tr>
<td>Wavelet Transform</td>
<td>Discrete fast Wavelet Transform</td>
</tr>
</tbody>
</table>

7.2.1 Number of Points Used for FFT

The spectral analysis tools in this section make frequent use of the FFT and inverse FFT tools. In each case, PITSA will prompt for the number of points to use, and provide a default value which is large enough to avoid wrap-around effects. You may always increase the number, as long as it is a power of 2, but using a smaller number will lead to spurious results.

7.2.2 FFT

Before calculating a spectrum, you will have a chance to zoom in on a selected portion of the trace. As described in Section 6.1, this can be done using tapered or untapered zooming (for untapered zoom, the user enters a taper fraction of 0). If spectral leaking is a concern, choose an appropriate taper function and enter a non-zero taper fraction. The following taper functions are implemented:

- Bartlett
- Cosine
- Hanning
- Hamming
- Boxcar
- Parzen
- Welch.

Figure 7-14 shows the different taper functions. For a discussion of the issues involved in selecting a taper function see Press et al. (1988).
PITSA will then prompt for the channel list, the zooming method, and finally the tapering fraction. The tapering fraction is the fraction of the trace that will be altered by the tapering function. For example, if a tapering fraction of 0.2 is entered, 10% at the beginning and 10% at the end of the input trace will be influenced by the taper function.

Next, PITSA will display the first trace both untapered and tapered (Figure 7-15) and ask the user for the number of points to use for the FFT, which must be a power of 2. PITSA will provide the user with a default value that will be a power of 2 and be greater than or equal to the number of points in the input trace.
PITSA will now calculate the FFT for the given data window. The spectrum is kept as a series of complex numbers in a multiplexed format. The following options are available for the display:

**Table 7-4. Spectrum display types**

<table>
<thead>
<tr>
<th>Display Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amplitude</td>
<td>Absolute values of the complex spectral values multiplied by the sampling rate</td>
</tr>
<tr>
<td>Phase</td>
<td>Phase spectrum to be displayed in radians, using a simple phase unwrapping scheme (Stearns and David, 1988).</td>
</tr>
<tr>
<td>Real</td>
<td>Real value of the FFT</td>
</tr>
<tr>
<td>Imaginary</td>
<td>Imaginary part of the spectrum</td>
</tr>
</tbody>
</table>

It is also necessary to choose the axis types for the display, where the first specification refers to the x-axis and the second to the y-axis:

- LIN - LIN
- LIN - LOG
- LOG - LIN
- LOG - LOG

Note that logarithmic axes are only permitted for positive values. A popular display type for spectra of seismic traces is the **LOG - LOG** display of the amplitude spectrum. Figure 7-16 shows the display after an FFT has been calculated for a trace and added to the list of traces in memory.
Figure 7-16. FFT Result. The upper trace is the trace that the FFT was calculated for and the lower trace is the FFT. Here the amplitude is displayed with a LOG-LOG scale.

7.2.3 Inverse FFT

The Inverse FFT tool is used to calculate the time series corresponding to a spectrum. PITSA will check to make sure that the selected traces are in the right format (i.e., multiplexed). Figure 7-17 shows the final result of taking the inverse FFT of the spectra in Figure 7-16. Notice that the length of the time series resulting from an inverse FFT is always a power of 2.

Figure 7-17. Inverse FFT calculated from the spectrum in Figure 7-16.
7.2.4 Multiplex to FFT Format

The *Multiplex to FFT format* tool is used to combine a pair of traces representing the components of a complex spectrum into the corresponding multiplexed spectrum. This tool is used in specialized circumstances where you may want to perform certain filter operations on spectral components separately, recombine them, and finally transform the resulting spectrum back into the time domain.

There are two options, depending on the components represented by the trace pair:

- Amplitude, Phase
- Real, Imaginary

The channel list should specify the component traces in the order given for each option. Both traces must be a length of a power of 2. The resulting multiplexed trace will have the same format as a complex spectrum and can be treated as such, e.g., for calculating the inverse transform. PITSA will prompt for the axis type to use in the display (Section 8.2.6).

Figure 7-18 displays a complex spectrum in trace 1; even though only the amplitude part can be shown, the trace represents the full multiplexed spectrum. Most of PITSA’s tools cannot be used with this trace.

![Figure 7-18. Display of a complex spectrum (trace 1) and its corresponding amplitude and phase components (traces 2 and 3).](image)

In the same figure, traces 2 and 3 display the amplitude and phase components of the complex spectrum represented in trace 1. They can be operated on by most of PITSA’s tools, and they can be recombined into the full multiplexed spectral representation. If they were displayed with the same axis types, traces 1 and 2 would appear identical, even though they represent different things.
7.2.5 Demultiplex from FFT Format

Certain tools within PITSA can only be applied to real-valued traces, hence they do not apply to spectral traces in their complex format. If you wish to process the amplitude or phase (or, alternatively, the real or imaginary) components of a spectrum separately (e.g., to integrate it or smooth it, etc.), you can use the Demultiplex from FFT Format tool to separate the complex spectrum into traces containing only selected components, which are reflected in the options to this tool:

- Amplitude
- Phase
- Real part
- Imaginary part

The selected component will be extracted as a real-valued trace. Of course this tool only works on a trace representing a complex spectrum (e.g., trace 1 in Figure 7-18).

7.2.6 Maximum Entropy Spectrum

The ME Spectrum tool is used to calculate a spectrum from a time series using the maximum entropy method. Maximum entropy spectral analysis is a data-adaptive tool for the analysis of signals produced by autoregressive processes. Its strongest point is its very good spectral resolution. Its weakest point is that the order of the process must be known. It should be emphasized that the maximum entropy spectral analysis method is only applicable to feedback systems (Kanasewich, 1981).

There are two options for this tool:

- Normalized (scaled to a maximum value of 1)
- True Value (no scaling)

PITSA will prompt for the name of the AR output file in which to store the coefficients of the prediction error filter which are calculated in the course of the maximum entropy spectral estimation. File extensions will be added automatically, beginning with a01, a02, a03, and so forth.

PITSA will prompt for three further input parameters:

- The order of the process.
- The maximum frequency for which a spectral value should be calculated.
- The step width $\Delta f$ [Hz].

Spectral values are calculated from 0 frequency up to the maximum frequency in steps of $\Delta f$ [Hz]. The AR parameters $a_1, a_2, ... a_m$ (with $m$ being the specified order of the process) will be written to the output file. This file can be used directly as input for filtering using the Difference Equation filter option (Section 7.1.9).

For details on the estimation of the AR order, the calculation of the ME spectrum and further discussion of its properties see Kanasewich (1981), and Press et al. (1988). Figure 7-19 shows an example of a ME spectrum calculated for an autoregressive process of order 2. The time series was produced using the Difference Equation filter option (Section 7.1.9) with AR coefficients $a_1 = 1.8$, and $a_2 = -.9$ on Gaussian noise.
Figure 7-19. Maximum entropy spectrum.

The corresponding AR parameter file contains the following lines:

```plaintext
# 1.813720      1  -AR-Parameter
#-0.916940     2  -AR-Parameter
# Pm = 0.011553  N = 512  FPE = 0.011689
1.813720 , -0.916940
# No MA parameters
1.0
```

Lines starting with # are comment lines. Pm, N, and FPE are the power of the prediction error signal, trace length in points, and final prediction error, respectively.

### 7.2.7 POW Spectrum

The **POW Spectrum** tool is used to calculate the Power Spectral Density (PSD) of the input time series. There are various ways to compute the PSD. We focus here solely on the algorithm called time averaged Periodogram introduced by Welch (1967). There are two options for this tool:

- Normalized
- True PSD Value.

The first simply normalize the spectrum to 1.0. The latter computes the PSD value according to:

\[
P_{Total} = \sum_f P(f) = \sigma^2
\]

Here \(P(f), P_{Total}\) represent the PSD Spectrum and the total Power of a stationary random process with normal distribution. \(\sigma^2\) is the variance of the process. After asking for the input channel list, PITSA prompts for zooming the input trace, the length of the segment in points (power of two). Please keep in mind that the frequency resolution is given by:
Here \( N \) represents the number of points per segment and \( \Delta_s \) is the sampling rate. Next you are asked to use 50% overlapping segments or no overlapping in order to compute the PSD. Each segment is also tapered using a Welch window. Next PITSA prompts for the number of segments to use for PSD. Default is the maximum number of segments (according to the number of points per segment given before and the overall trace length). Finally you are asked after how many segments you want to plot a first approximation of the PSD. This is especially useful testing the assumption of stationary time series. Before plotting PITSA will prompt for the display type of the traces.

Figure 7-20. Power Spectral Density after 10 steps.

\[
\Delta f = \frac{\Delta_s}{N}.
\]

Figure 7-20 shows the PITSA screen after 10 segments FFTs are stacked. At the top panel the difference between the actual PSD and the result of eight FFT stacks is shown. On the lower panel both spectra are shown. The color line represent the old the black line the new PSD. Now, you are asked for continue or stop adding new segments.

### 7.2.8 Wavelet Transform

**Warning:** this tool is for advanced users only!

The wavelet transform tool is used to compute spectrograms or to be more strict so called “scalograms”. The final plot represents the time - scale (frequency) distribution of a single input time trace. For a more detailed description we refer to the excellent text book of Chui (1992) or for a more brief discussion to Press et al. (1992).
The input signal is decomposed using a family of different orthogonal signals (called wavelets) which are subsequently shifted over the trace. Different scales represent different contraction or dilatation of the wavelets (and therefore different center frequencies and bandwidths). Thus the final output is a projection of the signal onto the orthogonal family of wavelets. In addition, it is possible to transfer the wavelet coefficients (i.e. the scaling factors for the different wavelets) to the PITSA main screen.

There are two options for this tool:
- Wt
- Inverse Wt

The first option performs the wavelet transform, the latter enables the user to compute a recovered version of a signal using given wavelet coefficients.

### 7.2.8.1 Wt

First of all PITSA prompts for either scrolling over the data or computing the Wt of the whole data trace (Figure 7-21). In the first case only the scalograms are shown and no additional output possibility is given.

**Figure 7-21. What to do popup menu.**

![What to do popup menu](image)

After specifying the input channel list PITSA prompts for zooming a time window out of the trace. The user can either accept the time window or zoom some specific time using the given options.

**Figure 7-22. Zooming popup menu.**

![Zooming popup menu](image)

**Warning:** the Wt tool only works correctly if the user specifies a number of points which is a power of two! Otherwise the trace is truncated to power of two next to the input length. In order to display the resulting scalogram only a number of points less or equal to the double horizontal number of screen pixels is allowed. In this case the PITSA main frame has to be enlarged to the full screen size. A good
choice for a 20’’ screen is 2048 points. This is not cross checked by PITSA! It is only possible to compute Wt for a longer time series using the scrolling option in the Wt tool.

After selecting the time window, PITSA prompts for the wavelet family used for calculation (Figure 7-23). There are three standard wavelets implemented in PITSA (Daubechies 4, 12 and 20). For the exact coefficients and the overall behavior we refer to Press et al. (1992). It is also possible to import your own wavelet by selecting *self defined*. In this case PITSA prompts for the ASCII input file name. The wavelet coefficients has to be written in a separate line each.

*Figure 7-23. Wavelet choice popup menu.*

Next PITSA asks the user to specify the length of the data trace which must also be a power of 2 (Figure 7-24).

*Figure 7-24. Data length input window.*

In order to display the absolute values of the wavelet coefficients, the user is able to chose between three different types (Figure 7-25).

*Figure 7-25. Display type popup menu.*

Before plotting the result of the Wt, PITSA prompts for changing the scaling for the minimum and maximum values of the wavelet coefficients (Figure 7-26). The user is also able to change this input settings while displaying the resulting map.
If the COLOR_MODE in the pitsa.cfg file is set to COLOR_SCALE the result will be displayed in color (Figure 7-27). Otherwise it will be presented in grayscale.

PITSA only supports dyadic shifts of the wavelet and dilatation is limited to the factor of two. Therefore the first scale represents roughly the frequency band of $f_{Nyquist} - f_{Nyquist}/2$, the second scale is $f_{Nyquist}/2 - f_{Nyquist}/4$ etc. On the other hand time resolution is changing from $t_{s}/2$ in the first scale to $t_{s}/(scale \cdot 2)$ in the following scales.

Selecting Back to Main Menu PITSA results in the popup menu for the display type of the wavelet coefficient trace. It is possible to append this trace to the existing traces in the PITSA main window. Please be aware that all coefficients are written in one trace all one type of scale. The consequence is that the last 50% of points of the written trace represent the coefficients of scale 1. The coefficients representing the scale 2 are stored in the last half of the remaining part of the trace and so on. Finally the first two points represent the remainder of the signal.
The absolute size of the coefficients of the Wt represent directly the contribution of
the scaled wavelet to the signal at that specific time and scale. Therefore a noise
reduction of the input trace can easily implemented by just ignoring small wavelet
coefficients. This can be done by choosing a threshold in percent of the peak value
(Figure 7-28).

**Figure 7-28. Input panel for lower threshold for output wavelet coefficients.**

Choosing a value of 0.1 will discharge all Wt coefficients smaller than 10% of the
maximum value. Finally PITSA prompts for *Accept/Append* the wavelet coefficient
traces (Figure 7-29).

Selecting the *just scrolling* in the first panel of the Wt tool is acting only on the
input length of each Wt slice and the appearance of a *Forward, Backward* option
(Figure 7-30).

**Figure 7-29. Wavelet coefficients trace written to the main frame of PITSA.**
Choosing the Forward/Backward option enables the user to select the next or previous part of the input trace. In addition no wavelet coefficient trace will be written using this mode Next Trace will load the scalogram of the next trace in the input channel list.

7.2.8.2 inverse Wt

The inverse Wt option compute a time domain signal using the Wt coefficients. Only those traces of wavelet coefficients are allowed that follow the output convention of the Wt module implemented in PITSA. In order to get meaningful results the same wavelet family for forward and backward transforming should be used. The final output is the recovered time trace (Figure 7-31).
7.3 Cross Correlation

Cross-correlation in PITSA is calculated in the spectral domain by complex multiplication and subsequent inverse transform. To calculate the autocorrelation function of a single trace, the user enters the same index twice. There are two options for the Cross Correlation tool:

- Scaled (by individual autocorrelation functions)
- Unscaled

If the Scaled option is selected, the result is scaled by the individual auto correlation functions. The autocorrelation function for a single trace will have an amplitude of 1 at zero lag.

The cross-correlation function will be displayed below the two input traces (Figure 7-32).

Figure 7-32. Cross-correlation result. Trace 2 is a copy of the first trace with a 10 second shift and noise added. The result of the cross-correlation is shown in the bottom trace (the trace indices were entered as 1, 2). The
peak on the right side of the xcorrelation trace indicates that the second trace lags the first.

Peaks in the cross-correlation trace in the left half of the trace correspond to times by which the second trace leads the first. Peaks in the right half of the trace, however, indicate times by which the second trace lags the first. The amount time lag is measured from the right end of the trace. In Figure 7-32, the second trace lagged the first by 10 seconds, and thus the peak in the cross-correlation trace is 10 seconds from the end of the trace. Another way to visualize this would be to cut out the right half of the trace and glue it on the left edge. Then times to the right of zero would indicate positive time shifts and times to the left would indicate negative time shifts.

7.4 (De)convolution

The Advanced Tools -> (De)convolution tool gives the user access to both convolution and deconvolution tools. Convolution can be performed in either the frequency domain or in the time domain. Deconvolution can only be performed in the frequency domain. Therefore the options available under this menu item are:

- Convolution (FREQ)
- Deconvolution (FREQ)
- Convolution (TIME)

7.4.1 Convolution (FREQ)

Select the option Convolution (FREQ) to perform convolution \((u(1) * u(2))\) in the frequency domain. The convolution is performed by multiplying the complex spectra of the two input traces and then performing an inverse FFT. PITSA will display
the input traces together with the trace resulting from the convolution (Figure 7-33).

**Figure 7-33. Convolution in the frequency domain. Trace 2 was used for u(1) and trace 1 for u(2). The resulting convolution is shown in trace 3.**

### 7.4.2 Convolution (TIME)

To perform convolution in the time domain, select the option *Convolution (TIME)*. PITSA will prompt for the trace indices to use for u(1) and u(2), where u(2) is the denominator trace for deconvolution. PITSA will display the two input traces and the resulting trace.

### 7.4.3 Deconvolution

To deconvolve in the frequency domain (u(1)/u(2)), select the option *Deconvolution (FREQ)*. To perform the deconvolution, PITSA will take the inverse FFT of the ratio of the complex spectra of the two input traces. In specifying the channel list, the first channel index corresponds to the numerator spectrum and the second channel index to the denominator spectrum.

Next, you will be prompted for the so-called waterlevel. In deconvolution, a small value in the denominator spectrum will cause an instability of the spectral division. All spectral values less than the waterlevel to be “filled up” to the waterlevel. In PITSA, the waterlevel is referenced to the maximum spectral value of the amplitude spectrum of the denominator spectrum in dB. For example, entering “20” for the waterlevel, will cause all spectral values in the denominator spectrum with an amplitude value below 0.1 of the maximum spectral value to be filled up to the waterlevel value. The phase values of the spectrum are unaffected by this process. A message window will display information about the number of spectral values found below the waterlevel. The “quality” of the deconvolution result may strongly depend on the selection of a proper waterlevel (see Figure 7-34)
Figure 7-34. The result of a deconvolution. The first three traces come from Figure 7-33. Traces 1 and 2 where convolved to produce trace 3 (indices were entered as 2, 1). Then Deconvolution (FRÉQ) was selected and indices 3, 1 were entered. The waterlevel for this example was purposely set to 20 dB (too small) to demonstrate the sensitivity to its proper selection.

7.5 Particle Motion

Particle motion analysis is an important tool for many seismological problems (e.g., phase identification, onset time determination, etc.). PITSA allows the user to interactively display particle motion diagrams (hodograms) in 2 and 3 dimensions for a moving window which can be shifted along the traces with a variable step size. Therefore, there are two options available for this tool:

- 2-D Snake
- 3-D Snake

PITSA will ask for the channels to use for the specified option (2 channels for 2D and 3 channels for 3D). PITSA will then have the user zoom in on the region of the traces that are to be plotted.

After the zoom is finished, PITSA will ask the user for the number of points to use for the particle motion ‘snake’. This will be the maximum number of points that can be seen in the particle motion projection at any one time (the length of the moving window). For a sampling frequency of 100 Hz, entering “20” would result in a window of 0.2 seconds moving along the traces. The Header Access -> Record option can be used to find the sampling frequency (Section 8.3.3). The moving window is called a snake because as the user steps through the traces being projected, the particle motion line will move in a snake-like fashion with the tip of the snake pointing towards positive times. PITSA will also ask the user how many points to move in the traces for each step. If there are a large number of points in the zoom area, it can take a long time to step through each individual point and it is desirable to be able to move more than one point per step.

If the user selected a 3D snake, then additional input will be required. These input parameters are discussed in Section 7.5.2.
Much of the user’s control for the particle motion displays is through the keyboard. Table 7-5 summarizes these controls.

Table 7-5. Keyboard commands for particle motion analysis.

<table>
<thead>
<tr>
<th>Key</th>
<th>2D Function</th>
<th>3D Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>R, -&gt;</td>
<td>Moves the snake to the right, or forwards in time.</td>
<td>Same as 2D.</td>
</tr>
<tr>
<td>L, &lt;-</td>
<td>Moves the snake to the left, or backwards in time.</td>
<td>Same as 2D.</td>
</tr>
<tr>
<td>CR</td>
<td>Moves the snake all the way to the right.</td>
<td>Same as 2D.</td>
</tr>
<tr>
<td>1,2,3</td>
<td>Lets the user pick a phase on either trace 1 or 2. The 3 key has no effect.</td>
<td>Same as 2D except that the 3 key picks a phase on the third trace.</td>
</tr>
<tr>
<td>A</td>
<td>Toggles the arrow mode from arrow only at the head; arrow at all points; and no arrows.</td>
<td>No function.</td>
</tr>
<tr>
<td>P, T, D</td>
<td>No function.</td>
<td>P increments the phi viewing angle and T the theta viewing angle. D changes the direction of the increment.</td>
</tr>
<tr>
<td>+, -</td>
<td>Increments (+) or decrements (-) the snake step size.</td>
<td>Same as 2D.</td>
</tr>
<tr>
<td>?</td>
<td>Displays information about the snake.</td>
<td>Displays information about the snake and the viewing angle.</td>
</tr>
<tr>
<td>S</td>
<td>No function.</td>
<td>Spins the snake about the Z (or 3) axis.</td>
</tr>
</tbody>
</table>

### 7.5.1 2D Snake

First enter the indices corresponding to the horizontal (x-axis) and vertical (y-axis) coordinate axes, respectively. Then PITSA will have the user zoom in on the section of data to project and ask for the length and step size of the snake. Figure 7-35 shows the 2D particle motion screen as it first appears. To the left, the zoomed up areas of the component traces are displayed while on the right, the 2D projection is displayed. When the screen first appears, only the first data point is displayed in the projection. To view the particle motion, the user steps through the traces by pressing either the R key or the right arrow (->) key.
Figure 7-35. The 2D particle motion screen as it first appears. To the right, the two traces used for the horizontal (x axis; top trace) and vertical (y axis; bottom trace) component are displayed. To the left is the partial motion display.

Each time the R or right arrow (→) key is pressed, the snake will move forwards in time by a number of points determined by the snake step size. A vertical bar will appear at the beginning of the traces to indicate where the head of the snake is. As the snake moves forward in time, the head will eventually run off the end of the trace and another vertical bar will appear on the traces to indicate where the tail is. Figure 7-36 shows the particle motion screen after the snake has been moved to the right far enough so that both the head and tail vertical bars are on the screen. To move the snake backwards in time, press the L key or the left arrow (←) key.
Figure 7-36. The 2D particle motion screen after the snake has been moved far enough to the right so that both the head and tail bars are shown on the left hand traces. In the upper righthand corner is the pop-up window which displays the time for the data point at the head of the snake.

The user can change the step size the snake takes by pressing either the + key (to increase the step size by 1) or the – key (to decrease the step size by 1). To view the step size, the user can hit the ? key. PITSA will display a message with information about the current snake parameters (Figure 7-37). A complete list of keyboard commands can be found in Table 7-5.

Figure 7-37. If the user hits the ? key, PITSA will display information about the particle motion snake.

7.5.1.1 Estimating polarization angles from the 2-D display

In addition to simply looking at the two dimensional projection of the time series traces, polarization angles of the particle motion can be measured. This is done by drawing a line on the plot. Move the mouse to a point where you wish to start drawing a line which will define the angle to be measured. Press the left mouse button and drag a line by moving the mouse cursor. Figure 7-38 shows the screen while a line is being drawn this way.
Figure 7-38. The particle motion screen while a line is being drawn to estimate angles.

When the mouse button is released, PITSA will draw a line between the two selected points and display the angle of this line in the pop-up window (Figure 7-39). The angle will be referenced to the start of the line drawn in map coordinates (toward the top of the screen is zero degrees). In order to avoid confusion, PITSA will draw a small vertical line and circular arrow at the start of the line (shown in Figure 7-39). When you move the snake again the angle tool will be removed.

Figure 7-39. The 2D angle tool after a line has been completed.
7.5.1.2 Alternative displays of the particle motion snake

Initially, PITSA will display a single arrow at the head of the snake. The user can use the A key to toggle between this mode and two others. Pressing the A key once will cause PITSA to display an arrow at each point in the particle motion snake (Figure 7-40).

Figure 7-40. Displaying an arrow at all points in the particle motion snake.

Pressing the A key a second time will change the display so that no arrows are shown.

7.5.1.3 Phase picking from the particle motion plot

You can make a phase pick at the location of the snake head by pressing either the 1 key (make the pick on the first trace) or 2 key (make the pick on the second trace) key. PITSA will display the text input window shown in Figure 7-41. Up to 9 characters can be entered as the phase ID. The user can view and edit the picked phase by going into the Routine Tools -> Phase Picking tools (see Section 6.4).

Figure 7-41. By pressing either the 1 (for first trace) or 2 (for the second trace), the user can enter a phase pick at the location of the snakes head.

Table 7-5 summarizes the key commands available.

7.5.2 3D Snake

In addition to the trace indices, size of the particle motion snake and the number of points to step, the 3D option for the Particle Motion tool will require some additional information. The first three questions will have to do with how PITSA will project the 3D display onto the computer screen.

For the 3D display, PITSA uses a right hand 3 dimensional coordinate system as shown in Figure 7-42. PITSA projects all the 3D points onto an imaginary plane placed between a hypothetical viewer and the 3D coordinate system. Two angles determine the orientation of the 3D coordinate system with respect to the projection plane, theta and phi. Theta is the angle which the coordinate system is rotated about the Z axis. If theta is zero (assuming phi is zero), then the viewer’s eye is
looking straight down the positive Z-axis and the Y-axis points up and the X-axis points to the right (Figure 7-42).

Figure 7-42. Projection of the 3D coordinate system onto an imaginary plane between the viewer and the coordinate system. Two angles, theta and phi, determine the orientation of the 3D coordinate system relative to the projection plane.

If theta is 90 degrees, then the Y-axis points to the right and the X-axis points down (Figure 7-43a). Phi is the angle which the coordinate system is rotated about the X-axis. If phi is zero (assuming theta is zero), then the viewer is looking straight into the positive Z-axis and if phi is 90 degrees, then the viewer is looking straight into the negative Y-axis. Figure 7-42 shows the projection with both theta and phi set to zero. The order of these rotations is important: first the coordinate system is rotated about the X-axis phi degrees and then about the Z-axis of the already rotated frame by theta degrees. Thus visually, changing the angle phi will always rotate the coordinate system about the X-axis of the projection plane (Xp) and changing theta will rotate the coordinate system about the Z-axis of the 3D system. PITSA will supply the user with default values of -30 degrees for theta and 80 degrees for phi.

Figure 7-43. View of four different mappings from the 3D coordinate system to the projection plane. These figures show the location and direction of the 3 axis on the 2D display.

In addition to changing the orientation of the projection plane with respect to the 3D coordinate system, the user can apply foreshortening. Foreshortening makes objects that are closer to the projection plane appear larger and objects that are further away appear smaller. Typically, with particle motion plots, foreshortening tends to add more confusion than clarity.
PITSA projects the 3D image onto a plane (always perpendicular to the line between the viewer’s eye and the 3D coordinate system origin). The projection plane is placed at a distance \( d \) away from the 3D coordinate system, which is the maximum distance any of the particle motion points will be from the 3D origin. We then place the viewer’s eye some factor of this distance away from the projection plane (called the distance ratio; see Figure 7-44). The higher this factor, the less effect foreshortening will have on the projected image. PITSA will provide the user with a default value of 50 for the distance ratio, which will result in little or no foreshortening.

**Figure 7-44.** An illustration of how foreshortening is performed in the 3D particle motion display. Two points are shown (both in the X=0 plane), one closer to the viewer than the other. The projection plane is placed a distance \( d \) from the origin of the 3D coordinate system and the viewer’s eye is placed a factor of distance \( \text{ratio} \) times \( d \) away from the projection plane. In order to map points from the 3D coordinate system, a line is drawn from the point to the viewer’s eye and the intersection with the projection plane is painted. Thus the point that is closest appears to be taller than the point further away. In the figure, the first quadrant of the projection plane is shown.

![Diagram](image.png)

Closer point is plotted higher than the further point even though they have the same Z value (X=0 for both)

Finally, PITSA will ask if you want to plot the snake shadow. It can be difficult to visualize what the particle motion actually looks like from the 2D projection. To assist in visualization, the projection of the particle motion onto the X-Y plane (or the shadow that would result from a light source at \( Z = \infty \)) can be plotted in the secondary drawing color (Figure 7-45).
Figure 7-45. The user can plot the projection of the particle motion snake onto the X-Y (or 1-2) plane. The shadow will be plotted in the secondary plotting color. In the above figure, it is hard to tell that the particle motion shown lies within a plane without the plotting of the shadow.

The functioning of the 3D particle motion screen is nearly the same as with the 2D screen, with some additional functionality. Also, no angle estimation tool is available nor are arrows plotted. The user steps the snake through the source traces with the \texttt{R} or right arrow key (\texttt{\rightarrow}) to move forward in time and the \texttt{L} or left arrow key (\texttt{\leftarrow}) to move backwards in time. Phase picks can be made at the location of the head of the snake with the 1 (to pick on first trace), 2 (to pick on the second trace) and 3 (to pick on the third trace) keys.

The viewing angle can be changed with the \texttt{P} (to change the phi angle) and \texttt{T} (to change the theta angle) keys. Pressing one of these keys will add a small incremental amount the appropriate angle. The user can toggle the direction of the angle increment with the \texttt{D} key. If the user types the ? key, PITSA will display the information shown in Figure 7-46. In addition, the user can spin the particle motion snake about the Z (or 3) axis by pressing the \texttt{S} key.

Figure 7-46. Information display in the 3D particle motion screen when the user hits the ? key.

Table 7-5 summarizes the key commands available.
7.6 Hilbert Transform (Envelope)

Waves propagating through an internal caustic within the Earth undergo a constant phase shift of -90˚ which corresponds to a Hilbert transform. PITSA provides a tool, Advanced Tools -> Envelope / Hilbert Trans, to simulate this effect numerically. The Hilbert transform can also be used to calculate the envelope of a signal. For a discussion of the theoretical background of this topic see Kanasewich (1981). There are two options for this tool:

- Keep Envelope
- Keep Hilbert Transform

For each selected trace, PITSA will calculate and display both the envelope and the Hilbert Transform (Figure 7-47); the choice of options only controls which one will be saved in the Replace or Append step. They can both be saved in a two-step process.

Figure 7-47. The result of an Envelope / Hilbert Trans calculation. The upper trace shows the original trace with the envelope calculation overlaid on top. The lower trace shows the Hilbert transform.

Figure 7-48 shows the display after an envelope and Hilbert calculation have been accepted and appended in separate steps. Trace 1 shows data collected at the GRF station C1 for the Fiji earthquake of June 26, 1990 (lat: 22.02 S; lon: 179.47W; Mb: 6.0; delta: 151.4 deg). The data shown correspond to the PKP wavegroup (vertical component) and show its three branches DF, BC, and AB. The AB branch has some interesting properties: It corresponds to a maximum traveltime path and since it touched an internal caustic, it has a constant phase shift of -90 degrees. This means that it was Hilbert transformed. This is why the AB wavelet of trace 1 (the original trace) and the BC wavelet of trace 3 (the Hilbert transformed trace) have a similar waveform.
7.7 Rotate Components

PITSA’s coordinate transformation tools, found under Advanced Tools -> Rotate Components, are used to rotate multi-component seismograms into ray-based coordinate systems. There are three options under this tool:

Table 7-6. Component rotation options

<table>
<thead>
<tr>
<th>Menu Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rotate N’,E’ -&gt; N,E</td>
<td>2-D rotation of horizontal components, to correct non-standard component orientation</td>
</tr>
<tr>
<td>Rotate N,E -&gt; R,T</td>
<td>2-D rotation of horizontal components to radial (R) and transverse (T) component.</td>
</tr>
<tr>
<td>Rotate Z,N,E -&gt; L,Q,T</td>
<td>3-D rotation to longitudinally- (L), vertically- (Q), and transversely- (T) polarized components.</td>
</tr>
</tbody>
</table>

Obviously, an estimate of back-azimuth is required for any of these options, and the 3-D option also requires an estimate of incidence angle.

7.7.1 Back-azimuth

The back-azimuth is defined as the angle measured between the vector pointing from the station to the source and the vector pointing from the station to the north. If the data header contains an entry for the back-azimuth angle, it will be displayed as default (Section 8.3.2). The back-azimuth can also be determined from the particle motion analysis of the horizontal components of the P wave portion of a seismogram (Figure 7-49).
7.7.2 Incidence Angle

The incidence angle is defined as the angle measured between the ray vector at the station (from the source to the station) and the vector pointing from the station straight up. If the data headers contain a value for the incidence angle, it will be displayed as the default values. See the example in Section 7.7.4.1 for the steps to estimate the incidence angle from 3-component data.

7.7.3 Rotate N',E' -> N,E

For cases in which the horizontal component seismometers have been installed in non-standard orientations, the Rotate N',E' -> N,E option is used to rotate the recorded horizontal components to the standard north (N) and east (E) coordinate system.

7.7.4 Rotate N,E -> R,T

The Rotate N,E -> R,T option is used to rotate the standard horizontal components to the radial (R) and transverse (T) coordinate system.

This option may be used to estimate the apparent incidence angle (see example 7.7.4.1 below), which can be measured directly from a particle motion plot of the radial versus vertical particle motion components.

7.7.4.1 Determination of apparent incidence angle.

This example uses the 2-D Snake tool (Section 7.5.1) and the Component Rotation tool to determine the apparent angle of incidence.

- Load a 3-component set of traces, assumed to be in the order Z, N, E.

The back-azimuth angle for rotation to the (R, T) coordinate system is determined from the particle motion plot of the horizontal components of the P wave portion of the seismogram.

- Select Advanced Tools -> Particle Motion -> 2D Snake.
- Enter 3, 2 for the X and Y components.
- Use the Double Cursor method to zoom in on the part of traces containing the P wave.
- Accept the default for the number of points to use for the particle motion snake.
- Enter 1 for the snake step size.
- Step forward through the trace with the R key and use the angle tool to estimate the back-azimuth (see Figure 7-49).
Figure 7-49. Determination of the back-azimuth using the 2D particle motion.

- Select Advanced Tools -> Rotate Components -> Rotate N,E -> R,T.
- Enter 2, 3 for the indices of the N and E traces.
- Enter the back-azimuth value you estimated.

Figure 7-50. The N and E traces rotated to the R and T components.

- Estimate the incidence angle by viewing the R and Z component in the 2D particle motion plot (Figure 7-51).
Figure 7-51. Incidence angle determination using the particle motion plot for the radial against the vertical components. The apparent incidence angle for this example was approximately 34°. Notice, that the apparent incidence angle is measured counterclockwise from the vertical (up) -> positive radial.

7.7.5 Rotate Z,N,E -> L,Q,T

The Rotate Z,N,E -> L,Q,T option is used to rotate components in 3-D, from the standard coordinate system into the longitudinal (L: along the path of propagation), vertically-polarized (Q: as in the SV phase), and transversely-polarized (T: as in the SH phase) coordinate system.

You will be asked to enter the back-azimuth and the incidence angle in degrees. For the determination of back azimuth and apparent incidence angle see Section 7.5 and the example in Section 7.7.4.1. An example is shown in Figure 7-52.
7.8 Polarization Filter

In addition to the analysis of particle motion plots, with its Polarization Filter tool, PITSA offers a quantitative method to determine the polarization properties of seismic signals. Both a measure of the amount of linearity and the particle motion direction are calculated using the time-domain filter described by Montalbetti and Kanasewich (1970). A slightly different filter is based on the complex analytical signal presented by Vidale (1986).

7.8.1 Montalbetti and Kanasewich Filter

The method is based on the diagonalization of the covariance matrix for the set of components being used. The amount of linearity—which is called rectilinearity—is calculated from the ratio of the largest to the smallest eigenvalue. The particle motion direction is given by the direction of the eigenvector corresponding to the largest eigenvalue. Since the eigenvalues and eigenvectors must be determined for each time step, the method is fairly time-consuming. In order to speed up the calculation, the analysis window is shifted along the traces with a user-selectable step width. Finally, a set of time-varying operators is obtained which is used as gain control on the input time series to suppress unpolarized signal energy. Because the gain control operators are interpolated between samples for which the covariance matrix has actually been calculated, care must be taken with the choice of the step width of the sliding window. For the details on the theory of the polarization filter see Montalbetti and Kanasewich (1970) and Kanasewich (1980). For the following, the nomenclature of Kanasewich (1980) has been adopted.
After entering the appropriate channels for the selected option, you will be asked for the window length in points and the number of points to shift per filter step to be used for the covariance matrix calculation. For a sampling frequency of 100 Hz, entering "20" as window length and "5" as step width would result in a window length of 0.2 seconds being moved along the traces with a step width of 0.05 seconds. If you enter "-1" for the window length, only the covariance matrix, the eigenvalues and the eigenvectors will be calculated, without performing any filtering. This provides a simple way to determine these parameters for a given set of components.

For each step, the covariance matrix is analyzed for the time window centered around the current sample. The window margin can be tapered (with the cosine taper function) with a user-selected tapering fraction. Entering "0.2" for the taper fraction will cause 10% on either margin of the window to be affected by the tapering.

After the eigenvalues $\lambda_i$ and the eigenvectors $e_i$ have been determined ($i$ running from 1 to the number of components being used), the rectilinearity is calculated according to:

$$RL(t) = \left[1 - \left(\frac{\lambda_2}{\lambda_1}\right)^n\right]^j$$

Here $\lambda_1$ and $\lambda_2$ are the largest and the next-largest eigenvalues for the covariance matrix centered around time $t$. Furthermore, direction functions $D_i(t)$ with

$$D_i(t) = (e_i)^k$$

are calculated. You will enter values for the eigenvalue exponent $n$, the rectilinearity exponent $j$, and the eigenvector exponent $k$, respectively. The rectilinearity and the direction functions are smoothed in time using a moving average filter for which you must enter the half-width in number of points, resulting in new functions $\overline{RL}(t)$ and $\overline{D}_i(t)$, respectively. Finally, the filtered traces $s_i^{filt}(t)$ are obtained from the input signals $s_i(t)$ by

$$s_i^{filt}(t) = s_i(t)\overline{RL}(t)\overline{D}_i(t)$$

After all the calculations have been done, you will select a display option (Table 7-8).
Table 7-8. Polarization Filter display options.

<table>
<thead>
<tr>
<th>Display Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Eigenvector + Rectilinearity</td>
<td>Eigenvector components corresponding to the largest eigenvalue, together with the rectilinearity.</td>
</tr>
<tr>
<td>Eigenvector + Largest Eigenvector Proj</td>
<td>Eigenvector components corresponding to the largest eigenvalue, together with the projection of the particle motion vector on the direction of the dominant eigenvector.</td>
</tr>
<tr>
<td>Filtered Traces</td>
<td>Filtered traces $s_i^{filt}(t)$.</td>
</tr>
</tbody>
</table>

In Figure 7-53, an example is given for the application of the polarization filter on the traces from Figure 7-52.

Figure 7-53. Polarization filter. The three top traces correspond to the rotated traces (L, Q, T) from Figure 7-52 (more points are shown here). The four bottom traces show the filtered traces and the rectilinearity, respectively. Notice the clear separation of linear polarized energy on the individual components.

7.8.2 Vidale Filter

The filter introduced by Vidale (1986) is based on the same assumptions and techniques just described. The only difference is due to the complex valued signals used by the Vidale filter. The complex analytical signal is defined as:

$$s^{\text{analy}}(t) = s(t) + iH[s(t)]$$

Here $H[s(t)]$ is the Hilbert transformation of the input trace $s(t)$ and $i$ is $\sqrt{-1}$. After converting each component to its analytical counterpart, we now compute the complex covariance matrix. After solving the calculation of the eigenvalue problem, the eigenvector according to the largest eigenvalue points in the direction of...
the largest amount of polarization of the signal. Maximizing the following quantity by rotating the eigenvector \([x_0, y_0, z_0]\) according to the largest eigenvalue in the complex plane (searching over \(\alpha = 0^\circ - 180^\circ\)): 

\[X = \sqrt{(Re[x_0 e^{i\alpha}])^2 + (Re[y_0 e^{i\alpha}])^2 + (Re[z_0 e^{i\alpha}])^2}\]

and computing 

\[P_E = \frac{\sqrt{1 - (\text{Max}[X])^2}}{\text{Max}[X]},\]

we reveal also a measure of the particle motions ellipticity. \(P_E\) is 1 for circular and 0 for linear polarized motion, respectively. This quantity is especially useful if the signal consists of Rayleigh waves. Here \(Re[\ ]\) represents the real part of a quantity. The azimuth of the direction of maximum polarization is simply:

\[\phi = \text{atan} \left( \frac{Re[y_0]}{Re[x_0]} \right).\]

The dip of the largest amount of polarization is given by:

\[\delta = \text{atan} \left( \frac{Re[z_0]}{\sqrt{(Re[x_0])^2 + (Re[y_0])^2}} \right)\]

In order to rate the amount of linearity of the polarization, two additional quantities are introduced by Vidale (1986):

\[P_S = 1 - \frac{(\lambda_1 + \lambda_2)}{\lambda_0}\] and \(P_P = 1 - \frac{\lambda_2}{\lambda_1}\).

If \(P_S\) is 1 if the signal is completely polarized in only one component. The latter quantity describes the planar polarization of the signal, which is 1 if the intermediate component is much bigger than the smallest component of polarization.

Because this computation is rather time consuming you are asked to enter for the window length in points and the number of points to shift the window per filter step. After calculations are done, you are asked for the number of points needed for smoothing the resulting traces. Finally all traces of quantities introduced above are displayed which can be accept and appended to the existing traces (Figure 7-54).
Figure 7-54. Complex Polarization filter. The first three traces show the linearity values $P_S$, $P_P$ and the measure for ellipticity $P_E$, respectively. The last two traces display azimuth and dip of the eigenvector regarding to the largest eigenvalue of polarization.

7.9 Cross Spectrum

The cross-spectrum is a measure of the joint spectral contents of two traces. If two traces are related by a simple linear time shift, the phase of the cross-spectrum is linear with slope proportional to the relative time difference. In the context of seismological signal analysis, this property has made the cross-spectrum an important tool to determine relative time shifts with accuracies better than the sampling interval (Poupinet et al., 1984; Ito, 1985). For a discussion of the influence of noise on the timing accuracy see Scherbaum and Wendler (1986).

After specifying two traces to use for the cross-spectrum calculation, you will be asked to enter the number of points for the FFT. A number equal to or larger than the default value (to avoid wrap around problems) should be entered. Then you will choose the type of spectral display and the axis type.

An example for the cross spectrum of two synthetic traces which are identical except for a one sample time shift is shown in Figure 7-55.

Figure 7-55. Cross spectrum. The second trace is a time delayed version (one sample) of the topmost trace. Below, the amplitude and phase of the corresponding cross spectrum are displayed. Notice the linear phase which indicates the pure time shift between the two uppermost traces.

7.10 Coherence Spectrum

The coherence spectrum is a well-established measure of the association of two different traces which may be restricted to particular frequency bands. It is defined as the ratio of the smoothed cross-spectrum of two traces and the product of their smoothed amplitude spectra (Kanasewich, 1980).

After specifying the two traces to use for calculation of the coherence spectrum, you will be asked to enter the half width of the smoothing window for spectral smoothing, which must be an integer number greater than 0. Next the coherence spectrum will be displayed below the two input traces (Figure 7-56). The values of the coherence spectrum range between 0 (no coherence) and 1 (total coherence). If no smoothing is done, the coherence spectrum will be 1 regardless of the similarity of the traces (Kanasewich, 1980).
7.11 Response Spectrum

The response spectrum is a commonly used spectral measure in earthquake engineering which describes the maximum response of a single-degree-of-freedom oscillator to a given input motion (here the input trace). It is a function of the natural frequency of the oscillator and its damping ratio. After selecting the trace to be analyzed, the user has to provide the fraction of damping (in percent). A commonly used value is 5 %. The

- Fraction of damping of the oscillator. A commonly used value is 5 [%].
- Display type. Select either frequency or period. This controls if the values of the response spectrum are calculated and displayed with increasing frequency or period.
- Range and increment for period or frequency, respectively. Provide start value, end value, and increment value separated by commas.
- Select one of the three possible types of response spectrum to be displayed: displacement, velocity or acceleration.

Subsequently, the resulting spectrum will be calculated using the technique of Ehrenberg and Hernandez (1981).

7.12 Spectral Ratio

For two given spectra, option Spectral Ratio PITSA calculates the ratio of two selected input traces which must both correspond to complex spectra. In specifying the channel list, the first channel index corresponds to the numerator spectrum and
the second channel index to the denominator spectrum. The resulting spectrum is again a complex spectrum which can be treated accordingly (demultiplexed etc.).

After channel selection the user will be prompted for the so-called waterlevel. During spectral division, a small value in the denominator spectrum will cause an instability. Therefore, all spectral values less then the waterlevel are “filled up” to the waterlevel. In PITSA, the waterlevel is referenced to the maximum spectral value of the amplitude spectrum of the denominator spectrum in dB. For example, entering “20” for the waterlevel, will cause all spectral values in the denominator spectrum with an amplitude value below 0.1 of the maximum spectral value to be filled up to the waterlevel value. The phase values of the spectrum are unaffected by this process. A message window will display information about the number of spectral values found below the waterlevel. The “quality” of the result may strongly depend on the selection of a proper waterlevel.
CHAPTER 8 Utilities

This chapter describes how to use the various tools under the Utilities menu of PITSA. Table 8-1 outlines the classes of tools available.

Table 8-1. Classes of tools available under the Utilities menu.

<table>
<thead>
<tr>
<th>Menu Selection</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Test Signals</td>
<td>Create a variety of test signals.</td>
</tr>
<tr>
<td>Trace Utilities</td>
<td>Combine and manipulate traces in many ways, change axis type.</td>
</tr>
<tr>
<td>Header Access</td>
<td>View and modify header information for station event, record, and output.</td>
</tr>
<tr>
<td>Phase Utilities</td>
<td>Use of slowness information, expected phase arrival times.</td>
</tr>
<tr>
<td>Resampling</td>
<td>Simulate the discretization of continuous data, gain-ranging A/D converter.</td>
</tr>
</tbody>
</table>

8.1 Test Signals

A variety of standard test signals can be created by selecting one of the options under the Utilities -> Test Signals menu:
Table 8-2. Test Signals.

<table>
<thead>
<tr>
<th>Test Signal</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sine/Cosine</td>
<td>Sinusoids.</td>
</tr>
<tr>
<td>Spike(s)</td>
<td>Multiple spikes, positive and negative amplitudes.</td>
</tr>
<tr>
<td>Constant</td>
<td>Boring!</td>
</tr>
<tr>
<td>Brune source</td>
<td>A simple earthquake source model.</td>
</tr>
<tr>
<td>Mixed Signal</td>
<td>Superposition of sinusoidal, exponential, and linear functions.</td>
</tr>
<tr>
<td>Ricker Wavelet</td>
<td>Zero-phase wavelet.</td>
</tr>
<tr>
<td>Seismometer</td>
<td>Seismometer response.</td>
</tr>
<tr>
<td>Chirp Signal</td>
<td>Sinusoid with linearly increasing frequency from (f_1) to (f_2)</td>
</tr>
<tr>
<td>RPN Equation</td>
<td>General function generator using Reverse Polish Notation (RPN).</td>
</tr>
</tbody>
</table>

The user can select the sampling rate, start time and the number of data points. In addition, noise can be added to the test signals.

8.1.1 Add Noise

During creation of test signals, you will be asked whether to add noise to the signal (Figure 8-1).

Figure 8-1. The Noise Method pop-up window.

If the option Noisy is selected, PITSA will prompt for the statistical properties of the noise to be added, which are described by the Noise Mode and the noise variance \(\sigma\). There are two options, shown in Table 8-3

Table 8-3. Noise Modes.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Mode Name</th>
<th>Noise Distribution</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Equally distributed</td>
<td>Over the interval ([-\sqrt{6}\sigma, \sqrt{6}\sigma])</td>
</tr>
<tr>
<td>2</td>
<td>Gaussian distribution</td>
<td>((1/\sigma \sqrt{2\pi}) \exp(-1/2(x/\sigma)^2))</td>
</tr>
</tbody>
</table>

You will initialize the random number generator in PITSA by entering a negative integer value when asked for the random number seed value. The same seed value will produce the same noise sequence for a given sampling rate and test signal length and hence allows you to create repeatable noisy test signals.
8.1.2 Sine/Cosine

To create a sinusoidal signal \( f(t) = A \cdot \sin(2\pi ft + \phi) \), you will be asked to enter amplitude \( A \), frequency \( f \) in Hz, and phase values \( \phi \) in degrees) for each trace to create. To create a cosine, enter a phase value of 90 degrees. Digitization frequency, time of the first sample, and the number of points for each trace are kept the same for multiple traces. Figure 8-2 shows a Sine/Cosine test signal.

**Figure 8-2.** A Sine/Cosine test signal. This is a 100 Hz sampling rate, 1000 point sine wave with amplitude of 1, frequency of 1 Hz and phase angle of 0.

8.1.3 Spike(s)

Using this option, you can create spiky test signals consisting of multiple or single spikes of different amplitudes at different positions. PITSA prompts for the index of a spike position and subsequently for its amplitude. Amplitude values may be negative or positive. Legal spike indices are always positive, however, and PITSA continues asking for new spike positions until a negative value is read.
Figure 8-3. A spike test signal with noise added. The sampling rate is 100 Hz and there are 1000 points. Spikes have been added at index values 200 (value = 1.0), 300 (value = -2.0), 700 (value = -1.5) and 900 (value = -3.0).

8.1.4 Constant

This test signal is a simple single value function (Figure 8-4). The user will be asked for the value to apply to every point of the test signal.

Figure 8-4. A constant test signal (1000 points at 100 Hz sampling rate) with a value of 1.0. This signal did not have noise added to it.
8.1.5 Brune Source Signal

One can create a test signal corresponding to the displacement pulse \( u(t) \) from a Brune earthquake source model (Brune, 1970) where:

\[
 u(t) = 2R(\theta, \phi) \frac{\sigma}{\mu} \frac{r}{v_s z} - 2.34 \frac{v_s}{r} e^{-2.34 \frac{v_s}{r}} 
\]

with \( R(\theta, \phi) \) being the radiation pattern, \( \sigma \) being the stress drop in bars, \( \mu \) being the shear modulus in Pa, \( v_s \) the shear velocity in km/sec, and \( r \) and \( z \) being the source radius and the hypocentral distance, respectively, in km. In the formula above, the free surface is taken into account by a factor of 2 (SH waves).

PITSA prompts for input of values for the radiation pattern (rth), stress drop (sigma), shear modulus (mu), shear velocity (vs), source radius (r), and the hypocentral distance (z) separated by commas. An example for a Brune source pulse is shown in Figure 8-5.

Figure 8-5. Example of a noise free Brune source pulse created using the default input parameters (sampling rate = 100 Hz, number of points = 1000, rth = 0.625, sigma = 50.0, mu = 3 \times 10^{10}, vs = 3.5, r = 10., z = 20.0).

8.1.6 Mixed Signal

The mixed signal is a superposition of a sinusoidal, an exponential and a linear function in order to help the user create a very general type of test signal. It is calculated according to the following formula:

\[
 u(t) = A \sin(2\pi f + \phi) e^{-B t} + C t + D 
\]

PITSA prompts for the amplitude \( A \), frequency \( f \), phase term \( \phi \), and constants \( B, C, \) and \( D \), all separated by commas.
Figure 8-6. A 100 Hz 1000 point mixed signal with parameters of \( A = 100.0, \ F = 1.0, \ PHI = 0.0, \ B = 5.0, \ C = 0.0, \ D = 2.0. \)

8.1.7 Ricker Wavelet

The Ricker wavelet is a zero phase wavelet which is the second derivative of the error function. PITSA prompts for the dominant frequency in Hz. Figure 8-7 shows a Ricker wavelet with a dominant frequency of 1 Hz.

Figure 8-7. A Ricker wavelet with a dominant frequency of 1 Hz. The traces is 1000 points long sampled at 100 Hz.
8.1.8 Seismometer

Use this option to create test signals simulating the response of a seismometer to different input signals. PITSA will display a pop-up menu to select the type of signal:

**Table 8-4. Options for seismometer test signals**

<table>
<thead>
<tr>
<th>Signal Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accel. step. -&gt; displ. response</td>
<td>Theoretical response of displacement transducers to a step function in acceleration.</td>
</tr>
<tr>
<td>Accel. step. -&gt; veloc. response</td>
<td>Theoretical response of velocity transducers to a step function in acceleration.</td>
</tr>
</tbody>
</table>

These last two kinds of input signal can be generated in seismometers with additional calibration coils by turning off (or on) a constant calibration current.

After selecting the signal type, you will be prompted for the eigenfrequency in Hz and the damping factor for the seismometer to simulate. The input signal is assumed to act at time zero.

**Figure 8-8. Impulse displacement response seismometer test signal with an eigenfrequency of 5 Hz and damping factor of 0.4. The trace length is 1000 points and is sampled at 100 Hz.**

8.1.9 Chirp Signal

The chirp signal is produced by linearly increasing the frequency of a sinusoid between two frequencies \( f_1 \) and \( f_2 \):
Chapter 8

Chapter 8

PITSA prompts for the amplitude $A$, lower frequency $f_1$, phase term $\phi$, and the higher frequency $f_2$, all separated by commas. Figure 8-9 shows an example of a chirp signal.

Figure 8-9. A 1000 point 100 Hz chirp signal with amplitude 1, $f_1 = 0.01$ Hz, $f_2 = 10.0$ Hz and a phase angle of 0.0.

\[ u(t) = A\sin(2\pi f(t) t + \phi) \]

$ f_1 \leq f(t) \leq f_2$

8.1.10 RPN Equation

The *RPN equation* option is the implementation of a general purpose function generator using Reverse Polish Notation (RPN) for its input (the way many HP calculators work). The user will be asked to enter an RPN equation as input with $X$ being the independent time variable. In order to create the sinusoidal signal:

\[ u(t) = 3\sin(2\pi f t) \]

with $f = 3$ Hz, you would enter

\[ \text{X 6.28 * 3 * SIN 3 *} \]

Several functions and constants are available; they are enumerated in Table 8-5.
8.2 Trace Utilities

The tools under Trace Utilities allow the user to perform simple trace manipulations like adding, shifting, or scaling traces, changing axis types, and stacking traces.
Table 8-6. Tools under the Utilities -> Trace Utilities menu.

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single Channel Utilities</td>
<td>Utilities for manipulating single channels, including scaling, adding and subtracting offsets, power, logarithm, cyclic and linear shift, appending zeroes, time reversion and rectifying.</td>
</tr>
<tr>
<td>Double Channel Utilities</td>
<td>Utilities for manipulating two channels, including scaled addition, multiplication, stabilized ratio, euclidian distance calculus, arcus tangens and projection angles.</td>
</tr>
<tr>
<td>Triple Channel Utilities</td>
<td>Utilities for manipulating three channels, including euclidian distance calculus and projection angles calculation.</td>
</tr>
<tr>
<td>Scale Traces Together</td>
<td>Plot traces in common scale.</td>
</tr>
<tr>
<td>Re-Autoscale Traces</td>
<td>Reverting changed viewports to automatic scaling.</td>
</tr>
<tr>
<td>Change Axis Type</td>
<td>Choose different axis types for channels.</td>
</tr>
<tr>
<td>Stack Traces</td>
<td>Methods for stacking traces.</td>
</tr>
<tr>
<td>Unify Traces</td>
<td>Unify channels to common start time and length.</td>
</tr>
<tr>
<td>Normalize Traces</td>
<td>Normalize maximum in channel to given amplitude.</td>
</tr>
</tbody>
</table>

As their names indicate, some of these utilities require a specific number of input traces to act on.

8.2.1 Single Channel Utilities

The tools available under the Single Channel Utilities menu option are described in Table 8-7. They are all rather easy to understand and require one or two input parameters besides the channel list.
8.2.2 Double Channel Utilities

The tools available under the Double Channel Utilities menu option are described in Table 8-8. They mostly involve simple algebraic or trigonometric manipulations of two traces, point by point. Therefore the two traces used for input must contain the same number of points. The first trace of the channel list will be used for the X trace and the second trace will be used for Y.

<table>
<thead>
<tr>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>a*X + b</td>
<td>Scale and offset a trace. X represents the trace to be processed. Input values a and b. Each point in the original trace is multiplied by a and then b is added to obtain a new trace.</td>
</tr>
<tr>
<td>a*X ** b</td>
<td>Raise all values of input trace (X) to a power b and scale by a factor a.</td>
</tr>
<tr>
<td>Log10(X)</td>
<td>Take Log10 of all values of the input trace X.</td>
</tr>
<tr>
<td>Cyclic Shift</td>
<td>Enter a value for number of points to shift; positive value shifts trace to the right, a negative value shifts to the left. All values shifted outside of the current window will re-appear on the other side.</td>
</tr>
<tr>
<td>Linear Shift</td>
<td>Enter a value for number of points to shift. A positive value will cause the trace to be shifted to the right, a negative value to the left. All values shifted outside of the current window are set to 0.</td>
</tr>
<tr>
<td>Append zeros</td>
<td>Zero padding. Input number of zeros to append.</td>
</tr>
<tr>
<td>Invert trace in time</td>
<td>Simple inversion in time. No additional input.</td>
</tr>
<tr>
<td>Rectify</td>
<td>Absolute value of every point in the input trace.</td>
</tr>
</tbody>
</table>
Table 8-8. Double Channel Utilities.

<table>
<thead>
<tr>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(a<em>X + b</em>Y)</td>
<td>Enter values for (a) and (b).</td>
</tr>
<tr>
<td>(X*Y)</td>
<td>No further input.</td>
</tr>
</tbody>
</table>
| \(X/Y\)               | Stabilized ratio of \(X\) and \(Y\). Enter threshold value \(c\) to prevent divide-by-zero errors. If \(Y < c\), the denominator for the division will be set to \(\pm c\).
| \(\sqrt{X^2 + Y^2}\) | If input traces are viewed as components of a time-dependent 2-D vector, resulting trace corresponds to the length of this vector at any time. |
| atan2(X,Y) [deg]      | No further input.                                                           |
| Projection Angles     | Resulting trace contains projection angle of the particle motion vector defined by \(X\) and \(Y\), w.r.t. one of the selected coordinate axes. Calculated as inverse cosine of the scalar product of the particle motion vector and the selected coordinate axis. |

8.2.3 Triple Channel Utilities

The tools available under the **Triple Channel Utilities** menu option are described in Table 8-9. They involve simple algebraic or trigonometric manipulations of three traces, point by point. Therefore the three traces used for input must contain the same number of points. The three traces of the channel list are interpreted in order as \(X\), \(Y\), and \(Z\), respectively.

Table 8-9. Triple Channel Utilities.

<table>
<thead>
<tr>
<th>Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(\sqrt{X^2 + Y^2 + Z^2})</td>
<td>If input traces are viewed as components of a time-dependent 3-D vector, resulting trace corresponds to the length of this vector at any time.</td>
</tr>
<tr>
<td>Projection Angles</td>
<td>Resulting trace contains projection angle of the particle motion vector defined by (X), (Y), and (Z), w.r.t. one of the selected coordinate axes. Calculated as inverse cosine of the scalar product of the particle motion vector and the selected coordinate axis.</td>
</tr>
</tbody>
</table>

8.2.4 Scale Traces Together

In general, PITSA scales each trace automatically so that it is plotted at highest screen resolution. Especially with three component data, however, it is sometimes advantageous to preserve the real amplitude relationship between traces. The command **Utilities \rightarrow Trace Utilities \rightarrow Scale Traces Together** will cause the selected traces to be plotted at a common scale. Figure 8-10 shows three traces that have been scaled together. Figure 8-11 shows the same three traces after they have been re-autoscaled.
Figure 8-10. Three traces scaled together.

8.2.5 Re Autoscale Traces

For traces which have been scaled together to a common viewport (Section 8.2.4), or have had their viewport changed manually (Table 8-12), automatic scaling for selected traces can be re-invoked using the Utilities -> Trace Utilities -> Re Autoscale Traces option. Figure 8-11 shows the traces in Figure 8-10 after they have been re-autoscaled.

Figure 8-11. The traces of Figure 8-10 after they have been re-autoscaled.
8.2.6 Change Axis Type

Axis display types can be changed using into any combination of linear and logarithmic scales, using the option Utilities -> Trace Utilities -> Change Axis Type. PITSA displays the menu shown in Figure 8-12, from which the selection is made.

Figure 8-12. Axis Type pop-up menu.

8.2.7 Stack Traces

An arbitrary number of channels can be stacked using the menu selection Utilities -> Trace Utilities -> Stack Traces. There are three options:

- Receiver Beam
- Source Beam
- Plain Sum

Either of the Beam options will calculate a single-beam sum for a given back-azimuth (or azimuth, in the case of Source Beam) and slowness while Plain Sum will simply sum up the selected list of channels on a point by point basis.

The Y-axis plot label of the resulting trace is set to “RES” for all these utilities. See Table 8-12 on page 8-18 for information on how to change this.

8.2.7.1 Receiver Beam

The selected traces are considered to represent recordings at a group of seismic stations from a single event. Therefore the “station” location information in the data headers must be set properly before this tool can be used. Station coordinates are required to be specified in degrees (geographic coordinates).

PITSA prompts for the back-azimuth and slowness, and for the index of a reference channel. For each trace, PITSA calculates the time delay with respect to the reference channel for a signal propagating at the given slowness and azimuth. The resulting trace consists of the stacked delayed traces (“delay and sum” beam).

8.2.7.2 Source Beam

In this variation of beam-forming, the selected traces are considered to represent recordings at a single station of waveforms from a cluster of earthquakes (a “source array”). Therefore the “event” location information in the data headers must be set properly before this tool can be used. Event coordinates are required to be specified in degrees (geographic coordinates).
PITSA prompts for the azimuth (leaving the source area) and slowness, and for the index of a reference channel. For each trace, PITSA calculates the time delay with respect to the reference channel for a signal propagating at the given slowness and azimuth. The resulting trace consists of the stacked delayed traces ("delay and sum" beam).

8.2.7.3 Plain Sum

No further input is required. The resulting trace will consist of the stacked trace of all the traces in the selected channel list.

8.2.8 Unify Traces

PITSA works with a group of traces most easily if they all start at the same point in time and have the same number of points. Selecting Utilities -> Trace Utilities -> Unify Traces will allow the user to enter a list of traces that are to be unified in this manner. PITSA will find the earliest start time and latest end time of all traces entered and then pad the beginning and end of each trace with zeros such that all the traces will start and end at the same time.

8.2.9 Normalize Traces

Utilities -> Trace Utilities -> Normalize Traces simply normalizes the traces given in the input list to the user specified value.

8.3 Header Access

Besides the actual trace data values, PITSA keeps additional information on each trace in what are called data headers. Some header information is always required for PITSA’s internal processing; PITSA usually maintains these entries automatically. Other header entries are only used by certain tools, however, and are therefore optional. This chapter describes how to gain access to the header entries and modify them. Some of the header information can also be written out to a plain ASCII file. The accessible header entries are grouped in five categories:

- Station
- Event
- Record
- Plot
- Output

Any changes made in any of the header entries are only stored in memory. You must re-save the traces in ISAM format if you want to make the change permanent.

8.3.1 Station

Station-related header entries which can be accessed are listed in Table 8-10.
Table 8-10. Station-related Header Entries.

<table>
<thead>
<tr>
<th>Header Entry</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Station Code</td>
<td>Maximum 6 characters (e.g., STU).</td>
</tr>
<tr>
<td>Channel ID</td>
<td>Maximum 6 characters (e.g., LPZ).</td>
</tr>
<tr>
<td>Instrument Type</td>
<td>Maximum 8 characters (e.g., WWSSN).</td>
</tr>
<tr>
<td>Coordinates</td>
<td>Entered as X, Y, Z triplet plus coordinate system type code:</td>
</tr>
<tr>
<td></td>
<td>0 = degrees/degrees/km</td>
</tr>
<tr>
<td></td>
<td>1 = km/km/km</td>
</tr>
<tr>
<td></td>
<td>2 = m/m/m</td>
</tr>
</tbody>
</table>
8.3.2 Event

Event-related header entries which can be accessed are listed in Table 8-11.

**Table 8-11. Event-related Header Entries.**

<table>
<thead>
<tr>
<th>Header Entry</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Origin Time</td>
<td>The pattern is: “year month day hour minute second”, separated by blanks.</td>
</tr>
<tr>
<td>Azimuth, Back-Azimuth</td>
<td>Azimuth is defined as the angle measured between the vector pointing from the source to the station and the vector pointing from the source to the north. Back-azimuth is defined as the angle measured between the vector pointing from the station to the source and the vector pointing from the station to the north. Can also be calculated from the event and station coordinates (see “Recalculate Parameters” option below).</td>
</tr>
<tr>
<td>Epi-, Hypo Distance</td>
<td>Epicentral and hypocentral distances (km). Can also be calculated from the event and station coordinates (see “Recalculate Parameters” option below).</td>
</tr>
<tr>
<td>Coordinates</td>
<td>Entered as X, Y, Z triplet, separated by blanks, plus coordinate system type code: 0 = degrees/degrees/km 1 = km/km/km 2 = m/m/m Event depth must be entered as a negative number.</td>
</tr>
<tr>
<td>Magnitude</td>
<td>Enter values for local magnitude (ML), body wave magnitude (Mb), and surface wave magnitude (MS) separated by blanks.</td>
</tr>
<tr>
<td>Recalculate Parameters</td>
<td>After event coordinates are entered, use this option to calculate azimuth, back azimuth, epicentral and hypocentral distances and make the corresponding header entries automatically for the selected list of channels.</td>
</tr>
<tr>
<td>Coordinates correction</td>
<td>Recalculates event coordinates according to a given reference point and azimuth.</td>
</tr>
</tbody>
</table>

8.3.3 Record

This group of entries contains the time of the first sample and the sampling rate (in Hz), which are entered together. Time entries in PITSA have to be entered as year, month, day, hour, minute, second, separated by blanks.

8.3.4 Plot

This selection gives the user access to trace header parameters that effect the way traces are plotted on the screen. The menu options are summarized in Table 8-12.
Table 8-12. Plot-related Header Entries.

<table>
<thead>
<tr>
<th>Menu Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Viewport</td>
<td>Define plotting margins in user units. Parameters $xmin$ and $xmax$ define minimum and maximum value for horizontal axis (normally time), while $ymin$ and $ymax$ define minimum and maximum values for vertical axis (normally amplitude). Setting viewport manually turns off autoscaling and forces all traces to be plotted at same scale. Enter values for $xmin$, $xmax$, $ymin$ and $ymax$ separated by blanks.</td>
</tr>
<tr>
<td>Bottom Label</td>
<td>Label for bottom of entire plotting area. Only the bottom label stored in the header of the first trace on the screen will be displayed.</td>
</tr>
<tr>
<td>Top Label</td>
<td>Label for top of entire plotting area. Only the top label stored in the header of the first trace on the screen will be displayed.</td>
</tr>
<tr>
<td>X Axis</td>
<td>x-axis label (e.g., TIME) plotted at the bottom of each trace.</td>
</tr>
<tr>
<td>Y Axis</td>
<td>y-axis label (e.g., VEL N) plotted at the left side of each trace</td>
</tr>
</tbody>
</table>

8.3.5 Output

Some of the header information, such as phase picks and magnitudes, can be written out to a plain ASCII file for documentation and/or further processing. After entering the name of the output file, you will be prompted for a comment line which will be the first line of the output file (see example below). The remaining lines will contain the magnitudes, station coordinates, and all the picked phases for each of the selected channels:

```
comment: It's a sad but beautiful world
magnitudes sta: FA Z ML: 0 MB: 0 MS: 0
sta chan sta x sta y sta z coord phase id
yr mo dy hr sec
FA Z 12.2250 49.8610 0.4650 DGDGKM EPU2 90
11 17 18 18 15.088
FA Z 12.2250 49.8610 0.4650 DGDGKM ESD0 90
11 17 18 18 20.592
```

8.4 Phase Utilities

The tools available under the Utilities -> Phase Utilities menu are used for specialized analysis of seismic phase.

8.4.1 Mark slowness window at receivers

This option enables the user to calculate artificial phase picks for the selected traces marking the begin and end time of a particular slowness window. In addition to the channel list to be processed the user has to enter the following parameters:

- Index of reference channel
- Reference phase ID. The corresponding phase has to exist on the reference channel.
- Delay time between the reference phase and the first phase marking the slowness.
• Time duration of the slowness window.
• Phase IDs for the begin and the end of the slowness window.
• Back azimuth (degrees) and slowness (seconds/degree) for the calculation of the time delays for each trace.

For each trace two artificial phase separated in time by the time duration of the slowness window are calculated and entered into the trace headers. On the reference trace the phase marking the begin of the slowness window will appear at the selected delay time. The reference phase must be defined on the reference channel while on the other channels it is optional.

8.4.2 Align phases for receiver slowness

Traces with a particular phase defined (e.g. P) can be rearranged such that the selected phase appears under a particular slowness at the receivers. This can be desirable for example to correct for site effects on the slowness properties. In addition to the trace list, the user has to enter the following parameters:

• Index of reference channel.
• Reference phase ID. The corresponding phase has to exist on all traces to be processed.
• Number of pre-phase samples. The resulting traces will be cut such that the selected number of pre-phase samples is present on the reference channel.
• Back azimuth (degrees) and slowness (seconds/degree) for the calculation of the time delays for each trace.
• Equalize traces to n samples (negative to ignore). In case a positive number is given, the resulting trace lengths are adjusted to an overall trace length of n samples.

8.4.3 Cut phase windows

For the selected traces, this option sets all amplitude values to zero which do not fall within the time window defined by the two selected phase IDs.

8.4.4 Relative onset time determination

This tool is used for determining high precision relative onset times according to the multiplet analysis introduced by Poupinet et al. (1984) and Scherbaum and Wendler (1986). While using this technique two basic assumptions are made. We are dealing with a cluster of events, and the velocity structure of the source region is constant in a volume containing all events of that cluster. According to the definition of an earthquake cluster, the waveforms of different events are coherent at a given receiver station. PITSA will calculate phase shifts of the slave event which are accurate down to sub-sample timing errors if certain thresholds of the waveform coherence and the cross spectral amplitude are exceeded.

After input the trace list of one station for different events and selecting the reference trace containing the master event, PITSA prompts for the phase ID used for the calculations. Now you are asked to input a time window for the different steps of computation (Figure 8-13).
First, PITSA prompts for the time window used for the computation of the cross correlation. In addition the user has to specify also the window used for computing the cross and coherence spectrum, respectively. For estimating a meaningful coherence spectrum, you have to input the half frequency window size which is used for averaging the coherence values (Figure 8-14).

Now PITSA prompts for two thresholds. You are asked to input the threshold for the normalized cross spectrum (*weighting factor*). Then PITSA prompts for the threshold for the coherence. In order to get a timing accuracy smaller than a sample, a linear regression of the cross phase spectrum is performed only in the signal part exceeding this two thresholds. The result is shown in Figure 8-15.
Figure 8-15. Result of relative onset time determination. The upper panel shows the coherence spectrum, the cross spectrum and the threshold (weighting factor) for the cross spectrum. In the lower panel the cross spectral phase and the linear regression line and error bounds are shown. In the note popup the estimated time shift is displayed.

In the upper panel of the PITSA screen appears the computed coherence spectrum, the cross spectrum and the threshold for the cross spectrum. In the lower panel the cross spectral phase and the result of the linear regression as well as the error regions are shown as blue and black line, respectively. The regression algorithm assumes zero shift at zero frequency. If the computed phase shift is abnormal or the bandwidth of the valid frequency band is too small, you can use the time estimation by accepting Cross correlation. In order to change the settings used for the computation, you can select Yes in the Change Parameters and recalculate popup menu. Finally PITSA includes a new phase ID labeled as PX to the preexisting phase list (Figure 8-16).
Figure 8-16. Phase entries labeled PX are added to the phase list of the slave event.

The relative onset time of the “slave events” according to the master is simply:

\[ \Delta t_{MS} = t_{\text{Master}} - t_{PX} \]

Where \( t_{\text{Master}} \) is the onset time of the master event, \( t_{PX} \) the onset time of the just computed Phase PX and \( \Delta t_{MS} \) the relative onset time of the slave event according to the master event.

8.5 Resampling

The tools under the Utilities -> Resampling menu are used for demonstrating the effects which can occur during sampling and A/D conversion of seismic signals—they are primarily used for teaching. For example, an input signal (e.g., a test signal with well known properties) can be re-discretized (setting the values between every n-th sample to zero) to demonstrate the effects of analog to digital conversion. In addition, the effects of digital to analog conversion can be demonstrated on re-discretized signals using Whittaker's reconstruction technique. You can also simulate the effects of downsampling (keeping only every n-th value) an input signal of comparatively high dynamic range using a gain-ranging A/D converter or downsample at full floating point precision. Many examples of the use of these tools are contained in the book, *Short Course on First Principles of Digital Signal Processing for Seismologists* by Frank Scherbaum (1993).

There are five options under the Utilities -> Resampling menu:

- Simulate discretization in time
- Reconstruction of discretized signals
8.5.1 Simulate discretization in time

All trace data in PITSA are already discretized. Using this tool, however, the input trace is treated as a pseudo-continuous trace from which discrete samples are taken every 1/f_{DIS} samples, where f_{DIS} is the discretization frequency. PITSA prompts for the discretization frequency (f_{DIS}) in Hz. The resulting trace keeps the original sampling rate, but trace values are set to zero at points between the “resampled” points. For this option to work properly, the specified discretization frequency f_{DIS} must be smaller than the real digitization frequency f_{DIG}.

In the top trace of the display for this tool, the discretized signal is superimposed on top of the original trace while in the bottom trace it is displayed alone. It can be kept for later processing, e.g., for demonstrating pseudo D/A conversion using Whittaker reconstruction.

Figure 8-17 demonstrates the discretization of a sinusoidal signal of 6.5 Hz with a discretization frequency of 10 Hz, a nice demonstration of aliasing.

**Figure 8-17.** Discretization of a 6.5 Hz sinusoid with f_{DIS} = 10 Hz. The original sampling frequency was 100 Hz.
8.5.2 Reconstruction of discretized signals

A method called “Whittaker reconstruction” is used in this tool to simulate the process of digital to analog conversion for traces which have been obtained by using the re-discretization tool described in Section 8.5.1. It uses a simple time-domain lowpass filter technique.

PITSA will prompt for the frequency used for the re-discretization (in Hz). This is not the actual digitization frequency! See Section 8.5.1 for the differences.

The top panel of the display will contain the reconstructed signal, superimposed on top of the corresponding discretized trace. The lower panel shows the reconstructed signal by itself (Figure 8-18).

Figure 8-18. The result of a Whittaker reconstruction. In the upper trace, the original discretized trace and the reconstructed trace are displayed together while in the lower trace, only the reconstructed trace is displayed.

Figure 8-19 shows the display after the reconstructed trace in Figure 8-18 was appended to the traces in memory.
8.5.3 Integer decimation

Integer decimation allows the selection of every n-th value in the input trace (starting with the first one). The user has to provide the decimation ratio as an integer value. E.g. giving an input value of 2 will result in an output trace containing the first, third, fifth, and so forth values of the input trace.

8.5.4 Resampling of interpolation polynomial (4-deg)

In contrast to the simulation of discretization discussed in Section 8.5.2, where all the samples between the discretization interval were set to zero but kept in the trace, the Resampling... tool described in this section actually downsamples the input trace to a new digitization frequency. Hence, the number of samples within the new trace will be smaller by a factor of \( f_{\text{DIG, NEW}} / f_{\text{DIG, OLD}} \) in comparison to the input trace. Here, \( f_{\text{DIG, NEW}} \) and \( f_{\text{DIG, OLD}} \) denote the original digitization frequency of the input trace and the resampling digitization frequency, respectively.

PITSA will prompt for the new digitization frequency in Hz (the original digitization frequency will be displayed in the text input window). The resulting trace will contain samples at time intervals taken from the input trace at time intervals \( 1/ f_{\text{DIG, NEW}} \). The new data values are interpolated from the neighboring points of the original data series using a 4th degree polynomial.

Figure 8-20 shows an example of a digitally resampled trace versus a discretized trace.
8.5.5 Simulate A/D Converter

The option Utilities -> Resampling -> Simulate A/D Converter simulates the behavior of a gain-ranging A/D converter (ADC). It is a simulation because we cannot use a true analog signal for input. Instead we use the method discussed in Section 8.5.1 to create our input signal.

Gain-ranging ADCs were common in seismology in the days before high-performance ADCs with up to 24 bit resolution, but they can still be found in use and it is useful to understand their deficiencies. The gain-ranging ADC consists of a fixed-gain pre-amplifier, a programmable gain-ranging amplifier (PGA) with a variable number of gain states, and a plain ADC for which the resolution and the least significant bit values can be assigned. The pre-amplifier is used to attenuate the input signal so that it does not exceed the limited scale range of the plain ADC.

For the ADC simulation, the user has the choice of four output signals, listed in Table 8-13.

Table 8-13. Output Signal Types for ADC Simulation.

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quantized Value</td>
<td>Actual output signal from the gain-ranging ADC.</td>
</tr>
<tr>
<td>Mantissa</td>
<td>Output of the plain ADC.</td>
</tr>
<tr>
<td>Exponent (-gain)</td>
<td>Gain setting of the PGA</td>
</tr>
<tr>
<td>Error Signal</td>
<td>Difference between the quantized value and the input trace.</td>
</tr>
</tbody>
</table>

If gain ranging is turned on, the actual output signal is combined from the output of the plain ADC (“mantissa”) and the gain setting (“exponent”) of the programmable
gain amplifier (PGA). In this case, the internal representation is similar to a scientific (mantissa, exponent) notation.

For the simulation of a gain-ranging ADC, you should start with a test signal generated at a very high sampling rate (e.g., 1000 Hz) which will treated as an “analog” signal. The sampling of this signal is simulated by a simple down-sampling process which uses only linear interpolation (unlike the tool in Section 8.5.4)—but it’s OK because the original sampling rate is so high. To begin the simulation PITSA prompts for the digitization frequency (Hz) of our hypothetical recording system. A frequency of 20-80 Hz might be appropriate. Before discussing the other input parameters which are needed to describe the behavior of the gain-ranging ADC, it is helpful to understand how gain-ranging works.

8.5.5.1 How Gain-Ranging Works

The incoming sample is first multiplied by the scaling factor of the fixed-gain pre-amplifier. Next it is verified that the signal will fit within the lowermost 25% scaling range of the plain ADC. If it does not, the PGA takes over and attenuates the sample amplitude in steps of 2 until it is small enough to meet this condition. At the same time, the gain state (which is a number between 0 and the maximum number of gain states possible - 1) of the PGA is stored. A difference of 1 in gain states corresponds to a factor of 2 in attenuation.

Next, the actual analog to digital conversion, simulating an n-bit ADC, is done. It consists of rounding the output value of the PGA to the next lowest value an ADC could represent with the given value for the least significant bit (LSB) and the given resolution. Given n bits of resolution and a value for LSB, $2^n$ values ($0 \times \text{LSB} - [2^n - 1] \times \text{LSB}$) can be represented before saturation occurs. The quantized value is finally calculated by multiplying the output value of the plain ADC by $2^{\text{gain}}$, with gain being the gain state of the PGA.

8.5.5.2 Input Parameters

After the digitization frequency for resampling has been entered, PITSA will prompt for the additional parameters for the gain-ranging ADC.

Table 8-14. Parameters for a Gain-Ranging ADC.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pre-amplifier gain</td>
<td>Scaling factor (e.g., 1.0) which simulates a fixed gain pre-amplifier.</td>
</tr>
<tr>
<td>Resolution</td>
<td>Number of bits (e.g., 12) for the plain ADC.</td>
</tr>
<tr>
<td>LSB value</td>
<td>Value of least significant bit (e.g., 0.1).</td>
</tr>
<tr>
<td>Number of PGA gain states</td>
<td>How many times (e.g., 10) the PGA can decrease the amplitude of the input signal for the plain ADC.</td>
</tr>
</tbody>
</table>

During the conversion, PITSA will display a note window with the actual values for the current index, input value, output value, gain state, mantissa, and the error signal.
Figure 8-21 shows an example for the simulation of the mantissa and gain output of a gain ranging A/D converter operating on a cosine bell.

Figure 8-21. Gain ranging A/D converter on a cosine bell. The top trace shows an input signal while the middle and bottom traces simulate the mantissa and gain function of a 12 bit gain ranging A/D converter with 11 PGA gain states.
The tools under the Special Plots menu are used for specialized displays in various kinds of seismological analysis. These tools are summarized in Table 9-1.

Table 9-1. Special Plots menu items.

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Epi-Distance Plot</td>
<td>Plot seismic traces as a function of epicentral distance.</td>
</tr>
<tr>
<td>Hypo-Distance Plot</td>
<td>Plot seismic traces as a function of hypocentral distance.</td>
</tr>
<tr>
<td>Receiver Array Vespagram</td>
<td>Calculates and plots vespagram (Davies et. al., 1971).</td>
</tr>
<tr>
<td>Receiver Array Slowness Power Spectrum</td>
<td>Calculates and plots the slowness power spectrum of a receiver beam regarding to the delay and sum technique.</td>
</tr>
<tr>
<td>Superimpose Traces</td>
<td>Plot two or more seismic traces with equal sampling rate and length together in one box.</td>
</tr>
</tbody>
</table>

9.1 Epi-Distance Plot

This option is used to plot seismic traces in order of increasing epicentral distance. Epicentral distances must be set correctly within the data headers of the traces to be used.

PITSA will prompt for the plotting method (Figure 9-1). The Distance vs. Zero Line option will place the imaginary zero line of each trace at the corresponding distance while Distance vs. First Point will place the first point of the data trace at the corresponding distance.
Figure 9-1. Plotting methods pop-up menu.

Next PITSA will ask for the scaling method (Figure 9-2). The user can select either select Rescale all Traces Together to plot all traces at the same scale or select Keep Current Scale.

Figure 9-2. Scaling methods pop-up menu.

Finally, the user will be asked to enter a value for the width of the plotting window going to be reserved for each trace. PITSA expects this value to be given in percent of the total window width. Figure 9-3 shows an example if an epicentral distance plot.

Figure 9-3. Special Plots -> Epi Distance Plot. Files were scaled together and plotted vs. the zero line. The width of traces is 5%. These data are from aftershock recordings of the Chalfant Valley earthquake of 1986 (Lutziano, 1988) which is in the ISAM file system isam11 in the demodata directory.
After PITSA displays the plot, a menu will appear (Figure 9-3) with two options. Selecting either of these options will bring PITSA back to the top level.

9.2 Hypo-Distance Plot

This plotting option is used to plot seismic traces in order of hypocentral distance. It works exactly as the Epi-Distance option described above. Hypocentral distances must be set correctly in the data headers for this option to be used.

9.3 Receiver Array Vespagram

Vespagram analysis (Davies et al., 1971) is a simple but powerful technique to identify individual phases based on their slowness properties. In a nutshell, a vespagram is a set of array beams (here receiver array beams) formed for different slowness values and a fixed azimuth. To improve its performance it is implemented here in conjunction with the Nth root technique proposed by Muirhead and Datt (1976).

The user must provide the input for the following parameters:

- Channel list for the traces to be used.
- Index of reference channel. The time scale of the reference channel will remain unshifted. Depending on the slowness and back-azimuth, during beam forming, all other traces will be shifted with respect to the selected reference channel.
- Slowness range and slowness increment to be used for the beam forming. The sequence of input values is: smallest slowness value, largest slowness value, slowness value increment. All slowness values in sec/deg.
- Parameter N for Nth root processing.

Subsequently, the user will be asked to enter a value for the width of the plotting window going to be reserved for each trace. PITSA expects this value to be given in percent of the total window width. Finally the user has to indicate if the traces should all be scaled to the same maximum amplitude value (normalized) before the beam forming. Finally, the user will be asked to enter a value for the width of the plotting window going to be reserved for each trace. PITSA expects this value to be given in percent of the total window width. Figure 9-3 shows an example if an epicentral distance plot. An example for a vespagram plot is shown in Figure 9-4.
9.4 Receiver Array Slowness Power Spectrum

**Warning:** this tool is for advanced users only who are familiar with the principles of an array of receivers and digital beamforming techniques! Computing the slowness power spectrum is only useful if all station coordinates are known and included in the data header. No correction to station elevation is made while computing the beam power and the plane wave assumption must be valid for the data.

This option is used to perform a delay and sum beamforming of a set of traces using the simple formula:

\[ b(t) = s_{\text{ref}}(t) + \sum_{i=1}^{N-1} s_i(t + r_i \hat{\theta}) \]

Where \( b(t) \) is the beam trace, \( s_{\text{ref}}(t) \) represents the reference seismogram, \( s_i \) are the time shifted traces of the remaining array stations, \( r_i \) are the distances of the array stations regarding to the reference station, \( N \) is the total number of stations and \( \hat{\theta} \) the horizontal slowness which is used to estimate the time shifts regarding to the reference station.

The beam power is computed by simply summing up the resulting beam trace per input time window and normalize it with respect to the number of array stations. Regarding to a grid search of different horizontal slowness values the result is plotted as a density map and the maximum slowness vector as well as the backazimuth of the beam are displayed.
After entering the channel list of array stations, the user is asked to input the reference channel. This action is equivalent to announce the reference station. Now the slowness grid in East-West and North-South direction must be specified. You are forced to input minimum, maximum and step size of the slowness grid in sec/deg (Figure 9-5).

**Figure 9-5. Input panel for the slowness grid used for the delay and sum beamforming**

Next PITSA will prompt for nth root processing the beamtrace according to the work of Muirhead and Datt (1976). The user can select either $n = 1$ (*unchanged*) up to $n = 4$ (Figure 9-6). This feature is useful to enhance small coherent signals in a seismogram with a strong and dominant signal (e.g. PcP and P phases in teleseismic signals).

**Figure 9-6. nth root processing popup menu**

PITSA will output two ASCII files containing the slowness power values for the total slowness grid as well as the position of the maximum value and the backazimuth. The user has to specify the first file name in the input panel appearing next. The latter file name is formed automatically by adding the extension `.max`.

PITSA will prompt now for *Normalize traces before beamforming*. Answering *y* (yes) will normalize all traces according to 1.0.

Before the resulting beam power distribution is displayed, the user can specify the minimum and maximum value for scaling (Figure 9-7). The beam power is plotted as density map either in a color or an gray scale plot according to the `COLOR_MODE` entry in the `pitsa.cfg` file (Figure 9-8).
Figure 9-7. Input for scaling the result of slowness power spectrum

![Image of input screen]

Figure 9-8. Slowness power spectrum with respect to the given horizontal slowness grid. Also the Rescale popup menu is visible.

![Image of slowness power spectrum]

The Rescale popup menu enables you to change the minimum - maximum values for the beam power plot. If you are choosing Back to Main Menu and the COLOR_MODE in the pitsa.cfg file is set to COLOR_SCALE, PITSA will prompt next for superimpose array response. Here the user can either type y (yes) or n (no). The array response is calculated regarding to the horizontal slowness of maximum beam power. The reference trace is duplicated to the number of array stations. For each individual station the time delay of the location of the maximum beam power is computed and the traces are successively shifted. Using this synthetic seismograms the beam power distribution for the used slowness grid is computed. The result is overlaid as brightness of colors on the original beam power distribution (Figure 9-9).
9.5 Superimpose Traces

This plotting option can be used to compare two or more seismic traces. First the user will be asked for a channel list of traces to be plotted together in one box. After specifying the channel list, the user is asked to specify one trace to be plotted with drawing color 2 (see Table 4-1). The popup menu for specifying the trace is shown in (Figure 9-11).
The plotting option can only be performed on traces with equal length and equal sampling rate. However, spectra can also be plotted together in one box, if they have equal frequency resolution $\delta \omega$. As an example Figure 9-12 shows two noisy synthetic Ricker wavelets with different frequency content in one box and in Figure 9-13 the resulting amplitude spectra of these wavelets are plotted together.

**Figure 9-11.** Popup menu for specifying the colored trace

![Popup menu for specifying the colored trace]

**Figure 9-12.** Two seismic traces plotted in one box with ‘superimpose traces’.

![Two seismic traces plotted in one box with ‘superimpose traces’]
Figure 9-13. Superimposing amplitude spectra in one box.
APPENDIX A

References


Banfill, R., Description of SUDS format (exact title not known yet), 1992.


Scherbaum, F., Combined inversion for the three-dimensional Q structure and source parameters using microearthquake spectra, J. Geophys. Res., 95, 12,423-12,438, 1990.


Scherbaum, F., and J. Wendler, Cross spectral analysis of Swabian Jura (SW Germany) three-component microearthquake recordings, J. Geophys., 60, 157-166, 1986.


APPENDIX B

The PITSA Configuration File

When PITSA is first started, it will look at the environment variable PITSA_CONFIG_PATH_ENV and use this as the path to find a special configuration file named pitsa.cfg. If the environment variable is not set, then PITSA will look in the directory where it was started for the configuration file.

The configuration file is a plain ASCII file that the user can edit to set preferences. Each entry in the file consists of two lines. The first line is the name of the parameter that is to be set and the second line is the value that it is being set to. Here is an example pitsa.cfg file:

```
SET_FOCUS
true
SET_FOCUS_LOOP
100
KILL_NOTE
false
MENU_POST
<Btn3Up>
MENU_SLCT
<Btn1Up>
TEXT_MARG
4
CANVAS_WIDTH
900
CANVAS_HEIGHT
550
DRAW_1_COLOR
black
DRAW_2_COLOR
red
BACKGROUND_COLOR
white
COLOR_MODE
COLOR_SCALE
MAX_NOCH
30
MAX_TRLEN
8000000
```
The parameters that can be set in the configuration file are as follows. The possible values for the parameter are shown in parenthesis after the parameter name.

**B.1 General Parameters:**

**B.1.1 BACKGROUND_COLOR**

(black, red, yellow, white or any valid X color)

This is the color that the PITSA window will use as the background color.

**B.1.2 CANVAS_HEIGHT**

(integer number 0-5000)

This is the height the PITSA window will have in units of pixels.

**B.1.3 CANVAS_WIDTH**

(integer number 0-5000)

This is the width the PITSA window will have in units of pixels.

**B.1.4 DRAW_1_COLOR**

(black, red, yellow, white or any valid X color)

This is the color that PITSA will use for drawing the main graphics and traces.

**B.1.5 DRAW_2_COLOR**

(black, red, yellow, white or any valid X color)
This is the color that PITSA will use for drawing highlighted graphics.

**B.1.6 COLOR_MODE**
(COLOR_SCALE, GRAY_SCALE)
This parameter controls whether the output of some routines is drawn in color or in grayscale (default). When setting to color mode the output is restricted to 156 colors only.

**B.1.7 KILL_NOTE**
(true or false)
This parameter controls whether the note window (the window that pops up during zooming, for example) is completely destroyed or just popped down. This value is normally false because it is faster to pop up and down the note window rather than destroy and re-create the note window each time it is needed. However, on some systems the note tends to pop up at unpredictable positions if it is just popped down. If this is happening and undesirable, then this value should be set to true.

**B.1.8 MAX_NOCH**
(integer number 10 or greater)
This is the maximum number of channels that PITSA will allow to be loaded at once. This can be set as high as desired.

**B.1.9 MAX_TRLEN**
(integer number 100 or greater)
This is the maximum number of points that PTISA will allow in a single trace. This can be set as high as desired.

**B.1.10 MENU_POST**
(<Btn1Down>, <Btn2Down> or <Btn3Down>)
This controls which mouse button will cause the main menu to be posted (popped up on the screen). This is normally set to <Btn2Down>, which means that pressing the second (or middle) mouse button will pop up the main menu.

**B.1.11 MENU_SLCT**
(<Btn1Down>, <Btn1Up>, <Btn2Down>, <Btn2Up>, <Btn2Down> or <Btn2UP>)
This controls which mouse button will cause a menu item to be selected. Normally MENU_POST is set to <Btn2Down> and MENU_SLCT is set to <Btn1Down>. This way, clicking the middle mouse button causes the main menu to popup. The user can then take their finger off of the mouse button and move the mouse pointer through the menu tree. Then, when the desired menu item is located, the user can
press the left menu button to make the section. Another popular configuration is to have the menu post when the left mouse button is pressed and the menu selection made when the left mouse button is released. This requires that the user keep the mouse button pressed while moving through the menu tree. To set up this configuration, MENU_POST would be set to `<Btn1Down>` and MENU_SLCT would be set to `<Btn1Up>`.

B.1.12 SET_FOCUS

(true or false)

This parameter tells PITSA whether or not it should try and set the keyboard focus on the text input window after it is popped up. On some systems, PITSA crashes intermittently when this is set to true. When PITSA is running on a SUN4 under OpenWindows, there is no problem and this value should be set to true.

B.1.13 SET_FOCUS_LOOP

(integer number 0-1000)

When PITSA is setting the focus on the text input window (meaning that key strokes will go to the text input window), it sometimes misses the window (the window appears after the focus is set). This value tells PITSA how long it should wait before trying to set the focus. Typically, a value of 100 works well. The larger the number, the longer PITSA will wait before setting the focus.

B.1.14 TEXT_MARG

(integer number 0-10)

This value determines how much space in pixels is allocated between text and box edges. On some systems fonts can act a little differently and not fit in the menu and text windows correctly. If the text looks crowded or if there is too much space between the text and box edges, this value can be adjusted. Normally this value is 4.

B.1.15 PICK_ADJ_WINDOW

(integer number)

This value determines the default width of the zooming box (in pixels) which is used for editing phase picks.

B.2 Automatic Phase Picker Configuration

Parameters:

B.2.1 P_DUR

(floating point value)
The maximum P wave amplitude is evaluated within a time window of \( P_{\text{DUR}} \) seconds following the determined P phase onset. 5.0 is the default value.

**B.2.2 PRESETDUR**

(floating point value)

\( S(t) \), the variance of \( SF(t) \), is evaluated within the first \( \text{PRESETDUR} \) seconds of the trace. It will, however, be updated as long as \( CF(t) \) stays below \( \text{THRESHL2} \) and the current time is less than \( 2 \times \text{PRESETDUR} \). 0.5 is the default value.

**B.2.3 TDOWNMAX**

(floating point value)

\( CF(t) \) may drop below \( \text{THRESHL1} \) for less than \( \text{TDOWNMAX} \) seconds without causing the pick flag to be cleared. 0.1 is the default value.

**B.2.4 TUPEVENT**

(floating point value)

\( CF(t) \) has to stay above \( \text{THRESHL1} \) for at least \( \text{TUPEVENT} \) seconds for the pick to be accepted.

**B.2.5 THRSHL1, THRSHL2**

(floating point number)

These values determine the evaluation thresholds for \( CF(t) \) and corresponds to the parameters \( S1 \) and \( S2 \) in Baer and Kradolfer (1987). 10.0 and 20.0 are the default values.

**B.3 Configuration Parameters for GSE writing**

**B.3.1 GSE_1OR2**

(GSE1, GSE2)

The valid entries for GSE_1OR2 are GSE1 or GSE2, indicating which main format of GSE is used for file writing.

**B.3.2 GSE_FORM**

(CMP6, INTV)

The entry GSE_FORM keeps the desired subformat for writing GSE datafiles and can be one of CMP6 or INTV for both GSE1 and GSE2. For the GSE2 main file format CMP6 is changed to CM6, and INTV to INT internally.
B.3.3 GSE_NDIFF

(integer value 0, 1, 2)

This entry has only effect when writing GSE1 datafiles in CMP6 subformat. It is an integer value 0, 1, or 2 and gives the number of differences that will be used for writing.

B.3.4 GSE_RESOL

(integer value 16, 32)

The entry GSE_RESOL specifies the resolution in bit which is used for converting float values into long value representation, which will be used when writing GSE datafiles. A typical value would be 16. The internal float values in a trace are divided by the value \((\text{maxamp}\text{–}\text{minamp}) / (2^{\text{GSE\_RESOL}})\) to get long values that can be written to a GSE datafile. As you can see this value is data dependent and for a low dynamic range in the data, the value will be very small. As a result please keep in mind, that under unfavorable circumstances an information loss can occur. This is due to the limited accuracy when writing this value to the appropriate entry in the GSE header!
When the Hardcopy Mode is turned on in PITSA, the program will look in the directory defined by the environment variable \texttt{PITSA\_PRINTDEF\_PATH\_ENV} for the file defined by \texttt{PITSA\_PRINTDEF\_NAME\_ENV} to use for the printer definition file. The user will then be prompted for the printer definition file to use with the \texttt{PITSA\_PRINTDEF\_NAME\_ENV} file name as the default.

The printer definition file tells PITSA how to generate output. The standard definition file that comes with PITSA is named \texttt{8X11\_landscape.PS} and gives definitions for printing to PostScript printer on 8.5” by 11” paper in landscape mode. If the user desires to send output to another plotting device, such as a pen plotter, a definition file will have to be created. Below is the file \texttt{8X11\_landscape.PS} with explanations of what each parameter controls:

\subsection*{C.1 Printer Configuration Parameters}

\subsubsection*{C.1.1 \#UPPER\_LEFT\_CORNER}

\begin{verbatim}
36,72
\end{verbatim}

This is the location of the upper left corner of the output in device units.

\subsubsection*{C.1.2 \#UPPER\_RIGHT\_CORNER}

\begin{verbatim}
36,792
\end{verbatim}

This is the location of the upper right corner of the output in device units.

\subsubsection*{C.1.3 \#LOWER\_LEFT\_CORNER}

\begin{verbatim}
576,72
\end{verbatim}

This is the location of the lower left corner of the output in device units. With these three parameters, the output can be placed at any location on the output device.
C.1.4 #PLOT_HEAD

```
%!\n/m {moveto} def
/l {lineto} def
0 setgray\n0.1 setlinewidth\n/Courier findfont
16 scalefont\nsetfont\nnewpath
```

This defines text that will be printed at the very start of the plot output. \n’s are expanded to carriage returns in the output file. This line is written out to the plot output file with the C command:

```
fprintf(fp_plotfile,PLOT_HEAD);
```

C.1.5 #PLOT_TAIL

```
stroke showpage\n```

This defines text that will be placed at the very end of the plot output file. Again, \n’s will be expanded to carriage returns. The line is written out to the plot output file with the C command:

```
fprintf(fp_plotfile,PLOT_HEAD);
```

C.1.6 #PLOT_MOVETO

```
%5.1f %5.1f m\n```

This is the format specifier that will be used to write out moveto commands. A moveto command instructs the output device to lift the pen and move it to the x y coordinates specified. The moveto command is sent to the plot output file with the C command:

```
fprintf(fp_plotfile,PLOT_MOVETO,x,y);
```

C.1.7 #PLOT_LINETO

```
%5.1f %5.1f l\n```

This is the format specifier that will be used to write out lineto commands. A lineto command instructs the output device to move the pen (while down) to the x y coordinates specified. The lineto command is sent to the plot output file with the C command:

```
fprintf(fp_plotfile,PLOT_LINETO,x,y);
```

C.1.8 #PLOT_STROKE

```
stroke newpath\n```

This is the format specifier that will be used when a stroke command is sent the output file. A stroke command instructs the plotting device to actually put ink on the paper for the pen path described by moveto and lineto commands. Some plotting devices will put ink on the paper while the path is being defined and this command is not needed (i.e. real plotters). The C command is:
fprintf(fp_plotfile,PLOT_STROKE);

C.1.9 #PLOT_MAX_LINE
1000

This value determines the maximum number of lineto commands allowed before a stroke command is given.

C.1.10 #PLOT_START_AXIS
stroke newpath 1 setlinewidth

This defines the text that will be sent to the plot output file just before plotting of the axis is started. This allows special values to be set such as line thickness or color that will only be used for the plotting of the axis. The C command is:

fprintf(fp_plotfile,PLOT_START_AXIS);

C.1.11 #PLOT_END_AXIS
stroke 0.1 setlinewidth newpath\n
This defines the text that will be sent to the plot output after plotting of the axis is ended so that any special effects installed by PLOT_START_AXIS can be turned off.

C.1.12 #PLOT_START_CHAR
stroke newpath 0.2 setlinewidth\n
This defines text that will be sent to the plot output file before character data is sent to the plot output file. Character data is only sent to the output file when a screen capture is made will the note is on the screen. The C command is:

fprintf(fp_plotfile,PLOT_START_CHAR);

C.1.13 #PLOT_END_CHAR
stroke 0.1 setlinewidth newpath\n
This defines text that will be sent to the plot output after character data has been sent to the output file. The C command is:

fprintf(fp_plotfile,PLOT_END_CHAR);

C.1.14 #PLOT_START_STRING
gsave\ncurrentpoint translate\n90 rotate\n(

This defines the text that will be sent to the plot output file just before a character string to be plotted is sent out. The C command is:

fprintf(fp_plotfile,PLOT_START_STRING);

C.1.15 #PLOT_END_STRING
)show\ngrestore\n
This defines the text that will be sent to the plot output file just after a character string is sent to the plot output file. The C command is:

```c
fprintf(fp_plotfile,PLOT_END_STRING);
```

C.1.16 #PLOT_STRING_HEIGHT_X
18
This defines the height in plotter units that character strings will have in the X direction.

C.1.17 #PLOT_STRING_HEIGHT_Y
0
This defines the height in plotter units that character strings will have in the Y direction.

C.1.18 #PLOT_COMMENT_START
%
Text to send to the plot output file at the start of a comment.

C.1.19 #PLOT_COMMENT_END
\n
Text to send to the plot output file at the end of a comment.

C.1.20 #PLOT_COLOR1
Text to send to the plot output file to select drawing color 1.

C.1.21 #PLOT_COLOR2
Text to send to the plot output file to select drawing color 2.

C.1.22 #PLOT_OUTPUT_FILE_NAME
`plotout`
The name to use for the plot output file. The user will have the option of changing this file name.

C.1.23 #PLOT_PRINT_COMMAND
`cat %s %s %s | lpr -Pfastlw -h\n`
Format for the system command to issue to send an output file directly to the printer. The C command is:

```c
sprintf(command_str,PLOT_PRINT_COMMAND,temp1,temp2,temp3);
system(command_str);
```
C.1.24 #PLOT_RM_COMMAND

```
rm %s
```

Format for the system command to remove a file. The C command is:

```c
sprintf(command_str,PLOT_RM_COMMAND,file_name);
system(command_str);
```

C.1.25 #PLOT_CAT_COMMAND

```
cat %s %s %s > %s
```

Format for the system command to concatenate three files together to generate the final output file. The C command is:

```c
sprintf(command_str,PLOT_CAT_COMMAND,temp1,temp2,temp3,out_file);
system(command_str);
```
When the program mode is turned on, PITSA will store all commands to an output file. This command file will consist of a simple ASCII text file that can be edited by the user. Here is an example command file created by PTISA:

```
MAINMENU Retrieve_Files_Menu 0
GETSTRING datsun4
GETSTRING ;
SPECIAL Prog_Msg 0
ARROW 0.124444 0.314545 0.211111 0.201818
ARROW_END 0.0 0.0 0.0 0.0
A program message with an arrow.
ENDMSG
MAINMENU Integration_Type 2
GETSTRING ;
BOBMENU Accept/Append Traces
BOBMENU Use selection(s) for remaining traces
MAINMENU Setup_Menu 3
```

There are four different types of commands stored in these files. The first type is a main menu selection. Selections from the main menu are written out on one line starting with the key word `MAINMENU` followed by the name of the menu (with underscores replacing blanks) and the menu item selected where 0 is the first item in the menu panel. In the above example, the first command stored is from the main menu selection `Files/Traces -> Retrieve Files -> ISAM` as shown in Figure D-1.

**Figure D-1.** The main menu selection (`Files/Traces -> Retrieve Files -> ISAM`) that corresponds to the first line in the above example of a command file.
The second type of command stored is a pop-up menu selection. These selections are stored on one line starting with the key word BOBMENU followed by the name of the menu selection made. The third type is the user response to a text input window, which is written out as a single line starting with the keyword GETSTRING followed by the string the user entered.

Finally, PITSA also stores special actions such as pressing the <F5> key to pop up a message. For the menu message, several lines are written out. The first line is SPECIAL Prog_Msg 0. Next comes the location of any arrows. These lines start with the key word ARROW and have four numbers following them. The four number are the x, y start and end points of the arrow. The units for these numbers are fractions of the screen width and height so that if the window is resized, the arrows will appear in roughly the same location. Then comes the line that starts with the key word ARROW_END to indicate there are no more arrows. Then between this line and the line that starts with the key word ENDMSG the text for the message window appears.

With enough knowledge of the flow of PITSA, the user can fine tune command files without having to re-create them from scratch.
The GSE format for waveforms is an ascii file, consisting of a header section, a data section and an end mark and checksum value for verification purposes.

For GSE1.0 the header section consists of 2 lines and starts with keyword WID1, while for GSE2.x the header is only one line starting with keyword WID2. The header entries and their formatted (strict!) position in the appropriate lines are given in Table E-1 and Table E-2.

The data section start with the keyword DAT1 for GSE1.x and DAT2 for GSE2.x, respectively. According to the subformat specified in the header, the data is stored in 80 character long ascii lines for GSE1.x and in 132 character long ascii lines for GSE2.x. An example for each supported format is given in Figure E-1 to Figure E-4.

The end of the data section is indicated by the CHK1 or CHK2 label (GSE1.x / GSE2.x) followed by an long integer value containing the checksum as calculated by the GSE checksum algorithm.

The most detailed information about GSE format can be found online following the index link to GSE/CRP/243 at the Prototype International Data Center PIDC. the URL is: http://www.cmr.gov and is a online version of the Group of Scientific Experts (GSE) Third Technical Test (GSETT-3) Conference Room Paper 243 of 1995.
Table E-1. WID1 section of GSE1.x waveform files.

<table>
<thead>
<tr>
<th>Position</th>
<th>Name</th>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>LINE 1:</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1-4</td>
<td>&quot;WID1&quot;</td>
<td>a4</td>
<td>Must be &quot;WID1&quot;</td>
</tr>
<tr>
<td>6-13</td>
<td>segment start date</td>
<td>i8</td>
<td>yyyyddd e.g., “1984045”, year + day of year</td>
</tr>
<tr>
<td>15-16</td>
<td>start hours</td>
<td>i2</td>
<td>hh</td>
</tr>
<tr>
<td>18-19</td>
<td>start minutes</td>
<td>i2</td>
<td>mm</td>
</tr>
<tr>
<td>21-22</td>
<td>start seconds</td>
<td>i2</td>
<td>ss</td>
</tr>
<tr>
<td>24-26</td>
<td>start milliseconds</td>
<td>i3</td>
<td>nnn</td>
</tr>
<tr>
<td>28-35</td>
<td>number of samples</td>
<td>i8</td>
<td>nnnnnnn</td>
</tr>
<tr>
<td>37-42</td>
<td>station</td>
<td>a6</td>
<td>use ISC code</td>
</tr>
<tr>
<td>44-51</td>
<td>channel id</td>
<td>a8</td>
<td></td>
</tr>
<tr>
<td>53-54</td>
<td>channel</td>
<td>a2</td>
<td>e.g., sz, lz, ..., etc., null = &quot;,,&quot;</td>
</tr>
<tr>
<td>56-66</td>
<td>sample rate</td>
<td>f11.7</td>
<td>samples per second</td>
</tr>
<tr>
<td>68-73</td>
<td>system type</td>
<td>a6</td>
<td>e.g., SRO, GS-13, etc., null = &quot;,,&quot;</td>
</tr>
<tr>
<td>75-78</td>
<td>data format type</td>
<td>a4</td>
<td>“INTX”, “FLTX”, or “CMPZ” X is width of the data field or “V” for variable.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>“CMPZ” denotes compressed data utilizing Z bits per byte.</td>
</tr>
<tr>
<td>80</td>
<td>differencing flag</td>
<td>i1</td>
<td>0 or &quot;,&quot;, 1, 2 for nil, first or second differences respectively.</td>
</tr>
<tr>
<td><strong>LINE 2:</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>81-89</td>
<td>calibration (gain)</td>
<td>f9.6</td>
<td>ground motion per digital count at calibration period, null = &quot;0&quot;</td>
</tr>
<tr>
<td>90</td>
<td>units of motion</td>
<td>a1</td>
<td>0 or blank; nm (displacement) 1: nm/s (velocity) 2: nm/s**2 (acceleration)</td>
</tr>
<tr>
<td>91-97</td>
<td>calibration period</td>
<td>f7.4</td>
<td>in seconds, null = &quot;,-1&quot;</td>
</tr>
<tr>
<td>99-107</td>
<td>station latitude</td>
<td>f9.4</td>
<td>decimal degrees, north &gt; 0, null = &quot;,-999&quot;</td>
</tr>
<tr>
<td>109-117</td>
<td>station longitude</td>
<td>f9.4</td>
<td>decimal degrees, east &gt; 0, null = &quot;,-999&quot;</td>
</tr>
<tr>
<td>119-127</td>
<td>station elevation</td>
<td>f9.4</td>
<td>m above sea level &gt; 0, null = &quot;,-999&quot;</td>
</tr>
<tr>
<td>129-137</td>
<td>depth of sensor</td>
<td>f9.4</td>
<td>m &gt; 0, null = &quot;,-999&quot;</td>
</tr>
<tr>
<td>139-145</td>
<td>beam azimuth</td>
<td>f7.2</td>
<td>degrees measured clockwise from north, null = &quot;,-1&quot;</td>
</tr>
<tr>
<td>147-153</td>
<td>beam slowness</td>
<td>f7.2</td>
<td>seconds per degree, null = &quot;,-1&quot;</td>
</tr>
<tr>
<td>155-160</td>
<td>horizontal orientation</td>
<td>f6.1</td>
<td>orientation of horizontal sensors, measured clockwise from north, null = &quot;,-1&quot;</td>
</tr>
</tbody>
</table>

- E-4 -

PITSA Users Manual
Table E-2. WID2 section of GSE2.x waveform format.

<table>
<thead>
<tr>
<th>Position</th>
<th>Name</th>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-4</td>
<td>“WID2”</td>
<td>a4</td>
<td>Must be “WID2”</td>
</tr>
<tr>
<td>6-15</td>
<td>Date</td>
<td>i4,a1,i2,a1,i2</td>
<td>Date of the first sample (yyyy/mm/dd)</td>
</tr>
<tr>
<td>17-28</td>
<td>Time</td>
<td>i2,a1,i2,a1,f6.3</td>
<td>Time of the first sample (hh:mm:ss.sss)</td>
</tr>
<tr>
<td>30-34</td>
<td>Station</td>
<td>a5</td>
<td>Station Code</td>
</tr>
<tr>
<td>36-38</td>
<td>Channel</td>
<td>a3</td>
<td>FDSN channel code</td>
</tr>
<tr>
<td>40-43</td>
<td>Auxid</td>
<td>a3</td>
<td>Auxiliary identification code</td>
</tr>
</tbody>
</table>
| 45-47    | Sub_format | a3 | “INT, “CMn”, or “AUx”
“INT” is free format integers as ASCII characters;
“CM” denotes compressed data, and n is either 6 (6-bit compression), or 8 (8-bit binary compression)
“AU” signifies authentication and x is T (uncompressed binary integers), 6 (6-bit compression), or 8 (8-bit binary compression). |
| 49-56    | Samps  | i8     | Number of samples |
| 58-68    | Samprate| f11.6  | Data sampling rate (Hz) |
| 70-79    | Calib  | e10.2  | Calibration factor; i.e. the ground motion in nanometers per digital count at calibration period (calper). |
| 81-87    | Calper | f7.3   | Calibration reference period; i.e., the period in seconds at which calib is valid; calper should be near the flat part of the response curve (in most cases 1 sec). |
| 89-94    | Instype| a6     | Instrument type |
| 96-100   | Hang   | f5.1   | Horizontal orientation of sensor, measured in positive degrees clockwise from North (-1.0 if vertical) |
| 102-105  | Vang   | f4.1   | Vertical orientation of sensor, measured in degrees from vertical (90.0 if horizontal). |

Figure E-1. Example for GSE2.x waveform file. The subformat used was the CM6 (6-bit compressed).
Figure E-2. Example for GSE2.x waveform file. The subformat used was the INT format.

WID2 199204/02 23:30:00:024 PD01 SHZ  INT  12000 40.000000 9.00e-03 1.0000 23900 0.0
DAT2
0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 1 1 1 2
2 3 2 2 1 1 0 0 0 1 1 1 0 0 0 -1 -2 -2 -1 0 1 1 1 1 1 1 0 -1 -1 -2 -2 0
0 1 2 1 1 0 0 -1 -2 -2 -1 -1 0 0 1 2 2 2 0 -1 -3 -5 -6 -6 -6 -6 -6 -6 -6

Figure E-3. Example for GSE1.x waveform file The subformat used was the INTV (integer variable).

WID1 1994277 13 34 24 795 8000 PRU  A  Z  27.777790 SKD-0A INTV 0
0.111601 1.0000 49.9880 14.5420 302.0000 302.0000 -1.00 -1.00 -1.0
DAT1
0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 1 1 1 2
2 2 2 2 1 1 0 0 0 1 1 1 0 0 0 -1 -2 -2 -1 0 1 1 1 1 1 1 0 -1 -1 -2 -2 0
0 1 2 1 1 0 0 -1 -2 -2 -1 -1 0 0 1 2 2 2 0 -1 -3 -5 -6 -6 -6 -6 -6 -6 -6

Figure E-4. Example for GSE1.x waveform file. The subformat used was the CMP6 (6-bit compression).

WID1 1998182 22 00 00 031 144000 RT7651 REFTEK32 0 40.0000000 NOTYPE CMP6 2
1.000001 1.0000 0.0000 0.0000 0.0000 -999.0000 -1.00 -1.00 -1.0
DAT1
jL5kFrF1VEVFVEJWGT3o-m1cBRaEYJSRmDV3IL8kJmTXGR3aBl6HVeEy77W+ICUIQ0WBYMmL2n
3nEV7xIkCpRqRzSV++kQn6KQQW9W6-VSmAVEmx0OW4WXL3HEZ0WLo+a7q1UVVe5c0MRi9r-VKU/JX6k
RV66s4UWSn+kRY-6vDX3j1KQiWN3QYNnPH1KfOXFo5VS7a1pBVOV9p-25UnhKUQICW2V7mRVG1P1F

yQVXHlgUuDI6s6TJTWkPrgRVxBxMm17CVD40we2UmlXOXKXZBR2z3Vc7H6a2kyT0kpypGUrMUqK6b7UCC-
kkU1-m5pyyBW+pm02Up6PGl6xG2mH1hXaSmEleGVLXLeEuHl1nUt6nC9rVjkQmdDwPAWYImpLUs
KVqPI0ksE/WaU9JU3W9ATa2Up4wCtKVY7mrCU3SU2Re3VV-m7lln.kkTm.3e4V3x6OvFkqL ufBw9

CHK1 127428090
The format of the instrument response files to be used in connection with the Instrument Simulation tool in PITSA Section 6.3 is based on the format of the GSE calibration section:

LINE 1:
0 - 3: a4 header ID (must be: CAL1)
5 - 10: a6 station or array name
   (ISC code e.g. NB2)
12 - 19: a8 channel id (unique channel code)
21 - 22: a2 channel (sz, lz, ln, etc., null="-"
24 - 29: a6 system type
31 - 33: a3 response type "PAZ", "FAP", "FIR",
   or "FPZ", null="-"
35 - 40: 3i2 YYMMDD start date of validity
   for calibration
42 - 45: 2i2 HHMM start time
47 - 52: 3i2 YYMMDD end date of validity for
   calibration, blank if not known
54 - 57: 2i2 HHMM end time
58-79: a32 blanks reserved
if RESPONSE TYPE PAZ: response is given in poles and
zeros
{
   LINE 2:
       0 - 7: i8 number of poles (npole!)
   LINE 3 - N: (N = npole + 2)
       0 - 7: f,e real part of pole
     8 - 15: f,e imaginary part of pole
   LINE N+1:
       0 - 7: i8 number of zeroes (nzero)
   LINE N+2 - M: (M = N+1 + nzero)
       0 - 7: f,e real part of pole
     8 - 15: f,e imaginary part of pole
   LINE M+1:
       0 - 19: f,e scale factor C to normalize to
         ground displacement in nm
   LINE > M+1: explanatory information as needed
}
else if RESPONSE TYPE FAP: response is given in frequency - amplitude - phase
{
    LINE 2:
    0 - 7: i8 number of triplets (ntrip)
    LINE 3 - N: (N = ntrip + 2)
    3f, or e triplets frequency,
    amplitude, phase
    LINE > N: an explanatory information as needed
    (variable length)
}
else if RESPONSE TYPE FPZ: response is given using a combination of Finite Impulse Response (FIR)
and Infinite Response (in PAZ) format
{
    LINE 2:
    0 - 7: i8 number of filters (nfir)
    LINE 3:
    0 - 3: a4 filter header
    (must be of form FIR1 or PAZ)
    if FIR1:
    {
        5 - 15: f11.7 sampling rate
        (input samples per second)
        17 - 24: i8 number of coefficients
        26 - 33: a8 filter ID, filter designator
        code (e.g. GSD 240)
        LINE 4 - N: (N = ncoef + 3)
        0 - 15: f,e filter coefficients
        J = N
    }
    else if PAZ:
    {
        LINE 4:
        0 - 7: i8 number of poles (npole)
        LINE 5 - N: (N = npole + 4)
        0 - 7: f,e real part of pole
        8 - 15: f,e imaginary part of pole
        LINE N+1:
        0 - 7: i8 number of zeroes (nzero)
        LINE N+2 - M: (M = N + 1 + nzero)
        0 - 15: f,e real part of zero
        17 - 32: f,e imaginary part of zero
        LINE M+1:
        0 - 7: f,e scale factor C to normalize
to ground displacement (nm/ct)
        J = M+1
    }
    LINE J+1:
    0 - 3: a4 filter header
    (must be of form FIR1 or PAZ1)
    if FIR1:
    {
        5 - 15: f11.7 sampling rate
        (input samples per second)
        .... same as above ...
else if PAZ:
{
    LINE J+2:
    0 - 7:  i8   number of poles (npole)
    .... same as above ...
    additional explanatory information
    as needed
}
}
else if RESPONSE_TYPE FIR: response is given using
Finite Impulse Response (FIR) filter
coefficients format
{
    LINE 2:
    0 - 7:  i8   number of filters (nfir)
    LINE 3:
    0 - 3:  a4   filter header (must be FIR1)
    5 - 15: f11.7 sampling rate
            (input samples per second)
    17 - 24: i8   number of coefficients (ncoef)
    26 - 33: a8   filter ID, filter designator code
               (e.g. GSD 240)
    LINE 4 - N:  (N = ncoef + 3)
    0 - 15:  f,e filter coefficients
    LINE N+1:
    0 - 3:  a4   filter header
            (must be of form FIR1 or PAZ1)
    5 - 15: f11.7 sampling rate
            (input samples per second)
    17 - 24: i8   number of coefficients
    26 - 33: a8   filter ID, filter designator code
               (e.g. GSD 240)
    LINES N + 2 - M:  (M = ncoef + N + 1)
    0 - 15:  f,e filter coefficients
    LINES M = 1 - L:  additional filters as
                     required
    LINE L+1:  additional explanatory information
                as needed
}
Automatic phase picking is done in PITSA using the algorithm of Baer and Kradolfer (1987).

This technique is based on a statistical evaluation of a function defined as $SF(t)$. This function is calculated from the envelope function of each trace which has been raised to the 4th power. For each trace, the variance $S(t)$ of $SF(t)$ is calculated within a certain time window of given length (PRESETDUR) which starts at the beginning of the trace. The function which is actually evaluated is:

$$CF(t) = (SF(t) - SF(t))/S(t)$$  \hspace{1cm} \text{(equation (8) Baer and Kradolfer, 1987)}.

A pick flag is set if $CF(t)$ increases above a given threshold (THRSHL1). However, as long as $CF(t)$ stays below a second threshold (THRSHL2) and the current time is less than 2*PRESETDUR, $S(t)$ and the variance of $SF(t)$ is updated.

A pick is accepted only if the pick flag is set for a certain time interval (TUPEVENT). However, since $CF(t)$ may not necessarily be a smooth function, it may drop below the given threshold (THRSHL1) for less than a certain duration (TDOWNMAX) without causing the pick flag to be cleared.

After a pick has been accepted, the maximum P wave amplitude ($p_{\text{amp}}$) is evaluated within a certain time period following the pick (P_DUR). The largest amplitude before the pick flag in the trace was set for the first time is considered to correspond to the noise amplitude ($n_{\text{amp}}$). The ratio $x_r = p_{\text{amp}}/n_{\text{amp}}$ is evaluated as a measure of reliability of the pick. On the basis of $x_r$, the HYPO71 phase descriptions are determined for each phase. The quality factor is taken to be 0 for $x_r > 8.0$, 1 for $x_r > 6.0$, 2 for $x_r > 4.0$, 3 for $x_r > 1.5$, and 4 for $x_r <= 1.5$. Quality factors of 0 or 1 are labeled impulsive (I), while the others are labeled as emergent (E) onsets.

The first motion direction for each phase is also determined automatically and added to the phase description.

The performance of the phase picker depends strongly on the values of the tuning parameters PRESETDUR, TDOWNMAX, TUPEVENT, THRSHL1, THRSHL2, and P_DUR (Table G-1). These can be altered within the configuration file pitsa.cfg (see Appendix B).
Table G-1. Tuning parameters used by the automatic P-phase picker.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>P_DUR</td>
<td>5.0</td>
<td>On default set to 5.0. This means the maximum P wave amplitude is evaluated within a time window of 5 seconds following the determined P phase onset.</td>
</tr>
<tr>
<td>PRESETDUR</td>
<td>0.5</td>
<td>On default set to 0.5. This means that $S(t)$, the variance of $SF(t)$, is evaluated within the first 0.5 seconds of the trace. However, it will be updated as long as $CF(t)$ stays below THRSHL2 and the current time is less than 2*PRESETDUR.</td>
</tr>
<tr>
<td>TDOWNMAX</td>
<td>0.1</td>
<td>On default set to 0.1. This means that $CF(t)$ may drop below THRSHL1 for less than 0.1 seconds without causing the pick flag to be cleared.</td>
</tr>
<tr>
<td>TUPEVENT</td>
<td>0.3</td>
<td>On default set to 0.3. This means that $CF(t)$ has to stay above THRSHL1 for at least 0.3 seconds for the pick to be accepted.</td>
</tr>
<tr>
<td>THRSHL1, THRSHL2</td>
<td>10, 20</td>
<td>These values determine the two evaluation thresholds for $CF(t)$. They correspond to the parameters S1 and S2 in Baer and Kradolfer (1987), and are set on default to 10 and 20, respectively.</td>
</tr>
</tbody>
</table>
Problem-Solving with HYPO71

It may be the case that HYPO71 will not run correctly. In this case, the user will need to understand a little bit about how PITSA sets up the HYPO71 run in order to find the problem. Problems can occur if a station that a phase has been picked on is not in the station file, for example. This section will outline the files that PITSA creates and the system command it issues to run HYPO71 so that the user can run HYPO71 by hand.

First PITSA generates a file named input in PITSA’s current directory (the same directory that it looks for the station and phase file in). If the user does not have write permission for this directory, PITSA will not be able to run HYPO71. This small file will contain three lines, for example:

```
pitsahyp.inp
hypo_out.prt
hypo_out.pun
```

The first line is the name of the input file that HYPO71 will use which is also generated by PITSA in PITSA’s current directory. This is a hard wired name and must be pitsahyp.inp. The second line is the name of the output file HYPO71 will create and is the HYPO71 output file name that the user provides PITSA with .prt appended. This is the file that HYPO71 will create if it runs successfully and is the file PITSA reads the new event information from. It will be created in PITSA’s current directory. The third line is a file name that is needed by HYPO71 but is not used by PITSA. It is generated the same way the .prt file is generated except that .pun is appended instead of .prt. The pitsahyp.inp file is generated by appending together the control file, velocity model, station file, phase file and other required lines together. The first two lines are always:

```
HEAD HYPO71PC SETUP FOR PITSA VER 3.3
RESET TEST(06)=1.
```

Then a blank line followed by the station file (this is the station file that is generated in example):

```
CRPV3754.75N12154.36W331000
HPRV3657.19N12141.70W940000
JPLV3658.62N12149.92W158000
HGWV3701.02N12139.18W133000
JECV3703.04N12148.54W438000
```
Chapter H

Followed by another blank line and the velocity model file:

4.00   0.0
5.90   3.5
6.80   15.0
8.05   25.0

Then another blank line and the control header file:

5. 25. 50. 1.78 2 1 18 1 1 11

And then the phase file (this is the phase file that is generated in example):

CRPVIPD0 891023002935.76
HPRVEPD0 891023002932.25
JPLVIPU0 891023002932.78
HGWVIPU0 891023002932.35
JECVEPD1 891023002932.78
HCRVEPU0 891023002933.01
HAZVIPD0 891023002933.04
JHLVIPD0 891023002933.44
HJGVEEP2 891023002933.40
HCAVIPU0 891023002934.43
JALVIPD0 891023002934.09
CADVEPU0 891023002934.47

After the input and pitsahyp.inp files have been created, PITSA then issues the following system command:

cd <PITSA’s current path>; hypo71pc < input > output

If hypo71pc is not in the users path, then PITSA will not be able to run the HYPO71 program. The output of the PITSA program is redirected to the file output, which will contain any error messages HYPO71 generates. If HYPO71 does not run, then the user should take a look at this file. The user can run HYPO71 by hand by changing into the directory that contains the station and phase file and then typing hypo71pc. HYPO71 will ask the user for the three file names that are normally in the input file and then attempt to locate the event.

Example: Running HYPO71 from PITSA.

• First load in the isam1 file system:
• Change to the PITSA demodata directory and start PITSA.
• Select Files/Traces -> Retrieve Files -> ISAM and enter isam1 as the file name.
• Select all channels to be loaded in by entering ; as the channel list to load.

PITSA will now display 12 channels. These channels have already been picked, so all we have to do is create a station and phase file:
• Select Routine Tools -> Phase Picking.
• Select Phase Picking Menu -> Output phases(s).
• Select HYPO71 as the phase output format.
• Select ; as the channel list.
• Enter isam1.pha for the name of the phase file.

After PITSA creates the phase output file, you should see the message in Figure 9-14 appear in the upper left hand corner of the screen. You must click in the button before you can continue on.

**Figure 9-14. The message that appears after the phase file is created in example.**

<table>
<thead>
<tr>
<th>Total number of phases in new file</th>
<th>12</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of new phases used</td>
<td>12</td>
</tr>
<tr>
<td>Number of new phases ignored</td>
<td>0</td>
</tr>
<tr>
<td>Number of old phases used</td>
<td>0</td>
</tr>
<tr>
<td>Number of old phases ignored</td>
<td>0</td>
</tr>
<tr>
<td>Number of warnings</td>
<td>0</td>
</tr>
</tbody>
</table>

Now create a station file:
• Select Phase Picking Menu -> Output station(s).
• Select HYPO71 as the station output format.
• Enter ; for the channel list.
• Enter isam1.sta for the name of the station output file.

Now you are ready to run HYPO71:
• Select Phase Picking Menu -> Run location program.
• Select HYPO71 as the location program to run.
• Enter velmod.hdr for the velocity model (it will be the default).
• Enter control.hdr for the control header (it will also be the default).
• Enter isam1.sta for the station file.
• Enter isam1.pha for the phase file.
• Enter hypo_out for the output file (it will be the default).
• When HYPO71 finishes, select Load in results.

After the location results are read in, you will see the message in Figure 9-15 appear in the upper left hand corner of the screen. In order to continue on, you must click in the CONTINUE button. PITSA has now read in the new event location and created 12 synthetic phases that show the phase residuals. We can view the residuals by selecting Phase Picking Menu -> Adjust phase(s):

**Figure 9-15. The message PITSA displays after HYPO71 result are read in example.**

| New Location: 38.95 [lat deg] -121.74 [lon deg] 15.29 [depth km] |
|-------------------------|-------------------------|-------------------------|-------------------------|
| # residuals: 0.978 [ave sec] 9.760 [max sec] 12 [# residuals] | b residuals: 0.000 [ave sec] 0.000 [max sec] 0 [# residuals] |
| 12 synthetic phases created | CONTINUE | 12 synthetic phases created | CONTINUE |
- Select Phase Picking Menu -> Adjust phase(s).
- Enter ; for the channel list.
- Enter 3 as the number of channels to look at each time.
- Enter 3 as the number of channels to increment each pass.

Figure 9-16 shows PITSA on its first pass through the phase picking screen. Notice that the zoom window is centered around the first phase pick in the top trace, which is (1) in this case. This is how PITSA always aligns the zoom window when this screen first comes up. For trace (1), we only see the phase that was previously picked and we don’t see any phase picks for the other two traces. This is because the residual phase for trace (1) is outside of the zoom box as well as the phases for traces (2) and (3). To see the phase picks and residuals of the other two traces, move the left edge of the zoom box by pressing the left mouse button while the mouse pointer is just outside and to the left of the zoom box. The pointer in figure Figure 9-16 shows where your mouse pointer should be when you first press down on the button. Then, while the mouse button is held down, move the mouse pointer to the left. As you do, the left edge of the zoom box will follow the cursor. When the left edge of the zoom box is to the left of the picks in trace (2), release the mouse button. When the mouse button is released, the traces in the lower part of the screen will be redrawn to reflect the new zoom box. Figure 9-17 shows the screen after the left edge of the zoom box has been moved.

**Figure 9-16. The PITSA phase picking screen on the first pass in example.**

![Diagram of the PITSA phase picking screen on the first pass](image)

We can see the synthetic phase for trace (1) by moving the right edge of the zoom box using the same method as before, except that we put the mouse pointer just outside on the right side of the zoom box; the pointer in Figure 9-17 shows where the mouse pointer should be before you press down the left mouse button. Figure 9-18 shows the screen after the right edge of the zoom box has been moved.
In Figure 9-18 we can see the phase and residual phases for all three traces. In trace (1), the phase that was used for the location (the previously picked phase) is \( P:\_\_ID0 \) and the residual phase (a synthetic phase because it has no colon) is \( IPD0 \). Notice that the phase id for the synthetic phases is different from the phase id of the picked phase. This is because the residual phase uses the HYPO71 naming convention which places Impulsive or Emergent first, followed by either a \( P \) or \( S \), then the first motion, and then the weight. The residual phases can be used as an aid...
in adjusting the phases. Notice that you will not be able to adjust or edit the residual phases.

The residual for trace (1) is quite large indicating that there is something wrong with that station, either the station location or timing is off. It would probably be best to re-locate this event leaving out this station. To do this, you can just delete the phase pick, create a new phase file (entering 2:12 as the channel list) and then re-run HYPO71.

- To view the remaining traces, select the Phase Menu -> DONE selection. This will bring up the next three traces.
- Continue selecting Phase Menu -> DONE until all the phases have been viewed. This ends the example.
## Index

### Symbols

1

**A**
- A/D converter 1, 26, 28
- Accepting new or processed traces 8
- Acknowledgements 3
- Adjust phases 14
  - controlling zoom 14
  - phase menu 22
    - all traces 28
    - clear amplitude 25
    - clear delta 26
    - clear Hilbert flag 27
    - clear pulled in 28
    - delta 25
    - done 29
    - first motion 22
    - Hilbert transform 26
    - next trace 28
    - onset type 22
    - phase type 22
    - prev trace 28
    - pull in all comp 28
    - pull in nearest sta 28
    - refresh 28
    - set amplitude 23
    - set Hilbert flag 27
    - weight 23
- picking phases 16
- Advanced tools
  - coherence spectrum 47
  - convolution 26
  - correlation 25
  - cross spectrum 46
  - envelope 37
  - FFT 12
  - filter 2
  - Hilbert transform 37
  - inverse FFT 15
  - maximum entropy spectrum 17
  - particle motion 28
  - polarization filter 42
  - rotate components 38
  - spectrum 11
  - and 9
  - AR process 17
  - ARMA coefficients 9
  - ASCII format 2, 2
    - header line 7
    - retrieve files 5
    - save files 9
  - Automatic processing 4
  - Autoscale traces 13
  - Average 43
  - Axis type 14, 16, 46, 9, 14
  - Azimuth 39, 41, 14, 17

**B**
- Band pass filter 2, 6, 7
- Baseline correction 42
  - linear regression 44
  - linear trend 43
  - offset 43
  - running average 43
- Beam forming 15
- Body wave magnitude 34
- Brune source 5
- Butterworth filter
  - Band Pass 2
  - High Pass 5
  - Low Pass 4

**C**
- Changing directories 3
- Chirp signal 7
- Clear
  - all phases 32
  - amplitude 25
  - phases 32
  - select phases 32
- Coherence spectrum 47
Color settings 1
Command files 3
Constant functions 4
Constants 4
Convolution 26, 26, 27
Copy traces 10
Correlation 25
Cross spectrum 46
.cshrc 1

D
Data trace 1
Deconvolution 26, 27
Delete traces 12
Delta phase 25
De-ring filter 5
Dialog boxes
clearing quickly 1
keyboard focus 6
text input 5
Dialog menus 7
Difference
equation 2
equation filter 8
Differentiate 41
Digital resampling 25
Digitization 22
Digitize signal 23
Distance plot 3
Double channel utilities 11

E
Edit 6
despiking 9
glitch editing 8
interpolate 6, 8
point editing 6
Envelope 37
Environment variables
PITSA_CONFIG_PATH_ENV 2
PITSA_HYPO71_PATH_ENV 2, 31
PITSA_PRINTDEF_NAME_ENV 2, 7
PITSA_PRINTDEF_PATH_ENV 2, 7
Adjust phases
phase menu 29

Event
access 16
Exit 9

F
FAP 10
FFT 12
demultiplex from FFT format 17
inverse 15
multiplex to FFT format 16
File I/O 1
File types 3
Files and traces
retrieve files 3
save files 8
Filter 2
band pass 2, 6
de-ring 5
difference equation 8
gaussian band pass 6
high pass 5
low pass 4
notch 7
FIR 10
First motion 22
Flags
plotall 10
Font size 2

G
Generic Wood Anderson magnitude 34
GSE 2
GSE format 10
GSE Reading 8

H
Hardcopy
screendump files 7
status line 9
Header access 1, 15
Event header 16
output information 18
Plot header 17
Record header 17
Station header 15
High pass filter 5
Hilbert
flag 27
transform 26
Hilbert transform 37
History function 9
HYPO71 1
control.hdr 31
debugging 32
example 2
phase labels 20
phase output status message 30
processing 30
running 31
synthetic phases 31
weight 23
HYPO71 phase id convention 5

I
Incidence angle 41
Installation
user 1
Instrument correction 9
GSE format 10
response files 10
Integrate
Tick’s rule 40
trapezoidal rule 40
Inverse FFT 15
IRIS 4
ISAM format 2, 2
example 4
retrieve files 3
save files 9

L
Last command 9
Linear
regression 44
regression removal 44
trend removal 43
Local magnitude 34
Index

Location
  running HYPO71 32
Location programs 31

M
Magnitudes 34, 34
Maximum entropy spectrum 17
Menu
  main menu item selection 4
Mixed signal  5
Moment magnitude 34, 37, 40
Multiplex format 16, 17

N
Next trace 28
Noisy traces 2
Notch filter 2, 7
Numbered postscript files 7

O
Offset removal 43
Onset type 22
Output phases 29

P
Particle motion 28
  2D snake 29
  3D snake 33
Path to data files 3
PAZ format 10
Personal note
  by Frank Scherbaum 4
  by James Johnson 4
Phase error 25
Phase id’s 22
Phase labels 20
Phase picking 12
  adjusting and editing phases 14
  auto picker parameters 1
  automatic phase picking 13
  clear phases 32
  clearing all phases 32
  clearing select phases 32
DONE 33
HYPO71 30
output phases 29
output stations 31
particle motion 33, 36
  phase labels 20
plot all 33
  run location program 31
sort by distance 29
PITSA.CFG 2
  P Picker 1
    phase picking 1
Plain ASCII files 5
Plain Sum 15
Plot access 17
Plot all 33
Plot all flag 10
Polarization filter 42
Pole zero file
  filter 8
Popup menus 7
Prev trace 28
Processed 8
Program mode 3
  accepting default 6
  input files 4
  input modifiers 6

Q
Quit 9

R
Reading data
  ASCII files 5
  ISAM format 3
Rearrange traces 11
Record access 17
Rectilinearity 43
Resampling 1, 22, 22, 25
Resizing PITSA 9
Retrieve file 3
Ricker wavelet 6
Rotate components 38
Routine tools
  adjust phase(s) 14
  baseline corrections 42
  differentiate 41
  edit 6
  integrate 40
  magnitudes 34
  phase picking 12
RPN equation 8
Running average 43

S
Sampling rate 2, 17
Save files 8
  ASCII format 9
  ISAM format 9
Scale traces together 12
Section plots 2
Seismometer signal 7
Set amplitude 23
Setup
  hardcopy mode 2
  program/track mode 2
Simulate A/D Converter 26
Sine/cos 3
Single channel utilities 10
Sinusoidal signals 3
Snake
  Particle motion 28
Sort traces by distance 29
Spectrum 11
Spikes 3
Stack traces 14
Station
  access 15
Statistics 43
Status line 8
Surface wave magnitude 34

T
Taper functions 12
Test signals 1
  noisy traces 2
Text 5
  Text input 5
trace 7
Traces
  accepting new 8
adding traces from ISAM file 9
autoscale traces 13
copy traces 10
delete traces 12
input for channel lists 7
processing large data sets 3
rearrange traces 11
scale traces together 12
scaling traces 9
utilities 1, 9
Track mode 3
accepting default 6
input files 4
input modifiers 6
Triple channel utilities 12

U
Unify Traces 15
University NAVSTAR Consortium 4

W
Waterlevel 27
Whittaker reconstruction 24

Z
Zoom 2
accept zoom window 4
adjust zoom window 4
index selection 5
tapered 4
Zoom box 14